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About This User Manual

General
Any security measures described in this User Manual, for example, for user 
access, password security, network security, firewalls, virus protection, etc., 
represent possible steps that a user of an 800xA System may want to consider 
based on a risk assessment for a particular application and installation. This risk 
assessment, as well as the proper implementation, configuration, installation, 
operation, administration, and maintenance of all relevant security related 
equipment, software, and procedures, are the responsibility of the user of the 
800xA System.

This User Manual describes setup and configuration activities for Asset 
Optimization Asset Monitoring, Maximo Integration, SAP/Plant Management 
(SAP/PM) Integration, Device Calibration Integration, the Control Loop Asset 
Monitor (CLAM), and the Generic (HXAM-G) and Shell and Tube (HXAM-ST) 
Heat Exchanger Asset Monitors. This product functionality consists of system 
extensions to the 800xA System product. 

User Manual Conventions
Microsoft Windows conventions are normally used for the standard presentation of 
material when entering text, key sequences, prompts, messages, menu items, screen 
elements, etc.

Feature Pack

The Feature Pack content (including text, tables, and figures) included in this 
User Manual is distinguished from the existing content using the following 
two separators:
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Feature Pack Functionality

<Feature Pack Content>

Feature Pack functionality included in an existing table is indicated using a 
table footnote (*) :
* Feature Pack Functionality

Unless noted, all other information in this User Manual applies to 800xA Systems 
with or without a Feature Pack installed.

Warning, Caution, Information, and Tip Icons

This User Manual includes Warning, Caution, and Information where appropriate to 
point out safety related or other important information. It also includes Tip to point 
out useful hints to the reader. The corresponding symbols should be interpreted as 
follows:     

Although Warning hazards are related to personal injury, and Caution hazards are 
associated with equipment or property damage, it should be understood that 
operation of damaged equipment could, under certain operational conditions, result 
in degraded process performance leading to personal injury or death. Therefore, 
fully comply with all Warning and Caution notices.

Electrical warning icon indicates the presence of a hazard that could result in 
electrical shock.

Warning icon indicates the presence of a hazard that could result in personal 
injury.

Caution icon indicates important information or warning related to the concept 
discussed in the text. It might indicate the presence of a hazard that could result 
in corruption of software or damage to equipment/property.

Information icon alerts the reader to pertinent facts and conditions.

Tip icon indicates advice on, for example, how to design your project or how to 
use a certain function
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Documentation of Third Party Software
This User Manual describes third party software to the extent that it applies to Asset 
Optimization. Specific information relating to the installation, setup, configuration, 
and operation of third party software can be found in the manufacturer’s 
documentation. 

Terminology
A complete and comprehensive list of terms is included in System 800xA System 
Guide Functional Description (3BSE038018*). The listing includes terms and 
definitions that apply to the 800xA System where the usage is different from 
commonly accepted industry standard definitions and definitions given in standard 
dictionaries such as Webster’s Dictionary of Computer Terms.

Released User Manuals and Release Notes
A complete list of all User Manuals and Release Notes applicable to System 800xA 
is provided in System 800xA Released User Manuals and Release Notes 
(3BUA000263*). 

System 800xA Released User Manuals and Release Notes (3BUA000263*) is 
updated each time a document is updated or a new document is released. It is in pdf 
format and is provided in the following ways:

• Included on the documentation media provided with the system and published 
to ABB SolutionsBank when released as part of a major or minor release, 
Service Pack, Feature Pack, or System Revision.

• Published to ABB SolutionsBank when a User Manual or Release Note is 
updated in between any of the release cycles listed in the first bullet. 

A product bulletin is published each time System 800xA Released User Manuals 
and Release Notes (3BUA000263*) is updated and published to ABB 
SolutionsBank.
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Section 1  Introduction

Product Overview 
System 800xA - Asset Optimization consists of system extensions to the 800xA 
Base System. Asset Optimization functionality includes Asset Condition Reporting, 
Asset Monitoring, CMMS (Computerized Maintenance Management System) 
Integration, and a separate engineered solution for calibration integration to the 
800xA System. This optimizes the use of plant equipment and processes. When 
integrated with SMS and e-mail Messaging, Asset Optimization provides a method 
for sending messages based on alarm and event information through SMS and 
e-mail. When integrated with Device Management FOUNDATION Fieldbus or 
Device Management PROFIBUS & HART, Asset Optimization provides a method 
to detect and notify problems with field devices. 

Product Scope

The Asset Optimization software provides the following functionality:

• Maintenance Workplace and Asset Structure.

• Asset Health Condition Reporting.

– Asset Viewer.

– Asset Reporter.

• Asset Monitoring.

– Basic Asset Monitors.

– Process Asset Monitors (includes Control Loop Asset Monitor (CLAM), 
Heat Exchanger Asset Monitor - Shell and Tube (HXAM - ST), and Heat 
Exchanger Asset Monitor - Generic (HXAM - G). 

– System Status Asset Monitor.
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– HART Asset Monitoring.

– FOUNDATION Fieldbus Asset Monitoring.

– PROFIBUS Asset Monitoring.

• Seamless Interaction Between Process and Maintenance.

– Maximo Integration.

– SAP/PM Integration.

• Engineered solution for Calibration Integration.

• Asset Optimization Reporting.
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Figure 1 shows the interaction between the various functional components of Asset 
Optimization. 

Figure 1. Asset Optimization Functionality 
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Section 2  System Setup

Introduction 
This section contains procedures for the following:

• Setting Up Aspect Defaults. 
– Asset Monitor Startup Parameters. 
– Connecting to a Process Portal B Node. 
– Maximo Server Connection Properties.
– SAP/PM Server Connection Properties.
– Mapping between the 800xA System and the CMMS.
– Alarm Behavior upon Fault Report Submittal.

• User Privileges. 
– Maximo User Credentials.
– SAP User Credentials.
– Primary Structures.

• Primary Structures. 
– Managing Data Source Connections.

This section contains system setup procedures applicable to all system 
extensions; however, procedures specific to PC, Network and Software 
Monitoring are located in System 800xA PC, Network, and Software Monitoring 
Configuration (3BUA000447*).

When creating aspects, it is possible to add a description and name the aspect as 
desired. If the aspect is not named, the aspect category name is used and 
displayed in the Aspect List Area. Unless otherwise noted, the procedures in this 
User Manual use the aspect category name.
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Setting Up Aspect Defaults
The following procedures must be performed to set up the aspects in the Aspect 
System Structure:

• Asset Optimization Server Configuration. 
• Loading Asset Monitor Configurations to an AO Server.
• Asset Monitor Startup Parameters. 
• Connecting to a Process Portal B Node. 
• Maximo Server Connection Properties.
• SAP/PM Server Connection Properties.
• Mapping between the 800xA System and the CMMS.
• Alarm Behavior upon Fault Report Submittal.

Setting up these aspects in the Aspect System Structure provides default values for 
each instance of that aspect applied to individual objects in the Primary Structures.

Asset Optimization Server Configuration

Each AO Server Object should be added under the Asset Optimization Object in the 
Control Structure.

An AO Server object in the Control Structure represents one AO Server that 
provides the following services:

• AssetMonitoring Service: This service collects the Asset Condition 
Documents (ACDs) generated by Asset Monitoring Engines and publishes 
them in the 800xA platform as OPC-DA properties, Soft Alarms, Asset Tree 
node status, and Fault Reports.

• AssetTree Service: All information displayed in the Asset Viewer is provided 
by the AssetTree Service. Asset Reporter OPC properties are provided by this 
service as well. There should be one and only one AssetTree service per 800xA 
System. This service collects severity, quality, and Fault Report availability for 
all assets in all AssetMonitoring Services and calculates the propagated values 
based upon 800xA structures. The AssetTree Service also publishes the 
composite and propagated values of the object in the 800xA platform as OPC-
DA properties. No configuration is required for this service. It will be started 
automatically when the first AssetMonitoring Service is started.
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• Asset Monitoring Engine: Provides the execution environment for the Asset 
Monitors. For each Asset Monitor loaded in this engine it provides the required 
runtime data through the connected OPC Servers and exposes the generated 
ACDs to the related AssetMonitoring service.

• Fault Reports Repository Manager: Maintains the Fault Reports generated 
by the Asset Monitoring Engines and exposes them to the user for further 
processing.

• AO Internet Information Service Webs: Exposes Asset Optimization data to 
Web Clients.

• Third Party Asset Monitoring Engine: The AO Server can also process 
ACDs generated by third party Asset Monitoring Engines.

The AO Servers should have been configured as part of the post installation process. 
If they have not been configured, refer to the Asset Optimization section in System 
800xA Post Installation (3BUA000156*).

Loading Asset Monitor Configurations to an AO Server

1. Go to the Control Structure and navigate to:

Root, Domain > Asset Optimization, Asset Optimization > 
AO Server 1, AO Server

2. Select Asset Optimization Server in the Aspect List Area.

3. Select the Asset Monitors tab in the Preview Area as shown in Figure 2. 

4. Make sure that the Asset Monitor aspects to be loaded are assigned to the target 
Asset Optimization Server and that they are enabled.

5. To load the enabled Asset Monitor aspects to the Asset Optimization Server, 
click Load all AMs. 

6. To load only selected Asset Monitor aspects:

a. Select the AMs Assigned to this AO Srv option.

A virtual AO Server can be created and configured on an existing AO Server. It is 
recommended to load and configure the Control Loop Asset Monitors on the 
Virtual AO Server. For detailed information refer to Virtual AO Server 
Configuration on page 146



Figure 2. Asset Optimization Server Aspect

TC06062B
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b. Select the desired Asset Monitors.

c. Right-click and select Load/Unload Config from the context menu that 
appears.

When a large number of Asset Monitor configurations are downloaded, the AO 
server will be busy updating the configuration. During this period the AO server 
aspect may show the following Status "Unknown, Unable to connect to AO 
server". Refreshing the view subsequently will update the Asset Monitor 
configuration status.
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7. To verify the current Asset Monitor configuration status:

a. Select the Asset Monitors tab.

b. Select the AMs Assigned to this AO Srv option. This operation, which 
may take a few minutes, will populate the list of all the Asset Monitors in 
the system that are assigned to this AO Server.

c. Each Asset Monitor in the list will display one of the current life cycle 
states listed in Table 1.  

Renaming an Asset Monitor object instance will not update the name of object  in 
the list of loaded Asset Monitors in AO server. The Asset Monitor should be 
reloaded to address this problem.

After executing a Replace Unit in Control Builder, the Asset Monitor aspect on 
the replaced unit should be renamed. The renamed Asset Monitor must be 
reloaded to the Asset optimization server.

It is also possible to load a single Asset Monitor from the Asset Monitor aspect 
itself. Refer to Loading a Single Asset Monitor on page 74 for more information.

Table 1. Asset Monitor Life Cycle States 

Life Cycle State Description

Configuration error, object 
not in Control Structure

Object containing the Asset Monitor aspect is not inserted in the 
Control Structure. This is an invalid configuration and must be fixed by 
inserting the Object once in the Control Structure.

Not loaded, enabled Asset Monitor aspect configuration is not loaded to an AO Server.

Loaded, not current Asset Monitor aspect configuration was modified since last loaded to 
an AO Server.

Will not load, disabled Asset Monitor aspect is not enabled; is not (and will not be) loaded to 
an AO Server.
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8. When initiating a load operation of Asset Monitors belonging to an entity, such 
as an AC 800M Controller, the load procedure will attempt to reserve those 
entities before the configuration is loaded to the AO Server. After the load 
operation completes, all reserved entities will be released. Figure 3 provides an 
example.   

Loaded, current Current Asset Monitor aspect configuration has been loaded to an AO 
Server.

Unknown, unable to 
contact the AO Server

Unable to contact the AO Server. The call to the AO Server that is 
needed to assess the current Asset Monitor life cycle failed. 

Asset Monitors not loaded or Asset monitors loaded to a disabled AO Server will 
have the quality of all of their conditions set to Bad Not Connected.

If an AO Server is assigned to a different AssetMonitoring Service group, or the 
default AO Server is reassigned, then a Load all AMs operation is required for 
each AO Server in the system.

Configuration changes to an Asset Monitor aspect (including Enable/Disable and 
assigning to a different AO Server) will become active after the Asset Monitor 
aspect is loaded.

Table 1. Asset Monitor Life Cycle States (Continued)

Life Cycle State Description



Figure 3. Entity Reserve and Release Process Example
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9. Request that the entities reserved by the other user (or users) be released.

10. Perform an incremental load of just the unreserved entities, or the entities 
already reserved by the user performing the load. To do so:

a. Sort all Asset Monitors by the Object Path in the AO Server aspect.

b. Select the group of Asset Monitors that belong to the same controller.

c. Select Load/Unload from the context menu. 

It is also possible to partition Asset Monitors in different AO Servers by grouping 
them by entity.

Asset Monitor Startup Parameters

Some Asset Monitors may use startup parameters to modify the behavior of the 
Asset Monitor, or to provide global configuration values (refer to Asset Monitor 
specific documentation for more information). 

Startup parameters can only be modified under the Logic tab in the Config view of 
the Asset Monitor category in the Aspect System Structure. Configuration of the 

If an entity reservation fails as a result of an existing reservation by a different 
user then the load operation is aborted. If this happens, perform Step 9 and 
Step 10.
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startup parameters applies to every instance of the Asset Monitor in the Primary 
Structures. 

Connecting to a Process Portal B Node 
Add the Process Portal B Provider aspect to 800xA System Objects to provide 
Process Portal B notification for them. Process Portal B alarm notification will 
not be enabled on an object in the 800xA System if the Process Portal B Provider 
aspect is not added to that Object.

800xA - Asset Optimization for Process Portal B adds Asset Optimization 
functionality to Process Portal B systems. Asset Monitoring information is available 
as a context menu on PPB TAGs and active Asset Conditions are reported into 
Process Portal B Alarm and Event systems. Furthermore, Asset Optimization 
enables the integration of Computerized Maintenance Management Systems and 
provides CMMS specific information through the context menu of a PPB TAG.

Refer to Operate IT Process Portal 800xA Asset Optimization for Process Portal B 
(3BUA000423*) for installation and Process Portal B node configuration.

To configure the Process Portal B Provider aspect: 

1. Use the Structure Selector to open the Aspect System Structure.

2. Navigate to:

Asset Monitoring, Aspect System > Process Portal B 
Provider, Aspect Type > Process Portal B Provider, 
Aspect Category

3. Right-click Process Portal B Provider, Aspect Category and select 
Process Portal B Provider from the context menu that appears. This opens the 
Process Portal B Provider shown in Figure 4. 

4. Fill in the fields with the appropriate information:

– Name: Name of the Process Portal B node on which Asset Optimization 
Process Portal B Connectivity is installed.

– Service Account: Service account information on Process Portal B node.
– Password: Password of the service account on Process Portal B node.
– Confirm Password: Re-enter password entered in Password field.



Figure 4. Process Portal B Provider
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5. Click Apply to save the entered information. This information will now appear 
in every Process Portal B Provider added to objects in the Primary 
Structures. 

To connect to more than one Process Portal B system, create another Process 
Portal B Provider (naming it something other than the original) on the Process 
Portal B Provider Aspect Category in the Aspect System Structure and define its 
parameters.

  

Maximo Server Connection Properties

The Maximo Equipment ID contains the information needed to access the Maximo 
Server and must be set up in the Aspect System Structure to provide CMMS System 
identification information (Provider Properties). Each instance of the aspect applied 
to individual objects in the Primary Structures references this information. 

The Maximo Equipment ID provides information for mapping the 800xA System 
object to the Maximo equipment in the CMMS database for a particular Maximo 
Server. Multiple Maximo Equipment IDs can be associated with the same asset, 
thus providing the ability to map to more than one piece of equipment defined in 
Maximo.

1. Use the Structure Selector to select the Aspect System Structure.
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2. Navigate to:

Maximo Connectivity, Aspect System > Maximo Equipment 
ID, Aspect Type > Maximo Equipment ID, Aspect Category

3. Click on Maximo Equipment ID in the Aspect List Area to produce the 
default view of the Maximo Equipment ID in the Preview Area

4. The Asset Information frame requires no action during setup. It is used when 
the Maximo Equipment ID is added to individual assets in the Primary 
Structures.

5. Table 2 lists and describes the properties in the CMMS Information frame and 
the Maximo Equipment ID Provider Properties. 

 

Table 2. Maximo Equipment ID 

CMMS 
Information 

Frame

Provider 
Properties

Default Value Description

CMMS System Does not appear Maximo The type of CMMS.

Does not appear ServerName None Not used.

Maximo Server 
Version

ServerVersion 6.2 The version of the Maximo 
software used.

Maximo Server 
Version*

ServerVersion 7.1 The version of the Maximo 
software used.

Does not appear AppServer None Not used. 

Maximo 
WebServer

MROWebServer MustDefine The DNS/IP name/address 
of the server for the Maximo 
web interface.

Maximo Site 
Name

MROSite None Not used.

Maximo Site 
Name*

MROSite None The name associated with 
the data set to view on the 
specified Maximo Server.
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* Feature Pack Functionality

6. Click Edit Category Data and the view changes to access the Maximo 
Equipment ID Provider Properties shown in Figure 5. 

7. Click in the Value column of the desired row to change the value.

a. Change the Value column of the ServerVersion row to the Maximo 
Version 6.2. 

Feature Pack Functionality

With reference to Step a, the Maximo Version is 7.1 for the System 800xA 5.1 
Feature Pack release.

Use Credentials UseCredentials True Determines whether or not 
the Maximo Credentials 
configured on the current 
user are used to submit a 
Fault Report.

Maximo Sender 
ID

MROSenderID MustDefine Enter the Sender ID as 
configured in the Maximo 
Server.

ECS Interface ECSWebAccess 
URL

http://<ECS

Server>/ECS/

EcsIntegratio

n.asmx

Enter ECS WebService 
URL. Use default value if 
ECS Software is installed on 
the AO Server designated 
as AOWebServer. Else 
replace [ECS server] in URL 
with the ECS server IP 
address.

ECS Interface* ECSWebAccess
URL

http://<ECS 
Server>:8010/
EcsService

Enter ECS WebService 
URL. Replace <ECS 
Server> in URL with the 
ECS Server IP address.

Table 2. Maximo Equipment ID (Continued)

CMMS 
Information 

Frame

Provider 
Properties

Default Value Description
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b. Change the Value column of the MROWebServer row to the DNS/IP 
name/address of the server for the Maximo web interface. 

Feature Pack Functionality

c. Change the Value column of MROSite row to the Site name associated 
with the data set to view on the specified Maximo Server.

d. If required, change the Value column of the UseCredentials row from 
True to anything other than True (usually False). A value of True means 
that the configured Maximo Credentials on the current user is used for the 
submittal of Fault Reports. A value of False means that the server will not 
use the credentials stored in the User Credential aspect in the User 
Structure. In this case it is required to reauthenticate the submittal of Fault 
Report .

e. Change the Value column of the MROSenderID row to the Sender ID 
configured in the Maximo Enterprise Adapter. 

Feature Pack Functionality

Ignore Step f and proceed to Step g for the System 800xA 5.1 Feature 
Pack release.

Figure 5. Maximo Equipment ID Provider Properties
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f. Change the Value column of the ECSWebAccessURL row to http://<ECS 
Server>/ECS/EcsIntegration.asmx, replacing <ECS Server> with the 
DNS/IP name/address of the ECS server. 

Feature Pack Functionality

g. Change the Value column of the ECSWebAccessURL row to http://<ECS 
Server>:8010/EcsService, replacing <ECS Server> with the DNS/IP 
name/address of the ECS Server. 

8. Click Apply. 

9. Click the back arrow in the Preview Area to return to the initial Maximo 
Equipment ID aspect view and verify that the correct information appears in 
the CMMS Information frame. 

The fields and values that appear in the Create Fault Report Form and Submit 
Fault Report view are dependent on the contents of 
MxDefMOMAppFR_Submit.xml Maximo Definition (MxDef) file. Refer to 
Mapping between the 800xA System and the CMMS on page 35 for information 
on accessing and editing the MxDef files.

SAP/PM Server Connection Properties

The SAP Equipment ID contains the information needed to access the SAP/PM 
Server and must be set up in the Aspect System Structure to provide CMMS System 
identification information (Provider Properties). Each instance of the aspect applied 
to individual objects in the Primary Structures references this information. 

The SAP Equipment ID provides information for mapping the 800xA System object 
to the SAP/PM equipment in the CMMS database for a particular SAP/PM Server. 
Multiple SAP Equipment IDs can be associated with the same asset, thus providing 
the ability to map to more than one piece of equipment defined in SAP/PM.

Feature Pack Functionality

1. Use the Structure Selector to select the Aspect System Structure.

While updating SAP Equipment ID from SAP Server Version 4.7 to 6.0, delete 
the Z<x>Proxy.dll files, where <x> represents a set of characters. The .dll files 
are located at <InstallDrive>:\Program Files\ABB Industrial IT\cpmPlus 
Enterprise Connectivity\Service on ECS Server.
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2. Navigate to:

SAP Connectivity, Aspect System > SAP Equipment ID, 
Aspect Type > SAP Equipment ID, Aspect Category

3. Click on SAP Equipment ID in the Aspect List Area to produce the default 
view of the SAP Equipment ID in the Preview Area.

4. The Asset Information frame requires no action during setup. It is used when 
the SAP Equipment ID is added to individual assets in the Primary Structures.
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5. Table 3 lists and describes the properties in the CMMS Information frame and 
the SAP Equipment ID Provider Properties.  

Table 3. SAP Equipment ID 

CMMS 
Information 

Frame

Provider 
Properties

Default Value Description

CMMS Type Does not appear SAP-PM 
Module

The type of CMMS.

Server IP 
Address

ServerAddr MustDefine1 The DNS/IP name/address 
of the SAP/PM Server node.

SAP Server 
Version

ServerVersion MustDefine2 The version of the SAP/PM 
software being used.

SAP Router 
Address

ServerRouter MustDefine3 IP address of an SAP/PM 
server that acts as a 
webfarm router and will 
direct request traffic to 
available SAP/PM server 
resources (SAP/PM server 
nodes). For single server 
SAP/PM systems, this is 
usually ( ).

SAP 
AOWebServer

SAPWebServer [AoWebServer] The DNS/IP name/address 
of the AO server for the 
SAP/PM web interface.

Use SAP 
Credentials

UseCredentials True Determines whether or not 
the SAP/PM Credentials 
configured on the current 
user are used to submit a 
Fault Report.
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* Feature Pack Functionality

6. Click Edit Category Data and the view changes to access the SAP Equipment 
ID Provider Properties. Refer to Figure 6.

The value of ECSWebAccessURL is http://<ECS Server>:8010/EcsService for 
the System 800xA 5.1 Feature Pack release (see Figure 6).

Feature Pack Functionality
 

7. Click in the Value column of the desired row to change the value.

ECS Interface ECSWebAccess 
URL

http://<ECS

Server>/ECS/E

csIntegration.as

mx

Enter ECS WebService 
URL. Use default value if 
ECS Software is installed on 
the AO Server designated 
as AOWebServer. Else 
replace [ECS server] in URL 
with the ECS server IP 
address.

ECS Interface* ECSWebAccess
URL

http://<ECS 
Server>:8010/E
csService

Enter ECS WebService 
URL. Replace <ECS 
Server> in URL with the 
ECS Server IP address.

Figure 6. SAP Equipment ID Provider Properties

Table 3. SAP Equipment ID (Continued)

CMMS 
Information 

Frame

Provider 
Properties

Default Value Description
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a. Change the Value column of the ServerAddr row to the DNS/IP address 
of the SAP/PM Server node.

b. Change the Value column of the ServerVersion row to the SAP/PM 
version being used.

c. Information needed for SAP/PM Router Address

d. Change the Value column of the SAPWebServer row to the DNS/IP 
name/address of the server for the SAP/PM web interface.

e. If required, change the Value column of the UseCredentials row from 
True to anything other than True (usually False). A value of True means 
that the configured SAP/PM Credentials of the current user is used for the 
submittal of Fault Reports. A value of False means that the SAP/PM 
Credentials of the current user is not used and it is required to 
reauthenticate the submittal of the Fault Report. Additionally, it is also 
required to configure the client and SAP Language parameters

f. Change the Value column of the ECSWebAccessURL as per the ECS 
software installation.

8. Click Apply. 

9. Click the back arrow in the Preview Area to return to the initial SAP 
Equipment ID aspect view and verify that the correct information appears in 
the CMMS Information frame.  

The fields and values that appear in the Create Fault Report Form and Submit 
Fault Report view are dependent on the contents of 
SapDef_FaultReportView.xml SAP/PM Definition file. Refer to Mapping 
between the 800xA System and the CMMS on page 35 for information on 
accessing and editing the SAP/PM Definition files.

Mapping between the 800xA System and the CMMS

The MxDef files (Maximo) and SAP/PM Definition (SAPDef) files (for SAP/PM) 
provide the mapping between the 800xA System environment and the CMMS 
system.  

Refer to Appendix A, CMMS Definition Files for an explanation of MxDef files and 
SAPDef files included with Asset Optimization.
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Maximo Integration

The Maximo Integration information can be found on Asset Optimization Server 
nodes. Refer to the Service Structure for the Asset Optimization Server.

Deploying the Maximo Model

The Maximo Model is installed at the following directory:

<InstallDrive>\Program Files\ABB Industrial IT\Optimize 
IT\AssetOptimization\AOECSConnector\EcsDefinitions

The Maximo Model File name to be used for the respective Maximo version is 
mentioned below.

* Feature Pack Functionality

Feature Pack Functionality

  

Table 4. Maximo Model File Name and Maximo Version

Maximo Model File Name Maximo Version

AOMaximoModel.xml 6.2

AOMaximo7Model.xml* 7.1

Before deploying the Maximo Model using Process Definition Tool, observe if 
another version of Maximo Model is already deployed. If so, uninstall the ECS 
4.2 version software and re-install it again.

Ensure to start the ABB cpmplus Enterprise Connectivity Services after 
restarting the node.

Ensure to set the Startup type for ABB cpmplus Enterprise Connectivity services 
as Manual.
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Deploy the Maximo Model where ECS software is installed. Follow the steps as 
mentioned below:

1. From the desktop, double-click the Process Definition Tool or go to Start > 
Programs > ABB cpmPlus connectivity and click on the process definition 
tool. The Process Definition Tool displays.

2. Click File > Open and navigate to the ECS model installation directory.

3. From the installation directory, select the respective Maximo Model file name 
and click Open.

4. Click Model > Deploy > Deploy to Production Environment.

5. Start/Restart the ABB cpmPlus Enterprise Connectivity Windows Service 
from the Services MMC Snap-in.

Modifying Maximo Definition Files

The MxDef files for the basic CMMS views (Active Work Orders, Work Order 
History, Equipment Status, Preventive Maintenance Schedule, Spare. Parts, 
Availability of Spare Parts (supported only in Maximo systems)) provides the 
information on the data to retrieve and display. 

The MxDef files for the Fault Report Submitter provides the information on the data 
to display, defines the data inputs/edit characteristics, and the data destination for 
the creation of a Work Order in the Maximo system.

When Customizing the MxDef Files, it should be saved in a predefined folder name 
"CustomDef" created under the folder where the MxDef files are installed:
...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\MaximoDef\CustomDef

In general, Asset Optimization software is configured to search the subdirectory 
created for the customized MxDef files before searching in the subdirectory for the 
default MxDef files.

The Maximo Definition XML Files are installed at the following directory:

Do not edit the MxDef files without consulting Maximo personnel to determine 
the required fields. Editing these files without the required knowledge and 
expertise may result in problems with the Maximo system and CMMS interface.
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<InstallDrive>\Program Files\ABB Industrial IT\Optimize 
IT\Asset Optimization\AOECSConnector\MaximoDef

The Maximo ECS Model is installed at the following directory:
 
<InstallDrive>\Program Files\ABB Industrial IT\Optimize 
IT\AssetOptimization\AOECSConnector\EcsDefinitions

Table 5. Modification Possibilities 

Function Description

Submit Fault Report The Work order fields that are sent to Maximo can be customized.

View Active Work Order The Columns and order can be customized.

View Equipment Status The Columns and order can be customized.

View Prev Maint Schedule The Columns and order can be customized.

View Spare Parts The Columns and order can be customized.

View Spare Part Availability The Columns and order can be customized.

View Work Order History The Columns and order can be customized.

Perform the following steps to modify the MxDef file:

1. In the installed directory, create a folder with the name “CustomDef” under the 
“MaximoDef”. Asset Optimization will always check for the existence of 
MxDef file under the “CustomDef” folder and if exists, it will load the MxDef 
file from this directory.

2. Open the MxDef file and Add/Remove Maximo Field/AttrDef element as per 
the requirement and Save the file.

3. In the ECS Model, Add/Remove the Equipment Type Property.

4. In the ECS Model, update property assignment in the Submit Event with the 
changed Property.
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5. Deploy the ECS Model and restart the ABB cpmPlus Enterprise Connectivity 
Windows Service.

Table 6. Asset Optimization Function, MxDef File, ECS Equipment Type mapping table 

Function MxDef file Name ECS Equipment Type

Submit Fault Report MxDefMOMAppFR_Submit.xml AOWorkOrderSubmitter

View Active Work 
Order

MxDef_GetAWO.xml AOWorkOrderList

View Equipment 
Status

MxDefGetEquipmentStatus.xml AOEquipmentStatusList

View Prev Maint 
Schedule

MxDefGetMaintenanceSchedule.xml AOPrevMaintScheduleList

View Spare Parts MxDefSpareParts.xml AOSparePartsList

View Spare Part 
Availability

MxDefAvailabilitySpareParts.xml AOSparePartsAvailability

View Work Order 
History

MxDef_GetHWO.xml AOWorkOrderList

1. The attributes that need to be added must be exposed by the Maximo Web 
service. 

2. The attribute name is case sensitive between the AO MxDef file and ECS 
Model Equipment Type Property.
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SAP/PM Integration 

The SAP/PM Integration information can be found on Asset Optimization Server 
nodes. Refer to the Service Structure for the Asset Optimization Server.

1. The SAPDef files provide the mapping between the 800xA System 
environment and the SAP/PM system.

Do not edit the SAPDef files without consulting SAP AG personnel to determine 
the required. Editing these files without the required knowledge and expertise 
will result in problems with the SAP/PM system and CMMS interface to the 
SAP/PM system.

    

2. Assuming the default directory was selected during Asset Optimization 
installation, the default SAPDef files supplied with Asset Optimization are 
located in:

...\Program Files\ABB Industrial IT\Optimize IT\ 
Asset Optimization\AOECSConnector\SAPPMDef 

These default SAPDef files are overwritten during an upgrade or reinstallation of 
the Asset Optimization software. 

3. When Customizing the SAPDef Files, save them in a predefined folder name 
"CustomDef" created under the folder where the SAPDef files are installed:

...\Program Files\ABB Industrial IT\Optimize IT\ 
Asset Optimization\AoAIPSAPWebSrv\SAPXML\ 
<SAPSERVERIP>\\AOECSConnector\SAPPMDef\CustomDef

In general, Asset Optimization software is configured to search the 
subdirectory created for the customized SAPDef files before searching in the 
subdirectory for the default SAPDef files.

Deploying the SAP  Model

 

  

Before proceeding further ensure that the ECS Software is installed and 
configured.  Refer to System 800xA Installation (3BSE034678*).

Ensure to start the ABB cpmplus Enterprise Connectivity Services after 
restarting the node.
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The SAP Model is installed at the following directory: 

<InstallDrive>\Program Files\ABB Industrial IT \OptimizeIT \ 
AssetOptimization\AOECSConnector\EcsDefinitions

The SAP  Model File name is AOSapModel.xml

Deploy the model on AO Server node where ECS software is installed. Follow the 
steps as mentioned below:

1. From the desktop, double-click the Process Definition Tool or Go to Start > 
Programs > ABB cpmPlus connectivity and click on the process definition 
tool. The Process Definition Tool displays.

2. Click File > Open and point the ECS model install directory.

3. Select the AOSAPModel.xml and click Open.

4. Click Model >Deploy > Deploy to Production Environment.

5. Start/Restart the ABB cpmPlus Enterprise Connectivity Windows Service 
from the Service MMC Snap-in.

Alarm Behavior upon Fault Report Submittal

The Fault Report Submitter must be set up in the Aspect System Structure to 
provide default values for each instance of it applied to individual objects in the 
Primary Structures. 

1. Use the Structure Selector to select the Aspect System Structure.

2. Navigate to:

CMMS Views, Aspect System > Fault Report Submitter, Aspect Type 
> Fault Report Submitter, Aspect Category

3. Click on Fault Report Submitter in the Aspect List Area to produce the 
config view of the Fault Report Submitter in the Preview Area

Ensure to set the Startup type for ABB cpmplus Enterprise Connectivity services 
as Manual.
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4. The only setup required is to enable or disable the Automatically dismiss 
Fault Report after successful submittal check box. This check box controls 
the default setting in the Submit Fault Report view. Enabling the check box 
(and leaving it enabled in the Submit Fault Report view) deletes the current 
condition from the system when it is successfully submitted. It also 
acknowledges the alarm in the Alarm and Event List and dismisses it if the 
Alarm and Event List is configured to do so. 

This function will not acknowledge alarms in Process Portal B.

User Privileges
The User Structure holds the defined users and user groups allowed to work in the 
system. Adding users and defining user roles is performed using the Configuration 
Wizard. All users must have a related Windows user account. The User object 
contains information about a user and what the user is allowed to do within the 
system. It also contains data specific to the user, such as profile configuration 
values. 

The User Structure contains two levels under the root object: the first level holds 
User Groups, and the second holds Users. The Everyone - IndustrialITUser User 
Group contains all Users. Users can be added to the system and to User Groups 
using the Configuration Wizard. 

Refer to the appropriate 800xA System documentation for detailed information on 
creating User Groups, adding Users, and the User Structure. 

Maximo User Credentials

Each User can contain Maximo Credentials. The Maximo Credentials contains the 
Maximo user credentials used to access the Maximo Server by the specific 800xA 
System user.

This procedure describes how to set up Maximo Credentials on a user.

1. Create a Maximo Credentials aspect on the desired User in the user Structure.

An authenticated web user (usually the logged on Windows user) must also be an 
800xA user to access the Asset Optimization web-enabled views (e.g. from the 
Process Portal B Asset Optimization context menu). 
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2. Right-click on the desired user and select Maximo Credentials from the 
context menu that appears. This opens the Maximo Credentials aspect shown 
in Figure 7. 

Figure 7. Maximo Credentials Aspect

TC04862C

 

3. Enter the user name and password information for the selected user for access 
to the CMMS.

4. Click Apply.

SAP User Credentials

Each User can contain SAP Credentials. The SAP User Credentials contains the 
SAP user credentials used to access the SAP/PM Server by the specific 800xA 
System user.

This procedure describes how to set up SAP Credentials on a user.

1. Create a SAP Credentials aspect on the desired User in the User Structure.

2. Right-click on the desired user and select SAP Credentials from the context 
menu that appears. This opens the SAP Credentials shown in Figure 8.  

3. Enter the user name and password information for the selected user for access 
to the CMMS.

4. Enter the SAP System Number.



Figure 8. SAP Credentials Aspect

TC06093A
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5. Enter the SAP Client Number.

6. Enter the desired user interface language (must be loaded onto the SAP server 
previously by the SAP Administrator).

7. Enter the SAP Version used.

8. Enter the IP address of the SAP server.

9. Enter the address of the SAP router ( ). Null means use the main SAP server 
address.

10. Click Apply.

Primary Structures
The following structures are called Primary Structures, because it is assumed that 
most operators and application engineers will perform the majority of their work 
within these structures.

• Asset Structure.
• Control Structure.
• Functional Structure.
• Location Structure.
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• Object Type Structure.
• User Structure.
• Workplace Structure.

These structures are built by placing objects into the structures according to their 
hierarchical relations. 

The object is a key concept in the Plant Explorer Workplace. The Plant Explorer 
Workplace is where the most basic elements of the system are created. These are the 
simple objects. Simple objects can be placed directly into a structure, but they can 
also be parts of other objects called composite objects. Simple objects can be pipes 
or valves or other basic elements used to build a more complex unit. 

Composite objects, which can contain several other simple objects, are called parent 
objects. They are composed of a number of subordinate objects, called children or 
descendents. When a new object is created, the parent object can be selected, to 
which the new object will be a child.  

 

Managing Data Source Connections
Asset Monitoring Engines manage connections to the OPC-DA servers required by 
the Asset Monitor Input Records. The data sources are specified during Asset 
Monitor configuration under the Input Records Tab. 

Each OPC-DA server is defined by one Asset Monitor Data Source aspect that 
identifies its connection parameters. It is recommended that Asset Monitor Data 

Building the various structures is beyond the scope of this User Manual. Refer to 
the appropriate System 800xA documentation for detailed information and 
definitions of the various structures. 

When the various structures are set up as desired, it may become necessary to 
move some Asset Optimization aspects to other areas in the structures by using 
the drag-and-drop method.

Do not move Asset Monitor Data Source aspects since all aspects referencing a 
moved Asset Monitor Data Source point to invalid Global Unique Identifiers 
(GUIDs).
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Source aspects be located in the Asset Optimization Object in the root of the 
Control Structure. 

After Asset Optimization installation, the Asset Optimization Object in the root of 
the Control Structure contains the default Afw OPC-DA Asset Monitor Data 
Source. This data source points to the 800xA System OPC Server located in the 
same node where the Asset Monitoring Engine is running (OPC Sever Node = 
localhost). 

1. Use the Structure Selector to select the Control Structure.

2. Navigate to:

Root, Domain > Asset Optimization, Asset Optimization

3. Select Afw OPC-DA Asset Monitor Data Source in the Aspect List 
Area to produce the Config view of the Afw OPC-DA Asset Monitor Data 
Source in the Preview Area as shown in Figure 9.  

Figure 9. Afw OPC-DA Asset Monitor Data Source Setup

TC04667D

 

The fields in the Asset Monitor Data Source are defined as follows:

– Server Type: Provides a list of preconfigured OPC-DA server templates.

Renaming an Asset Monitor Data Source aspect to the same name as an existing 
Asset Monitor Data Source aspect is not a valid configuration.

This procedure provides access to the Config view of the Afw OPC-DA Asset 
Monitor Data Source. Do not modify the values for this data source, since its 
configuration is shared by different Asset Monitors. 
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– Description: Data source description.

– Enable Write Access: Global switch to control write permission. Makes 
it possible to write values from an Asset Monitor.

– Default Data Source: If enabled, marks the selected data source as the 
default one. For backward configuration compatibility, it is recommended 
to leave the Afw OPC-DA Asset Monitor Data Source as the designated 
default data source.

– Browse OPC servers: If the logon user has OPC browsing privileges on 
the selected OPC server node, clicking Browse OPC servers lists 
available OPC servers in the specified node. 

The connection parameters for an OPC-DA server are:

– OPC Server Node: The hostname or address of the node hosting the OPC 
server. 

If the OPC Server Name is ABB.AfwOpcDaServer, then the OPC Server Node 
must be set to localhost.

– OPC Server Name: The ProgID of the OPC server to connect to. 
Whenever possible the OPC Server Name should be set to 
ABB.AfwOpcDaServer since this OPC Server provides access to any 
other OPC servers integrated in the 800xA System.

– OPC Group Update Rate (ms): Used by the OPC server for 
performance/scalability tuning purposes. Refer to the specific OPC server 
documentation for more information. 

If a different OPC Group Update Rate is needed (i.e., for 
ABB.AfwOpcDaServer) do not modify the default settings. Create a new Asset 
Monitor Data Source instead. This will avoid imposing the new settings on all 
Asset Monitors pointing to the default data source. 

4. If changes have been made, click Apply to save the entered data.

OPC connectivity to an OPC server located on a different node than the Asset 
Monitoring Engine uses DCOM protocol. Table 7 is a brief troubleshooting 
guide for typical OPC-DCOM connectivity problems. Refer to the specific 
OPC server documentation for additional troubleshooting.  



Table 7. OPC-DCOM Connectivity Troubleshooting Guide 

Problem Solution

Incorrect network protocol Use dcomcnfg.exe and make sure that TCP/IP is specified in the 
Default Protocol tab of both nodes. Ideally TCP/IP should be the 
first in the list unless other applications have different needs. 

Incorrect Launch/Access user 
credential

Use dcomcnfg.exe to add the identity used by the 800xA Service 
Account in the Launch/Access lists (Security tab) for the OPC 
server.

Some OPC servers need to 
run under a specific user 
account (e.g. interactive user 
or a specific NT account)

Use dcomcnfg.exe to modify the OPC server application identity 
settings (Identity tab) and select the appropriate user.
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Section 3  Configuration

Introduction 
This section describes the configuration steps required to add Asset Optimization 
functionality to an 800xA System automation solution. 

Asset Monitors provide automatic detection and reporting of changes in the 
monitored asset conditions. 

From a configuration point of view, an asset is represented by an 800xA System 
object. This object can contain a number of Asset Monitors to assess relevant asset 
condition states.

Asset Monitors integrate seamlessly with the 800xA Alarm and Event system and 
SMS and e-mail Messaging, Asset Optimization CMMS Connectivity, and PC 
Network and Software Monitoring. It also provides integration capability with 
Device Calibration Integration.  

A library of Basic Asset Monitors is provided with the Asset Optimization Asset 
Monitoring functionality when this functionality is licensed. This library can be 
extended using the Asset Monitor Software Development Toolkit, which can be 
obtained from ABB Product Development. 

This section contains configuration procedures applicable to all system 
extensions; however, procedures specific to PC, Network and Software 
Monitoring are located in System 800xA PC, Network, and Software Monitoring 
Configuration (3BUA000447*).
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This section provides procedures for configuring:

• Asset Monitors. Provides an overview of the tabs available for Asset Monitor 
configuration. Refer to Section 4, Basic Asset Monitor Library for detailed 
information on each Asset Monitor. Refer to System 800xA PC, Network, and 
Software Monitoring Configuration (3BUA000447*) for information on 
monitoring IT equipment and details on PC, Network and Software 
Monitoring. 

• Configuration Macros. Can be used when configuring Asset Monitors. They 
provide parametric configuration capabilities that are useful when designing 
Object Types.

• Asset Condition Reporting including the Asset Reporter and Asset Viewer.

• Maximo Integration including Mapping the 800xA System Object to the 
Maximo Equipment and CMMS Views.

• SAP/PM Integration including Mapping the 800xA System Object to the 
SAP/PM Equipment and CMMS Views.

• Alarm Grouping.

• Repeat the procedure for all other Alarm and Event Lists..

• Automatic Fault Report Submitter 

When creating aspects, it is possible to add a description and name to the aspect 
as desired. If the aspect is not named, the aspect category name is used and 
displayed in the Aspect List Area. Unless otherwise noted, the procedures in this 
User Manual use the aspect category name.

Asset Monitors 
Asset Monitoring configuration can be performed on any 800xA System node. 

To optimize the system engineering and minimize configuration effort, the 800xA 
System provides the capability to create object types that are used as templates to 
build the actual project configuration for the specific site.

Each Object represents a category of assets (e.g. a pump) used in the project specific 
configuration. The actual project configuration is composed of hierarchies of 
objects that are instances of previously defined Object Types. The following 
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example shows an object type for a pump that may include the aspects shown in 
Figure 10.   

As shown in the figure, every object of this type will have:

• Two Asset Monitors: a Runtime Asset Monitor to monitor the pump hours of 
operation and a High Limit Check to monitor the lube oil temperature. 

The Runtime Asset Monitor in this example has been renamed and does not 
match the category name of Running Time Check.

• CMMS Views: Active Work Orders, Work Order History, Equipment Status, 
Spare Parts, and Preventive Maintenance Schedule. 

• Maximo Equipment ID: Defines the corresponding equipment ID in the 
configured Maximo system.

• Fault Reporter Submitter: To submit Asset Monitor generated Fault Reports 
or to create a new Work Order in the CMMS system. 

TC05032B

Figure 10. Pump Object Type Definition
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• Runtime Faceplate and Runtime Faceplate Element: Constitute the 
faceplate. Used to reset the pump hours of operation when the pump is serviced 
(refer to System 800xA Asset Optimization Operation (3BUA000150*) for 
more information).

800xA provides inheritance for objects aspects so that changes on Object Types can 
be carried out automatically to all instances without the need to do the same change 
on all instances.

The default granularity of inheritance within the 800xA System is an aspect. If an 
aspect needs to be modified on the instance of that object, then its configuration 
inheritance is broken.

At times, customization of aspect configuration on instance level is necessary for 
Asset Monitor aspects. An example of such case would be:

An Object Type representing a type of pump having a Runtime Asset Monitor 
aspect may require adjusting the runtime limit at the instance level depending on the 
need of the particular pump instance.

Asset Monitor aspects provide a special inheritance behavior to allow modified 
aspect data on the instance level without stopping inheritance for other parts of the 
same aspect. It is possible to modify aspect configuration data for certain sections of 
an Asset Monitor aspect while still keeping inheritance for those configuration 
sections that do not need customization. This functionality increases the granularity 
of inheritance from the entire aspect to the following Asset Monitor configuration 
sections:

• Asset Monitor Tab: Execution Interval, Asset Monitor URL, and Logic 
Failure Severity.

• Condition Tab: For each Condition following SubCondition fields:

– Subcondition Name.
– Condition Label.
– Description.
– Severity.
– Corrective Action Taken.
– Possible Cause.
– Suggested Action.

• Asset Parameters Tab: Asset Parameters Values.
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• A&E Filters Tab:

– Severity Range.
– Source List.
– Alarm Categories.

• Input Records Tab: Fields:

– Data Source Aspect.
– Trigger Execution.
– Data Source Item.

Use of Asset Monitor aspects on Object Types is the preferred way of engineering if 
the customized object type with its Asset Monitor aspect will be used on several 
instances in the project. It is recommended for users to perform as much 
configuration as possible at the Object Type level to minimize or even eliminate the 
engineering effort for the Asset Monitoring aspect during instance-specific 
instantiation of the Object Type.

Configuration of Asset Monitor Aspects on Object Types

• Create the objects in the Object Type Structure and add the needed Asset 
Monitor aspects. 

• Configure the Asset Monitor aspects on the Object Type as far as possible by 
disabling the Inherit Configuration check box and entering the Object Type 
specific information. Refer to Asset Monitor Tab on page 57 through Logic Tab 
on page 67 for specific instructions on configuring the items under the various 
tabs in the Asset Monitor aspect.

• By disabling the Inherit Configuration check box the information will not be 
inherited from the category anymore regardless of whether or not it was edited.

• It is possible to re-enable the Inherit Configuration check box if it is 
necessary to go back to the original information. The manually edited data will 
be overwritten.

• Open the Object Type Definition aspect on the new Object Type and select 
Copy to all instances in the Aspect Control tab for the newly added Asset 
Monitor aspects. This setting translates into copying the Asset Monitor aspects 
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to all of its object instances, but these instance Asset Monitors will, by default, 
inherit from the Object Type. 

If the object type being extended with Asset Monitors belongs to an existing 
Library, then it is recommended to package the newly added aspects in a Library 
Extension. Refer to System 800xA Configuration (3BDS011222*) for more 
information.

• Whenever the Object Type gets instantiated, the Asset Monitors for this 
particular instance will inherit their information from the Object Type.

• An instance specific modification of an Asset Monitor aspect coming from an 
Object Type is still possible by disabling the Inherit Configuration check box 
on the specific TAB of the instance.

Configuration of Asset Monitor Aspects Directly on the Instances

In case there are only a few objects of the same type in a project or there is no object 
type available, Asset Monitor aspects can be directly added on Object instances in 
the Control Structure (inheritance from Category).

Add the Asset Monitor aspects to the object and configure the Asset Monitor aspect 
by disabling the Inherit Configuration check box and making required 
customization. Refer to Asset Monitor Tab on page 57 through Logic Tab on page 
67 for specific instructions on configuring the items under the various tabs in the 
Asset Monitor aspect.

By disabling the Inherit Configuration check box the information will not be 
inherited from the category regardless of whether or not it was edited.

It is possible to re-enable the Inherit Configuration check box if it is necessary to 
go back to the original information. The manually edited data will be overwritten.

For each Asset Monitor available for configuration there is a corresponding Asset 
Monitor Aspect Category as shown in Figure 11.    

Asset Monitors placed on an Object Type are not considered part of the active 
configuration. Their definition will not be loaded to the AO Server. 
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The Config view of each category of Asset Monitor contains the same tabs. They 
are summarized in Table 8. 

TC05031B

Figure 11. Asset Monitor Aspect Categories

Table 8. Asset Monitor Config View Tabs 

Tab Description Configurable

Asset 
Monitor

Allows selection of the AO Server assignment, Logic Execution 
Interval, Logic Failure Severity, and Asset URL. In Asset 
Monitor instances the Asset Monitor tab also provides 
information about Asset Monitor lifecycle such as: Configuration 
Last Modified time, Configuration Loaded to time, and 
Configuration Loaded to AO Server.

The Asset Monitor tab also provides an indication of the 
source of inherited configuration: either Asset Monitor Category 
or Object Type’s Asset Monitor.

Yes

Conditions Contains a list of conditions monitored by the logic and a list of 
subconditions defining each condition.

Yes

Asset 
Parameters

Contains asset specific information needed by the condition 
assessment logic for execution. 

Yes
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Asset Monitor Configuration
Asset Monitor configuration can be local or inherited from its configuration parent. 
To customize Asset Monitor configuration (make it local) it may be required to 
selectively break configuration inheritance on those areas of configuration that need 
customization.

The configuration inheritance source, which can be ascertained by looking at the 
Asset Monitor tab in the Asset Monitor Config View, shows the source of the 
inherited configuration for a particular Asset Monitor.

The inherited configuration source is automatically selected as follows:

• The Asset Monitor aspect in Asset Monitor Category object never inherits 
configuration. 

• An Asset Monitor aspect in an Object Type always inherits its configuration 
from the corresponding Asset Monitor Category: Inherits from Asset 
Monitor category.

• An Asset Monitors aspect defined in an object instance inherits configuration 
from either:

Input 
Records

Contains asset related measurement records needed by the 
condition assessment logic for execution, usually pointing to 
OPC items.

Yes

Output 
Records

Contains Output Records included in the ACD. If no Output 
Records exist on the Asset Monitor, this tab will not be shown.

No

A&E Filters Contains the Alarm and Event filters, if any, identifying the 
Alarm and Event to which the Asset Monitor subscribes. If no 
Alarm and Event filters are specified, this tab will not be shown. 

Yes

Logic Contains monitoring logic definition and Asset Monitor startup 
parameters.

Yes (Asset 
Monitor 
category only)

Table 8. Asset Monitor Config View Tabs (Continued)

Tab Description Configurable
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1. Corresponding Object Type: if the Asset Monitor was created by enabling the 
Copy to all instances check box on the Object Type > Type Definition Aspect 
> Aspect Control tab: Inherits from Object Type's Asset Monitor.

2. Corresponding Asset Monitor Category: if the condition in Step 1 is not met: 
Inherits from Asset Monitor Category. 

The source of inherited configuration applies to the entire Asset Monitor 
Configuration, not just the Asset Monitor tab.

 

Asset Monitor Tab

The following sections explain how to configure each tab of an Asset Monitor 
aspect configuration view. These generic Asset Monitor configuration instructions 
should be used together with Asset Monitor specific documentation to provide 
insight on the actual meaning of the configuration parameters. 

The first tab in the Asset Monitor Configuration view is the Asset Monitor tab. 
Figure 12 shows the Asset Monitor tab of the Bool Check Asset Monitor.

Asset Monitor configuration changes do not take effect in the AO Server until the 
Asset Monitor is explicitly loaded.



Asset Monitor Tab Section 3  Configuration

58 3BUA000118-510 G

Figure 12. Asset Monitor Tab



Section 3  Configuration Asset Monitor Tab

3BUA000118-510 G 59

To configure the Asset Monitor tab:

1. Server Assignment frame:

a. Configure Server Assignment by selecting AO Server designated to 
execute the Asset Monitor logic from the Assigned to drop-down list box. 
If Default is selected, then the AO Server designated to be the default will 
be used upon configuration load.

b. Enable the Enable in Server check box to include this Asset Monitor in 
the next AM Configuration Load to the specified AO Engine. If the 
Enable in Server check box is disabled then the next AM Configuration 
Load will remove (if previously loaded) this Asset Monitor from the 
specified AO Engine. 

Server Assignment configuration is never inherited from the parent.

 

 

2. Asset Monitor frame:

a. Enable the Inherit configuration check box to use the inherited 
configuration or disable it to customize the following configuration 
parameters.

– Logic Execution Interval: The requested time interval in seconds 
between subsequent, evenly spaced Asset Monitor logic executions in the 
Asset Monitoring Engine. 

The actual execution interval may be longer than the configured one on heavily 
loaded systems. Additionally, the actual execution interval may be shorter if any 
of the Asset Monitor Input Records or Alarm and Event filters have the Trigger 
Execution option enabled.

The AO Server that an Asset Monitor is assigned to is always the same for all 
Asset Monitors within one object. Upon creation of a new Asset Monitor on an 
object, the consensus AO Server value is assigned to it. If no other Asset 
Monitors exist on the object, then the copied value is used.

When a new Asset Monitor is created by Copy/Paste from an existing aspect, it 
will always be set to Enable in Server, no matter what this value was in the 
original aspect.
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– Asset URL: Address of a web page providing asset relevant information. 
When this configuration parameter is specified the Diagnostics menu 
entry is enabled in the Asset Monitor and Asset Reporter views. 
Configuration macros can be used in the Asset URL. Refer to 
Configuration Macros on page 76 for more information.

– Logic Failure Severity: The alarm severity used in alarming the 
abnormal status of an Asset Monitor, such as bad configuration or bad 
Input Records values. These kind of alarms are of the category Asset 
Monitoring Status Alarm and do not generate a Fault Report when 
activated.

b. Click Apply to save the configuration changes.

3. Asset Monitor lifecycle frame: This section provides information about the 
current configuration state of the Asset Monitor as it relates to the one loaded 
in the designated AO Server:

– Load Configuration to AO Server: Loads (or unloads if the Asset 
Monitor is disabled) this Asset Monitor to/from the configured AO Server. 
This operation can be performed even if the AO Server is not running.

– Last Modified: Timestamp of when this Asset Monitor configuration, or 
the one of the parent it inherits from, was last modified.

– Loaded to: Timestamp and AO Server name where this Asset Monitor 
configuration was last loaded to, if any.

Conditions Tab

The Conditions tab contains the definition of the condition or conditions that are 
assessed and reported by the specific Asset Monitor. The main functionality of the 
Asset Monitor is to monitor the operating parameters of an asset and report the 
current subcondition for each defined condition. 

Each condition is defined by a set of subconditions. Subconditions for a given 
condition are mutually exclusive. Subcondition ENUM 0 always represents the 
normal condition state. A transition to the normal state will deactivate the associated 
Asset Condition published in the containing object by a running Asset Monitor. 

The only subconditions that generate a Fault Report in the Fault Report Submitter 
are those that are not normal with good quality status.
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Asset Monitor conditions are defined in the Asset Monitor Category. However, it is 
possible to customize the Condition Labels at the Asset Monitor Category, Object 
Type, and instance level.

To customize the Condition Labels in Asset Monitors, it is necessary to break the 
selected Condition configuration inheritance by disabling the Inherit configuration 
check box. 

Figure 13 shows the Conditions tab of the Bool Check Asset Monitor with the 
Inherit configuration check box enabled. 

To modify the Condition Label for each condition:

1. Click Edit (next to the Condition drop-down list box).

2. Enter the new text (next to the Condition drop-down list box) and click Apply.

3. The configuration for the subconditions of each condition is as follows:

– ENUM: Integer that uniquely identifies the subcondition to the Asset 
Monitor logic. This field can not be customized.

After breaking inheritance (disabling the Inherit configuration check box) on 
one condition and modifying its data, first click Apply if it is intended to restore 
inheritance (enable the Inherit configuration check box) on the different 
condition. This step is necessary to avoid a loss of newly edited data on the first 
condition.

TC05024E

Figure 13. Conditions Tab
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– SubCondition: Subcondition Label. A non blank text string representing 
the subcondition state.

– Description: Subcondition description.

– Severity: Subcondition severity range 1 to 1000. This is also used when 
notifying the Alarm and Event List of a transition to this subcondition.

– CorrectiveActionTaken: The Asset Monitor may report an action that 
was taken by the system to reduce the effect of this state (e.g. emergency 
shutdown initiated).

– Possible Cause: Reports the diagnosis leading to this state (e.g. high 
vibration).

– Suggested Action: Provides hints on how to react (e.g. schedule 
maintenance) This is usually the most useful field when the related Fault 
Report is submitted in a CMMS as a Work Order.

Some Asset Monitors may dynamically provide the content of the subcondition 
fields and override user configured defaults.

It is possible to define configuration macros for the conditions definition. Refer to 
Configuration Macros on page 76 for more information.

Asset Parameters Tab

The Asset Parameters tab contains configuration parameters used to provide 
additional asset information required by the Asset Monitor algorithm. Refer to the 
specific Asset Monitor documentation for more information. 

It is possible to define configuration macros for the Asset Parameter values. Refer to 
Configuration Macros on page 76 for more information. 

Asset Monitor Asset Parameters are defined by the Asset Monitor category. 
However, it is possible to customize those parameter values at the Asset Monitor, 
Object Type, and instance level.

To customize Asset Parameter values in Asset Monitors, it is necessary to break the 
Asset Parameters configuration inheritance by disabling the Inherit configuration 
check box.
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Figure 14 shows the Asset Parameters tab of the Bool Check Asset Monitor with the 
Inherit configuration check box enabled.

Input Records Tab

The Input Records tab contains the definition of OPC-DA data items used by the 
Asset Monitor to assess the current asset condition.

Figure 15 shows the Input Records tab of the Bool Check Asset Monitor.

Figure 14. Asset Parameters Tab

TC05038E

Figure 15. Input Records Tab
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Asset Monitor Input Records are defined by the Asset Monitor category. However, 
it is possible to customize the Trigger Execution, Data Source Aspect, and Data 
Source Item fields at the Object Type, or instance level.

To customize Input Records in Asset Monitors it is necessary to break the Input 
Records configuration inheritance by disabling the Inherit configuration check 
box.

The columns in the Input Records tab are the same for all Asset Monitors and are 
defined as follows:

• ID: Input Record indentifier.

• Description: Input Record description.

• Units: Input record expected engineering units.

• Trigger Execution: When True, the Asset Monitor will be scheduled for 
immediate execution upon change notification of the subscribed OPC value. 
Thus setting this configuration parameter to True may increase the actual 
Asset Monitor execution frequency based on the Input Record's Data Source 
Aspect OPC Group Update Rate. Regardless of this setting the Asset Monitor 
will still be periodically executed based on the overall Execution Interval 
configuration parameter of the Asset Monitor.

• Data Source Aspect: Provides a pick list to select one of the available Asset 
Monitor Data Sources defining the OPC-DA server and related OPC group 
update rate sourcing the value. 

If Default is selected, then the Asset Monitor Data Source designated as the 
default will be selected upon configuration download to the Asset Optimization 
Server.

 

Multiple Asset Monitor Data Sources can be configured to point to the same OPC 
Server. Each Asset Monitor Data Source can have a different OPC Group Update 
Rate to optimize the load on the subsystem from which the data originates. Asset 
Monitor Data Source aspects are usually located in the Asset Optimization 
Object.
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• Data Source Item: Identifies the OPC item ID in the data server from which to 
read the value. 

If the Asset Monitor Data Source aspect points to the ABB.AfwOpcDaServer, 
the Data Source Item can be selected with the aid of the 800xA Properties 
Browser.

Click Open Properties Browser in the Input Records tab to open the 800xA 
Properties Browser similar to the one shown in Figure 16.  

To use the Object Properties Browser:

1. Navigate to the Process Portal Object containing the property that needs to be 
associated to the input record.

2. Select the aspect containing the property.

3. Browse the Aspect Properties in the bottom right frame and select the desired 
property.

TC05352B

Figure 16. 800xA Properties Browser
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4. Copy the name of the property from the 800xA Properties Browser into the 
Data Source Item of the appropriate Input Record. 

By default the 800xA Properties Browser provides a property name preceded by 
the fully qualified object name. If the property resides in the same object as the 
Asset Monitor, it is recommended to replace the object name with the %ID% 
macro. Refer to Configuration Macros on page 76 for more information.

 

A&E Filters Tab

The A&E Filters tab Contains the Alarm and Event Filters, if any, identifying the 
Alarm and Event to which the Asset Monitor subscribes. If no Alarm and Event 
Filters are specified then this tab will not be shown.

Asset Monitor Alarm and Event Filters are defined by the Asset Monitor category. 
However, it is possible to customize those filters at the Asset Monitor Object Type, 
and instance level.

To customize an Alarm and Event Filter it is necessary to break its configuration 
inheritance by disabling the Inherit configuration check box. Figure 17 shows the 
A&E Filters tab with the Inherit configuration check box disabled.  

TC08226A

Figure 17. A&E Filters Tab
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For each Alarm and Event Filter the following configuration parameters apply:

Severity Range: Specifies the severity range (inclusive) of the Alarm and 
Event of interest for the selected filter. Clients that wish to receive events of all 
severities should set the Low Severity to 1 and the High Severity to 1000.

Source List: A list of 800xA Object IDs or names sourcing the Alarm and 
Event of interest for the selected filter. Macros can be used in specifying a 
source; for example, %ID%. Refer to Configuration Macros on page 76 for 
more information. 

An empty source list will translate into a Filter All filter.

Categories: The list of categories of the Alarm and Event of interest for the 
selected filter. 

An empty categories list will translate into a Filter All filter.

Output Records Tab

The Output Records tab has no configurable values. The Output Records tab is 
only visible when the Asset Monitor has Output Records. It is for information only 
and shows the Output Records, if any, that will be included in an ACD. Output 
Records usually contain logic calculated values such as accumulated runtime and 
other defining information for the asset condition. 

Output Record values are published in the object, where the Asset Monitor resides, 
by the AssetMonitorProperties Control Connection aspect.

Logic Tab

The Logic tab has no configurable values in the Primary Structures. It shows the 
monitoring logic definition and the Asset Monitor startup parameters. 

The startup parameters of the Logic tab can be customized only in the selected 
Asset Monitor category object in the Aspect System Structure. Refer to the 
specific Asset Monitor documentation for more information.
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Asset Monitor Bulk Data Manager Support
Asset Monitors can be Added/Deleted/Modified using the Bulk Data Manager 
(BDM) 800xA engineering Excel add-in. 

When an Asset Monitor aspect is dragged into a BDM enabled Excel spreadsheet a 
pick list will expose all of the Asset Monitor configuration properties. 

Figure 18 shows a sample of Configuration properties for a Bool Check Asset 
Monitor.  

Asset Monitors of different categories may have a different set of configuration 
properties for Conditions, Asset Parameters, Input Records, A&E Filters, and 
Output Records.

TC08114A

Figure 18. Bulk Data Manager Configuration Properties Example
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Asset Monitor Tab Data 

The fields listed in Table 9, which represent properties in the Asset Monitor tab of 
the Asset Monitor aspect Config View are enabled in BDM. 

Enable the Hide write-protected properties option to only show updatable 
configuration properties. If invalid values or values for Read-only fields are 
entered, BDM will not apply such values to the referenced Asset Monitor upon 
configuration save. Furthermore, an error message will be displayed in the Errors 
worksheet of Excel.

Table 9. Asset Monitor Tab BDM Properties 

Property Name Notes Access

AOServer This field contains one of the following strings:

• The name of an AO Server formatted as 
ObjectName:Aspect Name (e.g. 
AO Server1:Asset Optimization Server)

• The string Default to reference the AO Server 
designated as the default in the system.

R/W

OnLine Enable in Server. Values: True, False R/W

ConfigurationParent Inherited configuration source R 

AssetMonitorInheritFromParent Inherit configuration switch. Values: True, False R/W

AlarmSeverity Range: integer 1 to 1000 R/(W)1

LogicExecutionIntervalSec Logic Execution Interval in seconds. Range: integer 
greater or equal to 1

R/(W)1

AssetMonitorURL Asset Monitor URL String R/(W)1

NOTE:
1. This field is read only if AssetMonitorInheritFromParent is True. 
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Conditions Tab Data

The fields listed in Table 10, which represent properties in the Conditions tab of the 
Asset Monitor aspect Config View are enabled in BDM.  

Table 10. Conditions Tab BDM Properties 

Property Name Notes Access

<ConditionName>.InheritFromParent Inherit configuration switch. Values: 
True, False

R/W

<ConditionName>.ConditionLabel Condition Label. Must be a non blank 
string.

R/(W)1

<ConditionName>. 
<SubConditionEnum>.SubCondition

SubCondition Names. Must be non 
blank.

R/(W)1

<ConditionName>. 
<SubConditionEnum>.Description

SubCondition Description string R/(W)1

<ConditionName>. 
<SubConditionEnum>.PossibleCause

SubCondition PossibleCause string R/(W)1

<ConditionName>. 
<SubConditionEnum>.SuggestedAction

SubCondition SuggestedAction string R/(W)1

<ConditionName>. 
<SubConditionEnum>.CorrectiveActionTaken

SubCondition CorrectiveActionTaken 
string

R/(W)1

<ConditionName>. 
<SubConditionEnum>.Severity

SubCondition Severity. Range: integer 
1 to 1000

R/(W)1

NOTE:
1. This field is read only if <ConditionName>.InheritFromParent is True. 

There can be one or more Conditions defined in an Asset Monitor. Each 
Condition can have two or more SubConditions defined.
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Asset Parameters Tab Data

The fields listed in Table 11, which represent properties in the Asset Parameters 
tab of the Asset Monitor aspect Config View are enabled in BDM.  

Input Records Tab Data 
There can be zero or more Input Records defined in an Asset Monitor.

The fields listed in Table 12, which represent properties in the Input Records tab of 
the Asset Monitor aspect Config View are enabled in BDM. 

Table 11. Asset Parameters Tab BDM Properties 

Property Name Notes Access

AssetParamsInheritFromParent Inherit configuration switch. Values: True, 
False

R/W

AssetParams.<AssetParam Name> Asset Parameter string Value R/(W)1

NOTE:
1. This field is read only if AssetParamsInheritFromParent is True. 

There can be zero or more Asset Parameters defined in an Asset Monitor.

Table 12. Input Records Tab BDM Properties 

Property Name Notes Access

InputRecords.InheritConfiguration Inherit configuration switch. Values: True, False R/W
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A&E Filters Tab Data

The fields listed in Table 13, which represent properties in the A&E Filters tab of 
the Asset Monitor aspect Config View are enabled in BDM. 

InputRecords. 
<InputRecordName>.DataSource

This field contains one of the following strings:

• The name of an Asset Monitor Data Source 
formatted as ObjectName:Aspect Name (e.g. 
Asset Optimization:Afw OPC-DA Asset 
Monitor Data Source)

• The string Default to reference the Asset 
Monitor Data Source designated as the 
Default in the system.

• The string None for unused optional Input 
Records.

R/(W)1

InputRecords. <InputRecordName>. 
TriggerAmExecution

True/False R/(W)1

InputRecords. 
<InputRecordName>.DataItemID

Data Item ID string R/(W)1

NOTE:
1. This field is read only if InputRecords.InheritConfiguration is True. 

Table 13. A&E Filters Tab BDM Properties 

Property Name Notes Access

OpcAeFilters.InheritConfigur
ation

R/(W)

OpcAeFilters.<FilterName>.
Description

Filter description text. R/(W)1

OpcAeFilters.<FilterName>.
HighSeverity

1 to 1000 R/(W)1

OpcAeFilters.<FilterName>.
LowSeverity

1 to 1000 R/(W)1

Table 12. Input Records Tab BDM Properties (Continued)
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Table 14 lists the A&E Filters tab EventTypes.

OpcAeFilters.<FilterName>.
EventTypes

This is not used if at least one category is defined in the 
filter. Refer to Table 14 for valid values.

R/(W)1

OpcAeFilters.<FilterName>.
TriggersAmExecution

True/False R/(W)1

OpcAeFilters.<FilterName>.
Sources

XML string format example: <Sources><S 
Name="%ID%"/><S Name="{DA4F7E12-F04E-4B58-
B659-462F80E6BB21}"/></Sources>

R/(W)1

OpcAeFilters.<FilterName>.
Categories

ML string format example:  “<Categories><Category 
ID="69781140" Name="Process Alarm for SoftAlarms" 
EventTypes="4"><Attrs/></Category></Categories>

R/(W)1

NOTE:
1. This field is read only if OpcAeFilters.InheritConfiguration is True. 

Table 14. A&E Filters Tab EventTypes 

EventType Value

Simple1 1

Tracking1 2

Condition 4

All1 7

Simple and Tracking1 3

Tracking and Condition1 6

Condition and Simple1 5

NOTE:
1. Not supported by the AO Server.

Table 13. A&E Filters Tab BDM Properties (Continued)
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Loading a Single Asset Monitor
It is possible to incrementally load or unload a single Asset Monitor by clicking 
Load Configuration to AO Server in the Asset Monitor tab of its configuration 
view. This action will perform exactly the same operation as selecting a single asset 
monitor from the Asset Monitors tab in the Asset Optimization Server aspect (refer 
to Loading Asset Monitor Configurations to an AO Server on page 21.

Click Load Configuration to AO Server on the Asset Monitor tab of its 
configuration view (Figure 19).   

1. If the configuration of the Asset Monitor has not changed since the previous 
load, the message stating that the configuration is up to date appears. If the user 
chooses to continue, the selected Asset Monitor’s configuration (the same as 

TC07795D

Figure 19. Load AM Configuration
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currently loaded) will be reloaded to the AO Server. Click Continue to load or 
Abort to quit. 

2. If the configuration of the Asset Monitor has changed (excluding AO Server 
field) since the previous load, a message stating that the Asset Monitor will be 
updated appears. If the user chooses to continue, the selected Asset Monitor’s 
new configuration will be reloaded to the AO Server. Click Continue to load 
or Abort to quit. 

3. If the configuration of the Asset Monitor has changed, including AO Server, 
since the previous load a message stating that the Asset Monitor will be 
removed from one AO Server and added to the another AO Server appears. If 
the user chooses to continue, the selected Asset Monitor’s new configuration, 
as well as all other enabled Asset Monitor aspects on the object, will be 
reloaded to the AO Server. Click Continue to load or Abort to quit. 

4. If the Asset Monitor has been disabled since the previous load a message 
stating that the Asset Monitor will be removed appears. If the user chooses to 
continue, the selected Asset Monitor will be removed from the AO Server. 
Click Continue to remove the Asset Monitor or Abort to quit. 

5. The Configuration Load information will be updated for the Asset Monitor 
aspect as shown in Figure 20. 

Figure 20. Configuration Load Information

TC07801B

 

6. Click on the X on the upper right corner of the Configuration Load information 
area to show the AM load button and related Lifecycle information again.
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Configuration Macros
Use the Configuration macros to configure Asset Monitors, CMMS Equipment ID. 
Configuration macros provides parametric configuration capabilities in designing 
the Object Types. 

Macros are the strings delimited by the % character that can be used in the following 
fields during the Asset Monitor Configuration, Maximo Equipment ID, and SAP 
Equipment ID Configuration.

• Conditions definition (Conditions Tab).

• Asset Parameter Values (Asset Parameters Tab).

• Input Records Data Source Items (Input Records Tab).

• URL Definition (Asset Monitor Tab).

• Source List (A&E Filters Tab).

• Maximo Equipment value. 

• SAP Equipment value.

If the % character is required in a field that accepts macros, enter using the %% 
characters sequence.

  

Macros contains the name of the 800xA System object property. The 800xA 
System object property value will be substituted during the Asset monitor 
configuration load to the Asset Monitoring Engine.

The following are examples of possible macro syntax:
%<PropertyName>%, example: %HighLow Limit Check.ProcessValue%

%<ObjectName>:<PropertyName>%, example: 
%AMTestObject1:HighLow Limit Check.ProcessValue%

%:<AspectName>:<PropertyName>%, example:
%:General Properties:HighLow Limit Check.ProcessValue%

%<ObjectName>:<AspectName>:<PropertyName>%, example: 
%AMTestObject1:General Properties:HighLow Limit 
Check.ProcessValue%
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%<QualifiedObjectName>:<PropertyName>%, example: %[Control 
Structure]Asset Monitoring Server/AMTestObject1:General 
Properties:HighLow Limit Check.ProcessValue%

%ID%/[Structure Name]ChildObjectName:AspectName:PropertyName, 
example: %ID%/[Control Structure]child1:GeneralProerties: 
CHILDPROPERTY

%..:<AspectName>:<PropertyName>%, 
example: %..:Name:Description%

%...:<AspectName>:<PropertyName>%, 
example: %...:CNGP:MX62%
 
where:
<ObjectName> is a placeholder for the name of a specific 
object in the system.
<AspectName> is a placeholder for the name of a specific 
aspect in the system.
<PropertyName> is a placeholder for a specific property in the 
system.

%ID% (where %ID% is a special macro that returns the 800xA 
System object Global Unique Identifier (GUID) on which the 
Asset Monitor resides). 

".." is used to return the property value one level up.

"..." is used to return the property value in the current 
object and all parent object till the value is found.

The following are the examples of possible macros:

1. %Name% or %:Name:Name% - returns the object name on which the Asset 
Monitor resides.

2. %ID%:PV - returns {69E932E4-2815-4D86-B235-DB226244705A}:PV 

%ID% can be used as a replacement of 800xA System object name when 
specifying OPC items in the 800xA System OPC server.



Asset Condition Reporting Section 3  Configuration

78 3BUA000118-510 G

 

Asset Condition Reporting
Asset Optimization provides asset condition reporting and monitoring status 
through the Asset Viewer, Asset Reporter, Fault Report Viewer (refer to System 
800xA Asset Optimization Operation (3BUA000150*) for information on the Fault 
Report Viewer), and the items accessible through their context menus.

Asset Reporter

The information in the Asset Reporter represents composite severity of an object 
and all children beneath it for the current structure. It is only necessary to insert an 
Asset Reporter on the object if access to the Asset Reporter view or the 800xA OPC 
properties is desired.

Figure 21 shows the Asset Reporter Main and Config views. All properties in these 
views are provided by the 800xA OPC server and can be used in faceplates, etc. 

Follow the guidelines to avoid possible property name uncertainty in specifying 
the macros:

• If possible, use the %ID% to identify a Process Portal Object, else use the 
fully qualified object name.

• If possible, include the aspect name in addition to the property name.
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TC08228A

Figure 21. Asset Reporter Main and Config Views
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Table 15 lists and describes the Asset Reporter composite values. Composite values 
are values calculated based only on the Asset Monitors in the object itself. 

Table 15. Asset Reporter Composite Values 

Property/Valu
e

Description

Severity Worst severity of all the Asset Monitors on the object.

-1 None of the Asset Monitors on the object are running or there are no Asset 
Monitors on the object. 

0 All Asset Monitor Conditions on the object are in normal subcondition.

1 to 1000 Worst subcondition on the object.

Quality Worst Asset Optimization quality on the object.

0 Good quality.

1 Uncertain quality.

2 Bad quality.

OPCQuality Worst object OPC quality.

192 Good quality (OPC_QUALITY_BAD   0x00).

64 Uncertain quality (OPC_QUALITY_UNCERTAIN 0x40).

0 Bad quality (OPC_QUALITY_GOOD 0xC0).

FRAvial Represents Fault Report availability on the object. 

0 (FALSE) No Fault Reports available on the object.

1 At least one Fault Report available on the object.

-1 No Fault Report aspect on the object
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Table 16 lists and describes the Asset Reporter propagated values. Propagated 
values are values calculated based on all Asset Monitors in the object and its 
descendants in a particular structure. 

Table 16. Propagated Values 

Property/Value Description

<Structure>.Severity Worst severity of the Asset Monitors of all descendant objects in that 
<Structure> tree branch.

-1 None of the Asset Monitors in the branch are running or there are 
no Asset Monitors in this tree branch.

0 All conditions of the Asset Monitor in the <Structure> tree branch 
are in normal subcondition.

1-1000 Worst subcondition in the <Structure> tree branch.

<Structure>.OPCQuality Worst OPC quality of all Asset Monitors of the descendant objects in 
that <Structure> tree branch.

192 Good quality (OPC_QUALITY_BAD   0x00).

64 Uncertain quality (OPC_QUALITY_UNCERTAIN 0x40).

0 Bad quality (OPC_QUALITY_GOOD 0xC0).

<Structure>.FRAvial Represents Fault Report availability in the <Structure> tree branch. 

0 (FALSE) No Fault Reports available in the branch.

1 At least one Fault Report available in the branch.

-1 No Fault Report aspect on the object.

NOTE:
1. Propagated values are values calculated based on all Asset Monitors in the object and its descendants in a 

particular structure.
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The Border around the Asset Reporter Main view (Table 17) represents the overall 
health of the Object Asset Monitors.  

Create an Asset Reporter aspect on each object that requires an Asset Reporter. No 
further action is required to configure the Asset Reporter. 

Asset Reporter with System Status

The Asset Reporter with System Status aspect, when added to an object, allows the 
Asset Reporter to participate in the System Status Viewer. 

Perform the following procedure to enable the Details view on the System Status 
Viewer.

1. Create an Asset Reporter with System Status aspect on the desired object.

2. Right-click on the Asset Reporter with System Status aspect and select Details 
from the context menu to launch the Details dialog.

3. Click Add and select System Status Details in the dialog that appears.

4. Click OK in both dialogs to close them.

Table 17. Asset Reporter Main View Border Description 

Border Description

None All Asset Monitors on the object are in the running state.

Orange Corresponding Asset Monitoring Engine has not completed first 
execution cycle.

Red Corresponding Asset Monitoring Engine is not in good state

If the object is inserted in one structure more than once, the second structure will 
be represented in the Asset Reporter OPC properties as {GUID} and not 
<Structure>.Property.

Only one aspect can expose System Status on an object. Do not instantiate an 
Asset Reporter with System Status aspect on an object that already exposes 
System Status properties (S_STATUS). Exposing the System Status properties 
more than once on the same object will cause the System Status Viewer/System 
Status Reporter to fail.
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Asset Viewer

The Asset Viewer, when added to an object, allows the Asset Tree to be displayed. 
When displayed, the Asset Tree shows the condition of that object and all its 
descendants. Figure 22 shows an example of an Asset Viewer in various stages of 
Asset Tree expansion.  

Create an Asset Viewer aspect on each object that requires an Asset Viewer. No 
further action is required to configure the Asset Reporter. 

Maximo Integration
In order to make CMMS Connectivity operational, it is necessary to perform the 
following procedures: 

• Mapping the 800xA System Object to the Maximo Equipment. 
• CMMS Views. 

TC08229A

Figure 22. Asset Viewer
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Mapping the 800xA System Object to the Maximo Equipment

The Maximo Equipment ID aspect provides information for mapping the 800xA 
System object to the Maximo equipment in the CMMS database for a particular 
Maximo Server. Multiple Maximo Equipment IDs can be associated with the same 
asset, thus providing the ability to map to more than one piece of equipment defined 
in Maximo. 

1. Create a Maximo Equipment ID aspect on the asset that requires a Maximo 
Equipment ID.

2. Right-click on the asset and select Maximo Equipment ID from the context 
menu that appears. This opens the Maximo Equipment ID like the one shown 
in Figure 23.

Feature Pack Functionality

For Feature Pack, refer Figure 24.
   

A given 800xA System object may map to many different Maximo Equipment 
IDs in the Maximo system. This may represent a breakdown/drilldown into a 
subassembly or what is called a crossover, in which a functional object is mapped 
into the subassembly/parts of a real machine which fulfills the specification for 
that functional location.

The items in the CMMS Information frame are grayed out and cannot be changed 
in this structure. For descriptions of, and the procedure to change this 
information, refer to Maximo Server Connection Properties on page 27.
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Figure 23. Maximo Equipment ID
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Feature Pack Functionality

3. If the Primary Structure was set up so that the asset name matches the 
Equipment Number in the Maximo Server, leave the Equipment field as it is. If 
the asset name does not match the Equipment Number in the Maximo Server, 
disable the Use Default Asset Name check box and change the Equipment 
field to match the Equipment ID in the Maximo Server. It is possible to define 
configuration macros for the Equipment ID definition. Refer to Configuration 
Macros on page 76 for more information.

4. If changes were made in Step 3, click Apply.

5. Repeat the procedure for each asset that requires a Maximo Equipment ID.

CMMS Views

The CMMS Views consist of: 

• View Active Work Orders.
• View Work Order History.
• View Equipment Status.
• View Preventive Maintenance Schedule.
• View Spare Parts/View Availability of Spare Parts.

Figure 24. Maximo Equipment ID
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The Fault Report Submitter, which is part of the Asset Optimization Server system 
extension, makes it possible to submit Fault Reports to the CMMS System.  

 

The procedure for adding all CMMS Views is the same. Create the desired CMMS 
View aspects on all assets that require them. No further action is required to 
configure the selected views. Refer to System 800xA Asset Optimization Operation 
(3BUA000150*) for information on the operational capabilities of the CMMS 
Views.

Maximo Bulk Data Manager Support

The Bulk Data Manager (BDM) is 800xA System engineering Excel add-in. The 
Maximo Equipment ID aspect can be added, deleted, and modified using the BDM. 
All CMMS Maximo views can be added and deleted using the BDM as well.

When a Maximo Equipment ID aspect is dragged into a BDM enabled Excel 
spreadsheet, a pick list will expose all of the configuration properties (Figure 25). 
Table 18 lists and describes the properties. 

 

 

These aspects can be added to Object Types. This allows objects to be created 
with these aspects already added. Refer to the appropriate System 800xA 
documentation for information on creating Object Types.

Before any CMMS Views are added to a particular object, all of the views are 
available in the list in the New Aspect dialog. Each time one of these views is 
added to the particular asset, it is removed from the list. This ensures that the 
same view is not added to a single asset more than once. The exception to this 
general rule is the Equipment ID aspect. Many Equipment ID aspects are allowed 
on any one object to facilitate the many to one mapping of an 800xA System 
object to a subassembly or crossover.
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TC08230A

Figure 25. Bulk Data Manager for Maximo Equipment ID

Table 18. Maximo Equipment ID BDM Properties 

Property Name Notes Access

UserDefaultName True/false. True if the asset name matches the 
Equipment Number in the Maximo server.

R/W

ItemName Equipment ID name in the Maximo server. R/(W)1

ItemType. Equipment type in the Maximo server. R

NOTE:
1. Writable only if UseDefaultName is FALSE. 
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SAP/PM Integration
In order to make CMMS Connectivity operational, it is necessary to perform the 
following procedures: 

• Mapping the 800xA System Object to the SAP/PM Equipment. 
• CMMS Views. 

Mapping the 800xA System Object to the SAP/PM Equipment

The SAP Equipment ID provides information for mapping the 800xA System object 
to the SAP/PM equipment in the CMMS database for a particular SAP/PM Server. 
Multiple SAP Equipment IDs can be associated with the same asset, thus providing 
the ability to map to more than one piece of equipment defined in SAP/PM. 

1. Create a SAP Equipment ID on an asset that requires a SAP Equipment ID.

2. Right-click on the asset and select SAP Equipment ID from the context menu 
that appears This opens the SAP Equipment ID like the one shown in 
Figure 26.

Feature Pack Functionality

For Feature Pack, refer Figure 27.

A given 800xA System object may map to many different SAP Equipment IDs in 
the SAP/PM system. This may represent a breakdown/drilldown into a 
subassembly or what is called a crossover, in which a functional object is mapped 
into the subassembly/parts of a real machine which fulfills the specification for 
that functional location.

The items in the CMMS Information frame are grayed out and cannot be changed 
in this structure. For descriptions of, and the procedure to change this 
information, refer to SAP/PM Server Connection Properties on page 31.
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Feature Pack Functionality

3. Set up the Primary Structure, so that the asset name matches the Equipment 
Number in the SAP/PM Server, leave the Equipment: field without modifying. 
If the asset name does not match the Equipment Number in the SAP/PM 
Server, disable the Use Default Asset Name check box and change the 
Equipment: field to match the Equipment ID in the SAP/PM Server. It is 
possible to define configuration macros for the Equipment ID definition. Refer 
to Configuration Macros on page 76 for more information.

4. If the changes were made in Step 3, click Apply.

Figure 26. SAP Equipment ID

Figure 27. SAP Equipment ID
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5. Repeat the procedure for each asset that requires a SAP Equipment ID.

CMMS Views

The CMMS Views consist of: 

• SAP View Active Work Orders.
• SAP View Work Order History.
• SAP View Equipment Status.
• SAP View Preventive Maintenance Schedule.

The Fault Report Submitter, which is part of the Asset Optimization Server system 
extension makes it possible to submit Fault Reports to the SAP/PM systems.  

 

The procedure for adding all CMMS Views is the same. Create the desired CMMS 
View aspects on all assets that require them. No further action is required to 
configure the selected views. Refer to System 800xA Asset Optimization Operation 
(3BUA000150*) for information on the operational capabilities of the CMMS 
Views.

SAP/PM Bulk Data Manager Support

The Bulk Data Manager (BDM) is 800xA System engineering Excel add-in. The 
SAP Equipment ID aspect can be added, deleted, or modified using the BDM. All 
CMMS SAP/PM views can be added or deleted using the BDM as well.

When a SAP Equipment ID aspect is dragged into a BDM enabled Excel 
spreadsheet, a pick list will expose all of the configuration properties (Figure 28). 
Table 19 lists and describes the properties

 

These aspects can be added to Object Types. This allows objects to be created 
with these aspects already added. Refer to the appropriate System 800xA 
documentation for information on creating Object Types.

Before any CMMS Views are added to a particular object, all of the views are 
available in the list in the New Aspect dialog. Each time one of these views is 
added to the particular asset, it is removed from the list. This ensures that the 
same view is not added to a single asset more than once.
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Figure 28. Bulk Data Manager for SAP Equipment ID
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Device Calibration Integration
Device Calibration Integration is an engineered solution. The solution is based on 
standard technologies like DBMS, OPC, XML and Web Services and allows 
integration between System 800xA and a third party calibration application. The 
horizontal (across features) and vertical (details of a feature) level of integration is 
determined by the openness of the calibration application.

Important features of such integration are:

1. Access to third party calibration application within System 800xA

2. Mapping between an object in System 800xA and a device in the calibration 
application1

3. Exchange of calibration events between System 800xA and the calibration 
application

4. Calibration condition alarm notification to operator.

5. Generation of calibration work order.

1. Level of integration is determined by the openness of the calibration application.

For more information and integration solution, contact ABB technical support.
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Authentication
To configure authentication, refer to the appropriate 800xA System documentation 
to enable log over features.

Authentication for the AO Server

1. Use the Structure Selector to open the Aspect System Structure. 

2. Navigate to Asset Optimization Server object and enable appropriate 
authentication for all the required operations as shown in Figure 29.

Figure 29. Enabling Authentication

TC07825C

     

Alarm Grouping
Alarm and Event Lists are part of the base 800xA System and are added to objects 
when building the various structures. Building the various structures in the 800xA 
System is beyond the scope of this User Manual. Refer to the appropriate System 

Table 19. SAP Equipment ID 

Property Name Notes Access

UserDefaultName True/false. True if the asset name matches the 
Equipment Number in the SAP/PM server.

R/W

ItemName Equipment ID name in the SAP/PM server. R/(W)1

NOTE:
1. Writable only if UseDefaultName is FALSE. 
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800xA documentation for detailed information on the various 800xA System 
structures.

The Alarm and Event Lists are used to group alarm points together. They define the 
group of events being sent to the same group of people. For ease of use, take 
advantage of the defined structures to group the assets. All child objects in the 
structure can be defined as being included. 

Operators can view Alarm and Event Lists according to the selected filter and 
presentation settings. These settings can be changed. For example, a list can be 
sorted by clicking on a column header, resizing columns, or moving them by using 
drag and drop. 

Filtering and presentation functions allow alarms to be viewed in dedicated ways. 
For example, a list can be configured to show all alarms or only those alarms 
relevant for the associated object and its descendents.

Acknowledging and silencing alarms can be done within a list, for one or more 
selected alarms, or for multiple alarms per page or entire lists. Object alarms can be 
acknowledged through process graphics displays. Refer to System 800xA - Asset 
Optimization Operation, and other appropriate 800xA System documentation for 
more information on acknowledging alarms.

Up to 1000 priorities can be defined with acknowledge and unacknowledged colors.

To configure an Alarm and Event List:

1. Use the Object Browser to navigate to an object with an Alarm and Event List 
to configure. 

2. Select Alarm and Event List in the Aspect List Area.

3. Click the View Configuration button as shown in Figure 30 and the Alarm and 
Event List Configuration dialog shown in Figure 31 appears.  

 

4. There are two categories of alarms that are used exclusively by Asset 
Optimization:

Asset Condition Alarm: Generated by an Asset Monitor when an 
abnormal asset condition is detected. An example of an Asset Condition 
Alarm is when the hours of operation of an asset (equipment) has been 



Figure 30. View Configuration
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exceeded. A suggested action might be some periodic preventative 
maintenance action.

Asset Monitoring Status Alarm: Generated when something is abnormal 
in the Asset Optimization execution environment. An example of an Asset 
Monitoring Status Alarm is when the Asset Monitoring Engine is unable 
to read OPC values. Another example is when a particular Asset Monitor 
is not properly configured and is unable to execute.

TC04704B

Figure 31. Alarm and Event List Configuration Dialog
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By using the Filter tab on an Alarm and Event List, it is possible to filter on 
these categories. Figure 32 shows the Asset Optimization Group in the Filter 
tab. 

Figure 32. Alarm and Event List Filter Tab

TC08235A

 

5. Click Apply and then close the dialog.

6. Repeat the procedure for all other Alarm and Event Lists. 
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Asset Optimization Reporting Configuration
These procedures provide general guidelines for configuring Asset Optimization 
Reports. For detailed information, refer to the Creating Reports and Scheduling 
sections in System 800xA - Information Management, Operation.

Asset Optimization Reporting provides a preconfigured Job Description for each of 
the Asset Optimization Report Templates in the system. Each Asset Optimization 
Report Job Description must be configured prior to reporting.

Asset Optimization Report Templates are configured in the Scheduling Structure. 

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Scheduling Structure in the Plant 
Explorer Workplace.

3. Use the Object Browser to navigate to:

Schedules and Jobs > Job Descriptions, Job Folder > 
AO Asset Condition History, Job Description

4. Select Scheduling Definition in the Aspect List Area to produce the 
Scheduling Definition aspect view, with the Schedule tab selected, in the 
Preview Area as shown in Figure 33. 

Figure 33. Scheduling Definition Aspect

TC07774B

 



This procedure describes configuration to automatically run reports on a 
configured schedule. The Run Now button is used to run reports as desired. For 
more information on operator actions, refer to System 800xA Asset Optimization 
Operation (3BUA000150*).
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5. Select the type of schedule desired (cyclic, periodic, weekly, or monthly) in the 
Schedule: drop-down list box.

6. Depending on the schedule type selected, the bottom half of the aspect view 
will change. Fill in the fields as desired to complete the configuration for that 
schedule type.

7. Enable the Enabled check box. This check box must be enabled in order for 
reports to run automatically.

8. Select the server that will execute a given job in the Service Group: drop-
down list box. The default is the primary service group which is the first 
service group created, not necessarily the first one listed in the Service 
Structure. To avoid unexpected results, it is recommended to specify a server 
where the report will run.

9. The Action Aspect must also be configured for each report type. This defines 
the input parameters for the report and how the report will be retained and 
optionally printed or archived using Information Management. Select Action 
Aspect in the Aspect List Area to produce the Action Aspect view in the 
Aspect Preview Area as shown in Figure 34.   

10. Select Report Action from the Action: drop-down list box.

11. If desired, a timeout value may be specified in the Time Limit (seconds): 
field, but in most situations the default values for the Time Limit (seconds), 
Isolated:, Priority:, Attempts:, and System Messages: fields should be used.

12. Select the report template to be used. Click ... next to the Report Template 
Path: field and select the desired Asset Optimization Report template. The 
location of the templates is shown in Figure 35.  

13. There are Report Parameters to configure for each report type. These are 
displayed after clicking Add Parameter. The parameters for each report type 
are described in the topics immediately following this procedure:



Figure 34. Action Aspect
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Figure 35. Asset Optimization Report Template Location.

TC07777B
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– AO Asset Condition History Report Parameters on page 101.
– AO Running Time Report Parameters on page 101.

14. Select the appropriate parameter to change and click Modify to edit the 
parameter in the Value column, leaving the parameter name in the Name 
column intact.

15. When the modifications to the desired reports are complete, click Close and 
continue to Exporting Reports on page 102. 
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AO Asset Condition History Report Parameters

The AO Asset Condition History Report Template (refer to Figure 36) requires 
configuration of the following parameters:

• StartDate: Start time (oldest event) in mm/dd/yyyy hh:mm am/pm format.

• EndDate: End time (newest event) in mm/dd/yyyy hh:mm am/pm format.

• AEObjPath: Path to object with the configured AO Asset Condition Event 
aspect (Alarm and Event aspect type) that is the source of the report data. The 
default Asset Condition Event List aspect is found under the AO Asset 
Condition Report Template object.

• MaxRows: Maximum number of rows to retrieve for this report.

• ReportTitle: Title to appear in the header of the printed report. 

 

AO Running Time Report Parameters

The AO Running Time Report Template (refer to Figure 37) requires configuration 
of the following parameters:

• Structure: Name of the structure in which to start the object search (usually 
the Asset Structure).

• RootObject: Name of the root object under the structure to start the object 
search.

• AspectType: Objects with this aspect type to be included in the report, usually 
Running Time Check.

TC07778A

Figure 36. AO Asset Condition History Report Parameters
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• ReportTitle: Title to appear in the header of the printed report. 

Figure 37. AO Running Time Report Parameters

TC07780A

 

Exporting Reports

Reports are saved on the local system by exporting. 

1. Enable the Export Paths: check box in the Action Aspect view in the Preview 
Area.

2. Click Add Object Path to save the reports in the Aspect system. These will be 
retained under:

Reports > folder name

in the Scheduling Structure. These may then be later reviewed and/or printed 
by any clients on the system that have Microsoft Excel installed locally.

3. If required, output reports can also be saved to a local file folder. Click Add 
File Path to configure the output folder and file name. 

The print area is predefined in the Excel spreadsheet. This can be modified and 
saved in the template if required. This definition is used when the Printer check 
box is enabled and a printer selected from the drop-down list box in the Action 
Aspect.

 

A printer needs to be set up on the workstation that the AO Excel based reports 
are run. This is due to the Report Title being set. Excel requires that a default 
printer be set up to do this, whether or not the report is being printed.

 

Refer to System 800xA - Asset Optimization, Operation for information on 
reviewing reports, printing reports, etc. 
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Automatic Fault Report Submitter
The Fault Report Submitter is enhanced to allow Fault Reports to be automatically 
submitted to a CMMS with the user defined values when a specific Asset Monitor 
Condition and SubCondition become active. Auto submittal is managed through a 
new Aspect View on the Fault Report Submitter Aspect.

Configuring Fault Report Auto Submittal

To configure automatic submittal of Fault Reports, first configure a Fault Report 
Submitter Aspect (that is, CMMS integration must be properly configured and a 
Fault Report Submitter Aspect must be able to manually submit a Fault Report to 
the CMMS).

To enable a Fault Report to be submitted automatically, the default values must be 
specified. Select a Fault Report Submitter Aspect and change the Aspect View to 
the Default View.

After creating the Fault Report defaults, any changes to Equipment ID aspect or 
Asset Monitor aspect on the object is not reflected in the saved Fault Report 
default of the object. In such a scenario the Fault Report default should be re-
created with the necessary changes..

Figure 38. Select the Defaults View
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The default view shows the familiar grid layout. This view lists all the configured 
Fault Report Defaults that may be automatically submitted.

Creating a new Fault Report Default

To create new Fault Report Defaults, right-click on the first row in the table (where 
the field shows New) and click Create New.

The Create Fault Report Default page appears. Select the desired CMMS 
Provider, Asset Monitor, Condition, and SubCondition and click Get Fault Report 

Figure 39. Default Views

Figure 40. Create New Menu
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Fields. When the selected SubCondition becomes active on the selected Asset 
Monitor, the Fault Report Default will be automatically submitted by the AO server.

The Edit Fault Report Defaults page appears. Enter the desired values for the 
Fault Report. These values will be automatically submitted when the selected 
SubCondition becomes active. Automatic submittal is enabled by selecting the 
Auto Submittal Enabled check box. Once the editing is completed, click Save 
Fault Report Defaults. A confirmation message appears when the save process is 

Figure 41. Create Fault Report Default Page
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completed. To return to the Defaults View again, click Home at the top of the 
Aspect window.

Figure 42. Edit Fault Report Defaults Page

If a new Fault Report Default is created with the same Asset Monitor, Condition, 
and SubCondition as an existing default, the new one will overwrite the existing 
one. This is due to the fact that defaults are uniquely identified by those three 
values, and therefore it is not possible to have two defaults with those same three 
values.
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Modifying Existing Fault Report Defaults

From the default view, it is possible to edit and delete the existing Fault Report 
Defaults. Right-click the row for the desired Fault Report Default, a context-menu 
appears with the two options - Edit or Delete.

Select the Edit option to display the Edit Fault Report Defaults page with the saved 
values of the selected Fault Report Default. Make any desired changes and click 
Save to save the changes.

Select the Delete option to delete the Fault Report Default from the system. The 
values stored in it will be lost and it will no longer be automatically submitted.

Automatically Submitting Fault Reports

Fault Report Defaults will be automatically submitted when the SubCondition 
specified by the Fault Report Default becomes active (provided that the Fault 
Report Default is enabled). It is possible to check the summary of the Defaults View 
of the Fault Report Submitter Aspect.

If the listed Auto Submit column is checked which indicates that Fault Report 
Default will be submitted automatically. If the listed Auto Submit column is 
unchecked, no changes will happen when the SubCondition for that Fault Report 
Default becomes active. It is possible to change the Auto Submit behavior by 
editing the Fault Report Default as described previously. 

Figure 43. Modify Menu

Automatic fault report must be sparingly used as there will be a performance 
impact with delayed execution of subsequent Asset Monitor.
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Maintenance Workplace
Asset Optimization information can be accessed from any workplace in the 800xA 
System. The Maintenance Workplace is a default workplace for maintenance 
personnel.

Setting up the Maintenance Workplace Shortcut

Follow the steps mentioned below to use Maintenance Workplace:

1. Click Start, and click All Programs and then click ABB Industrial IT 800xA 
System.

2. Click Workplace, ABB Workplace login dialog appears.

3. Select Maintenance Workplace / Maintenance Workplace 2 and then click 
Create Desktop Shortcut as shown in the Figure 44.

Figure 44. Workplace Selection Window

 

4. The new Maintenance Workplace / Maintenance Workplace 2 icon is placed on 
the Desktop. 
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Adding Assets to the Maintenance Workplace

All assets that are engineered in the system can be inserted into the Asset Structure. 
They can be grouped in a way that supports typical maintenance workflow in a more 
efficient way than in the Control, Location, or Functional Structures.

To add an asset to the Maintenance Workplace:

1. Select a dedicated Asset Group in the Asset Structure where it is desired to add 
an engineered asset.

2. Right-click on the selected Asset Group and select Insert Object from the 
context menu.

3. The Insert Object dialog appears. Navigate to and select the asset to insert.

4. Click Insert.

The selected Object will show up in the selected Asset Group. All Asset Alarms of 
the new inserted Object will show up in the Alarm Band of the Maintenance 
Workplace. They will appear in the Alarm Group of one of the five Root Asset 
groups. 

Application specific modifications of the alarm band or the Maintenance Workplace 
are possible. Refer to System 800xA Operations Operator Workplace Configuration 
(3BSE030322*) for details.

The new workplace provides an easy, enhanced and efficient way for the user to 
view the Asset Monitor condition details in few clicks. The Maintenance Workplace 
2 is based on the Asset Structure. All the assets that are engineered in the system has 
to be inserted into the Asset Structure.

For Operation information, refer to System 800xA Asset Optimization Operation 
(3BUA000150*).

Setting High Precedence for Asset Reporter Aspect Categories

Maintenance Workplace 2 is designed to display an Asset Reporter Aspect in the 
Aspect Preview by default when an Object is selected. The Asset Reporter preview 

When deleting the Object containing Asset Monitors that are inserted in any other 
Structure, delete the Object from the Control Structure before other Objects are 
deleted from all the other Structures.
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will be loaded only when an Asset Reporter Aspect is evaluated as default Aspect 
on the selected Object.

In addition to the built-in Aspect Precedence List, a new Aspect Precedence List 
Asset Optimization APL can be found in the Library Structure which is valid for the 
entire system.

To make the Asset Reporter and the Asset Reporter with System Status Aspect as 
the default Aspect on the Object, the User level precedence should be configured to 
use Asset Optimization APL. To know more about User level Precedence refer to 
Operator Workplace Configuration manual (3BSE030322*).

Maintenance Management Filter

To make the Maintenance Management Filter as the default for the Maintenance 
users, the default filter should be set to the Maintenance Management in the 
Workplace Profile Values Aspect on the user Object as shown in the Figure 45. 

Once this configuration is performed, the Maintenance Management Filter is 
applied when the workplace is launched by this user.

Figure 45. Workplace Profile Values Aspect
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NAMUR NE107
With this release, the icons used in Asset Viewer, Asset Condition details and colors 
used in Asset Reporter Aspect are based on the Namur NE107 recommended icons 
and colors. A new Color definition Object is available to make use of NAMUR 
NE107 recommended colors for the Alarms in the Alarm and Event List. 

Restore Existing Icons and Colors
Users must be a part of the Administrators - IndustrialITAdmin User Group to 
perform this operation.

Users have an option to revert to the existing icons instead of Namur. To revert to 
the existing icons: 

1. Open the Plant Explorer Workplace. 

2. Go to Aspect System Structure. Click Asset Tree Aspect System and then 
click Asset Viewer Aspect Category.
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3. Click on the Icon Setting Aspect as shown in the Figure 46.

Figure 46. Icon Change Configuration Window

4. In the Main view of the Aspect, change the value from True to False and then 
click Apply. 

5. Restart all the open Workplaces. Users will be able to see the old icons instead 
of Namur icons. 

Alarm Color Definition

It is possible to use the Namur NE 107 recommended colors for Alarms in the 
Alarm and Event list. The Alarm Color DefinitionAspect is used to configure the 
colors of the Alarms.  A new Alarm & Event Color Definition object name 
NAMUR NE107 Alarm Color Definition can be found in the Library Structure. To 
make use of the colors based on the Namur NE107 for Alarms, select NAMUR 
NE107 Alarm Color Definition in the Color Defintion area of the Alarm and Event 
List Configuration Aspect. 
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Section 4  Basic Asset Monitor Library

Introduction
This section contains procedures for creating and configuring the Asset Monitors 
contained in the Basic Asset Monitor Library. The Basic Asset Monitor Library is 
provided with the Asset Optimization Asset Monitoring license feature. The Config 
view of each Asset Monitor has six tabs provided for configuration. These 
procedures contain only those tabs with configuration procedures that are unique to 
each Asset Monitor. Refer to Asset Monitors on page 50 for descriptions of all the 
tabs, and procedures for configuring those that are common to all Asset Monitors.

The Asset Monitors contained in the Basic Asset Monitor Library are:

• Bad Quality Check.
• Bool Check.
• Flow Delta.
• Limit Check (High, HighLow, and Low).
• Runtime.
• XY Profile Deviation.
• Counter Check.
• System Status.

Creation, Configuration, and Commissioning (Single 
Instance) 

The following details the general steps for the creation, configuration, and 
commissioning of a single instance of an Asset Monitor. This procedure can be 
performed in object types or repeated for each object instance needing an additional 
Asset Monitor.
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1. Create the desired Asset Monitor on an Object type or Object Instance needing 
an additional Asset Monitor.

2. Click on the newly added Asset Monitor in the Aspect List Area to produce the 
default view of the Asset Monitor in the Preview Area.

3. Click on the View Selector and select Config to open the Config View in the 
Preview Area.

4. The view appears with the Asset Monitor tab selected. If needed, customize 
the items in the Asset Monitor tab as described under Asset Monitor Tab on 
page 57.

5. If needed, configure the items in the Conditions tab as described under 
Conditions Tab on page 60.

6. If needed, configure the Asset Parameters, Input Records, and A&E Filters 
Tabs as instructed by the Asset Monitor specific documentation.

7. Click Apply.

To commission the configured Asset Monitor:

1. Perform an Incremental Load as described under Asset Monitor Tab on page 
57. 

-or-

Perform a Full AO Server Load as described in Loading Asset Monitor 
Configurations to an AO Server on page 21.

2. Verify that the AO Server to which the Asset Monitor was loaded is enabled; if 
not, enable it.

3. Select the newly loaded Asset Monitor default view.

4. Right-click on one of its conditions and select Asset Monitor Status from the 
context menu.
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5. Verify that all the configuration parameters and input records have the 
expected data and runtime values. 

Most Asset Monitors report Configuration Errors or Input Record bad quality 
value problems in the overall Asset Monitor status. When this happens an Asset 
Monitoring Status alarm is also generated. Refer to Asset Monitor Tab on page 57 
for information on how to configure the severity for these kind of alarms.

Configuring Asset Monitor Inhibit functionality
Most Asset Monitors implement the standard inhibit functionality. This allows for 
conditionally inhibiting the Asset Monitor from reporting not normal conditions 
with their related alarm and fault report.

An Asset Monitor inhibited state is as follows:

• All of its conditions are set to the Normal State with a quality of 
goodLocalOverride and a description of Inhibited.

• The overall Asset Monitor Status quality is set to goodLocalOverride and the 
related status text to inhibited.

• All of the alarms related to the Asset Monitor are deactivated (set to normal).

• All of the Asset Monitor output records, if any, will have their quality set to 
Bad Not Connected.

The following details the general steps to configure an Asset Monitor for standard 
inhibit functionality:

1. Open the Asset Monitor aspect to be configured.

2. Click on the View Selector and select Config to open the Config View in the 
Preview Area.

3. Select the Input Records tab.

4. Configure the Inhibit Input Record as follows:

– Trigger Execution = True.

– Data Source Aspect: Select the appropriate data source providing the 
Inhibit value.



Bad Quality Check Section 4  Basic Asset Monitor Library

116 3BUA000118-510 G

– Data Source Item: Select the appropriate OPC Item ID providing the 
Inhibit value.

5. Select the Asset Parameters tab.

6. Configure the Inhibit_Value asset parameter to a value that, when equal to 
the Inhibit Input Record runtime value, will set the Asset Monitor to its 
inhibited state. Inhibit_Value examples are OFF, False, 1, 0x00000001 
(32-bit hexadecimal notation).

7. If present, configure the Inhibit_Value_Mask_Hex asset parameter. A 
32-bit hexadecimal notation integer. A value other than 0xFFFFFFFF 
represents a 32-bit mask that is applied (bitwise AND) to the Inhibit Input 
Record value before comparing it with the Inhibit_Value asset 
parameter. 

When the Inhibit_Value_Mask_Hex is configured, it is necessary to specify 
the Inhibit_Value Asset Parameter using the hexadecimal notation.

 

If either the Data Source Aspect or Data Source Item fields of the Inhibit Input 
Record are left blank, the inhibit functionality is disabled.

Bad Quality Check
The Bad Quality Check Asset Monitor notifies if there is a bad or uncertain quality 
indication from a control system input. Refer to Creation, Configuration, and 
Commissioning (Single Instance) on page 113 for general background information.

1. To change the Asset Parameters for this instance of the Asset Monitor, click 
the Asset Parameters tab. The view shown in Figure 47 appears. All of the 
Asset Parameters listed can be changed.    

a. The values are used for the following:

– ExecutionsRequiredForTrigger: Positive integer representing the 
number of subsequent executions required to recognize a change in the 
OPCQuality Input Record value. Tune this parameter to filter out 
momentary quality value changes. For example, the initial subscription to 
an OPC item may return a bad quality value. 

b. Change the fields to the desired values.

2. Click Apply.



Figure 47. Asset Parameters Tab (Bad Quality Check)

TC05021E
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3. Click the Input Records tab and the view shown in Figure 48 appears. The 
view shown has values configured.  

Figure 48. Configured Input Records Tab (Bad Quality Check)

TC05022E

 

4. Click on the Data Source Aspect column and select the OPC server from 
which to receive the data. This is a data source that was created in Managing 
Data Source Connections on page 45.

5. Fill in the Data Source Item column with the OPC item providing the value to 
be monitored.
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6. Click Apply. 

Refer to Configuring Asset Monitor Inhibit functionality on page 115 if inhibit 
functionality is needed.

7. The Output Records and Logic tabs are common to all Asset Monitors. Refer 
to Output Records Tab and Logic Tab on page 67 for more information.

Bool Check
The Bool Check Asset Monitor monitors a signal with two states: normal and alarm. 
Depending on the configuration, it notifies if the signal is in its alarm state, or if it is 
not in its normal state. Refer to Creation, Configuration, and Commissioning 
(Single Instance) on page 113 for general background information.

1. To change the Asset Parameters for this instance of the Asset Monitor, click 
the Asset Parameters tab. The view shown in Figure 49 appears. All of the 
Asset Parameters listed can be changed.   

Figure 49. Asset Parameters Tab (Bool Check)

TC08117B

 

a. The values are used for the following:

– Normal_Value and Alarm_Value: These two Asset Parameters are 
mutually exclusive; if one is configured the other must be set to a blank 
value. These Asset Parameters can be configured with any of the 
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following values: Numeric value (e.g. 1, 1.123, etc.), String Values (e.g. 
Running), 32-bit hexadecimal notation integers (e.g. 0X02).

– Input_Value_Mask_Hex: 32-bit hexadecimal notation integer. A value 
other than 0xFFFFFFFF represents a 32-bit mask that is applied (bitwise 
AND) to the Signal Input Record value before comparing it with the 
Normal_Value or Alarm_Value Asset Parameter. When the 
Input_Value_Mask_Hex is configured to a value other than 
0xFFFFFFFF, it is necessary to specify a 32-bit hexadecimal notation 
integer for the Normal_Value or Alarm_Value Asset Parameter.

Change the fields to the desired values.

2. Click Apply.

3. The Bool Check Asset Monitor logic is as follows:
If (Signal Input Record quality is not good) then

State Condition is set the previously calculated 
SubCondition with a quality of BadLastKnownValue
Else If Normal_Value asset parameter is configured then

If (Signal Input Record AND Input_Value_Mask_Hex) = 
Normal_Value then

State Condition is set to the Normal SubCondition 
Else

State Condition is set to the Alarm SubCondition
Else If Alarm_Value asset parameter is configured then

If (Signal Input Record AND Input_Value_Mask_Hex) = 
Alarm_Value then

State Condition is set to the Alarm SubCondition 
Else

State Condition is set to the Normal SubCondition

Boolean Value "True" or "False" is not allowed as it is a reserved OS keyword
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4. Click the Input Records tab and the view shown in Figure 50 appears. The 
view shown has values configured.  

Figure 50. Configured Input Records Tab (Bool Check)

TC08118B

 

5. Click on the Data Source Aspect column and select the OPC server from 
which to receive the data. This is a data source that was created in Managing 
Data Source Connections on page 45.

6. Fill in the Data Source Item column with the OPC items providing the value 
to be monitored.

7. Click Apply. 

Refer to Configuring Asset Monitor Inhibit functionality on page 115 if inhibit 
functionality is needed.

8. The Output Records and Logic tabs are common to all Asset Monitors. Refer 
to Output Records Tab and Logic Tab on page 67 for more information.

Flow Delta
The Flow Delta Asset Monitor monitors the difference between two numeric values 
(i.e. steam flow and feedwater flow) and notifies if the difference exceeds a 
configured percentage of the first value. Refer to Creation, Configuration, and 
Commissioning (Single Instance) on page 113 for general background information.
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1. To change the Asset Parameters for this instance of the Asset Monitor, click 
the Asset Parameters tab. The view shown in Figure 51 appears. All of the 
Asset Parameters listed can be changed.  

Figure 51. Asset Parameters Tab (Flow Delta)

TC05029E

 

a. The values are used for the following:

– AllowablePercentDeviation: This value defaults to 5% and is used to 
calculate the difference between the two Input Records: Feedwater Flow 
and Steam Flow. If the difference is more than five percent, or whatever is 
configured, an ACD and alarm are generated. 

If:

Feedwater Flow Steam Flow– 100× Feedwater Flow AllowablePercentDeviation×>

Then:

SubCondition LimitExceeded=

Else:

SubCondition WithinLimit (normal)=

Change the fields to the desired values.

2. Click Apply.
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3. Click the Input Records tab and the view shown in Figure 52 appears. The 
view shown has values configured.   

Figure 52. Configured Input Records Tab (Flow Delta)

TC05030E

   

4. Click on the Data Source Aspect column and select the OPC server from 
which to receive the data. This is a data source that was created in Managing 
Data Source Connections on page 45.

5. Fill in the Data Source Item column with the OPC item providing the value to 
be monitored.

6. Click Apply. 

Refer to Configuring Asset Monitor Inhibit functionality on page 115 if inhibit 
functionality is needed.

7. The Output Records and Logic tabs are common to all Asset Monitors. Refer 
to Output Records Tab and Logic Tab on page 67 for more information.

Limit Check (High, HighLow, and Low)
The High Limit Check Asset Monitor monitors a process value and notifies if it 
exceeds configured limit values that include the high limit value and the high limit 
value plus a negative offset value. The HighLow Limit Check Asset Monitor 
monitors a process value and notifies if it exceeds configured limit values that 
include the high limit value, the high limit value plus a negative offset value, the 
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low limit value, and the low limit value plus a positive offset value. The Low Limit 
Check Asset Monitor monitors a process value and notifies if it exceeds configured 
limit values that include the low limit value and the low limit value plus a positive 
offset value.

Refer to Creation, Configuration, and Commissioning (Single Instance) on page 113 
for general background information.

1. To change the Asset Parameters for this instance of the Asset Monitor, click 
the Asset Parameters tab. The view shown in Figure 53 appears showing the 
default values. All of the Asset Parameters listed can be changed.  

Figure 53. Asset Parameters Tab (HighLow Limit Check)

TC04687E

 

The Asset Parameter values shown in Figure 53 reflect the HighLow Limit Check 
Asset Monitor. The values for the High Limit Check and Low Limit Check Asset 
Monitors contain only those applicable to each. 

a. By default the values for Range/Upper, Range/Lower, 
ConditionConfig/HighLimit/Value and 
ConditionConfig/LowLimit/Value are dynamically read from the Input 
Record specified in the Value column. Optionally, a fixed numeric value 
can be entered in the Value column; in this case the corresponding Input 
Record can be left unconfigured (select None for the Data Source Aspect).
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b. The values for ConditionConfig/HighLimit/OffsetValue and 
ConditionConfig/LowLimit/OffsetValue can be defined as a percentage 
of range (by appending the % character to their numeric value), or a fixed 
numeric value. These offset values are evaluated in absolute value. 

If a percentage is chosen, then the HighOffset subcondition limit is 
defined by:

ConditionConfig/HighLimit/Value
Range/Upper Range/Lower–( ) ConditionConfig/HighLimit/OffsetValue×

100
------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------–

and the LowOffset subcondition limit is defined by:

ConditionConfig/LowLimit/Value
Range/Upper Range/Lower–( ) ConditionConfig/LowLimit/OffsetValue×

100
-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------+

If a fixed numeric value is chosen, then the HighOffset subcondition limit 
is defined by:

ConditionConfig/HighLimit/Value ConditionConfig/HighLimit/OffsetValue–

and the LowOffset subcondition limit is defined by:

ConditionConfig/LowLimit/Value ConditionConfig/LowLimit/OffsetValue+

2. Click Apply.

3. The HighLow Limit Check Asset Monitor logic is as follows:
If (ProcessValue Input Record quality is not good) then

(High/Low) Limit Condition is set the previously calculated 
SubCondition with a quality of BadLastKnownValue
Else
If (ProcessValue >= HighLimit) then

High Limit Condition is set to the High SubCondition 
ElseIf (ProcessValue >= HighOffsetLimit) then

High Limit Condition is set to the HighOffset 
SubCondition
Else

High Limit Condition is set to the Normal SubCondition
If (ProcessValue <= LowLimit) then

Low Limit Condition is set to the Low SubCondition 
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ElseIf (ProcessValue <= LowOffsetLimit) then
LowLimit Condition is set to the LowOffset SubCondition

Else
Low Limit Condition is set to the Normal SubCondition

4. Click the Input Records tab and the view shown in Figure 54 appears. The 
view shown has values configured. 

The Input Records shown in Figure 54 reflect the HighLow Limit Check Asset 
Monitor. The values for the High Limit Check and Low Limit Check Asset 
Monitors contain only those applicable to each. 

 

Figure 54. Configured Input Records Tab (HighLow Limit Check)
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5. Click on the Data Source Aspect column and select the OPC server from 
which to receive the data. This is a data source that was created in Managing 
Data Source Connections on page 45.

6. Click Apply. 

7. Fill in the Data Source Item column with the OPC item providing the value to 
be monitored.

8. Click Apply. 

Refer to Configuring Asset Monitor Inhibit functionality on page 115 if inhibit 
functionality is needed.

9. The Output Records and Logic tabs are common to all Asset Monitors. Refer 
to Output Records Tab and Logic Tab on page 67 for more information.
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Runtime
The Runtime Asset Monitor monitors the accumulated runtime hours of a device 
and notifies, for preventive maintenance, that the runtime has accumulated up to a 
configured limit. Refer to Creation, Configuration, and Commissioning (Single 
Instance) on page 113 for general background information.

1. To change the Asset Parameters for this instance of the Asset Monitor, click 
the Asset Parameters tab. The view shown in Figure 55 appears. All of the 
Asset Parameters listed can be changed. 

Figure 55. Asset Parameters Tab (Runtime)

TC05013E

 

a. The values are used for the following:

– Hours_Running_Limit: Positive numeric value in hours engineering 
units. When the AdjustedHoursRunning Output Record is greater or 
equal to Hours_Running_Limit, then the RunTime Limit Reached 
condition is set to the Yes subcondition.

– Percent_Of_HoursUnaccounted_applied_to_AdjustedHoursRunning: 
Numeric value ranging from 0 to 100. Used to account for time when the 
Asset Monitor is unable to monitor the running status of the asset; for 
example, if the Monitoring Server is shut down or if the RunningStatus 
Input Record is not in good quality.
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– RunningStatusValue: This Asset Parameters can be configured with any 
of the following values: a Boolean value (True, False), numeric value 
(e.g. 1, 1.123, etc.), String Values (e.g. Running), 32-bit hexadecimal 
notation integers (e.g. 0X02). The monitored asset running time is 
accumulated when the RunningStatus Input Record value (after the 
optional mask is applied) is equal to this RunningStatusValue Asset 
Parameter.

– RunningStatusValue_Mask_Hex: 32-bit hexadecimal notation integer. 
A value other than 0xFFFFFFFF represents a 32-bit mask that is applied 
(bitwise AND) to the RunningStatus Input Record value before 
comparing it with the RunningStatusValue Asset Parameter. When the 
RunningStatusValue_Mask_Hex is configured to a value other than 
0xFFFFFFFF, it is necessary to specify a 32-bit hexadecimal notation 
integer for the RunningStatusValue Asset Parameter.

Change the fields to the desired values.

2. Click Apply.

3. Click the Input Records tab and the view shown in Figure 56 appears. The 
view shown has values configured. ResetSignal and HoursResetBias are 
configured by default. 

Figure 56. Configured Input Records Tab (Runtime)

TC05014E
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4. Click on the Data Source Aspect column and select the OPC server from 
which to receive the data. This is a data source that was created in Managing 
Data Source Connections on page 45.

5. Fill in the Data Source Item column with the OPC item providing the value to 
be monitored.

6. Click Apply. 

This Asset Monitor requires write access to be enabled on the Data Source used 
for the ResetSignal and HoursResetBias Input Records.

The Runtime Asset Monitor generates six Output Records. The Output Records 
tab of a Runtime Asset Monitor instance is shown in Figure 57.   

The Output Records are:

• HoursRunning: Provides the number of hours accumulated while the 
RunningStatus Input Record value, after the optional bit mask has been 
applied, matched the RunningStatusValue Asset Parameter.

• AdjustedHoursRunning: Provides an adjusted HoursRunning estimate based 
on the following function:

A B C D×
100

-------------- 
 +=

Where:

TC05039C

Figure 57. Output Records Tab (Runtime)
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A = AdjustedHoursRunning 
B = HoursRunning 
C = HoursUnaccounted 
D = Percent_Of_HoursUnaccounted_applied_to_AdjustedHoursRunning

• HoursUnaccounted: Provides the number of hours accumulated while the 
Asset Monitor was not able to monitor the RunningStatus Input Record value.

• LastReset: Date and time of the last HoursRunning reset.

• HoursRunningLimit: Number of AdjustedHoursRunning hours that trigger 
the Runtime Limit Reached condition.

• IsRunning: True when monitored asset is running.

Refer to Configuring Asset Monitor Inhibit functionality on page 115 if inhibit 
functionality is needed. When the Runtime Asset Monitor is inhibited it will not 
increment the HourRunning or HoursUnaccounted regardless of the 
RunningStatus input record value.

The Runtime Asset Monitor requires a user interface to reset the runtime. Therefore, 
a Runtime Asset Monitor Object Type is provided as an example of how to add a 
Runtime Asset Monitor, including the related faceplate, to an existing Object Type 
or instance representing the asset to be monitored. Figure 58 shows the Runtime 
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Asset Monitor faceplate.  

To reset the runtime using the faceplate:

1. Click the button next to Reset Hrs.: to set the initial runtime hours. 

2. Click Reset.

3. In order to add Runtime Asset Monitoring capability to an Object Type, the 
following five aspects are required to be added to that Object Type.

a. Runtime Asset Monitor

b. Runtime Asset Monitor Faceplate Inputs

c. Runtime Faceplate

d. Runtime Faceplate element

e. Asset Reporter

TC05034B

Figure 58. Runtime Asset Monitor Faceplate
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For this purpose, it is recommended to copy and paste the required aspects from the 
Runtime Asset Monitor Object Type to the target Object Type. Once the aspects are 
copied, it is necessary to modify the Object Type Definition aspect, Runtime Asset 
Monitor should be approved from reference Tool and in element tab object should 
be pointed to the new target Object Type. Refer to Figure 59.  

Where:

• Runtime Asset Monitor: Represents one Runtime Asset Monitor.

• Runtime Faceplate and Runtime Faceplate Element: Constitute the 
faceplate. The Runtime Faceplate Element needs to be deployed after it is copied in 
the target Object Type.

• Runtime Asset Monitor Faceplate Inputs: Contains two supporting 
properties (OPC items) used to link the faceplate runtime reset inputs to the 
Asset Monitor.

TC05033B

Figure 59. Runtime Asset Monitor Object Type
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• Asset Reporter: Shows all the object conditions and provides access to the 
Fault Report Submitter, if configured on the object.

Renaming the Runtime Asset Monitor or Runtime Asset Monitor Faceplate Input 
aspects properties will break the links between such aspects and the related 
Runtime Faceplate Element. A new Runtime Faceplate Element can be deployed 
that points to the new aspect names.

 

Refer to System 800xA Upgrade (3BSE036342*) for backup and restore 
procedures for Runtime data.

XY Profile Deviation
The XY Profile Deviation Asset Monitor compares a two-dimensional value (a 
point in a Cartesian plane) against a baseline function and notifies if the deviation 
from the baseline is less than or greater than the configured limit.

The XY Profile Deviation Asset Monitor uses an external Excel configuration file. 
This file contains the definition of a XY reference function and related High and 
Low profiles. When defining the XY reference profile function, the X values must 
be in ascending order with no duplicate X values. 

When the operating point lies outside the defined reference profile (Xpoint is less 
than reference profile Xmin or Xpoint is greater than reference profile Xmax), the 
High and Low profiles will be set to be parallel to the extrapolated reference profile 
(same slope as the slope of the last defined reference profile segment).

Refer to Creation, Configuration, and Commissioning (Single Instance) on page 113 
for general background information.
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1. To change the Asset Parameters for this instance of the Asset Monitor, click 
the Asset Parameters tab. The view shown in Figure 60 appears. All of the 
Asset Parameters listed can be changed.   

Figure 60. Asset Parameters Tab (XY Profile Deviation)

TC05017E

 

a. The values are used for the following:

– XY_Reference_Profile_FileName: This value contains the file name 
(without a path) of the Excel workbook containing the baseline XY profile 
with relative allowable deviations (High and Low Limit profiles). 

The Excel files containing the XY profiles must reside in the following directory: 

Installdrive:\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin\XY_Reference_Profiles

 

 

A sample XY profile is provided in the XY_Reference_Profiles directory. It is 
recommended to copy TestProfile.xls, rename it, and modify it as required. 
Figure 61 shows the sample XY profile. 

  



Figure 61. Sample XY Profile

TC05040A
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Change the fields to the desired values.

2. Click Apply.
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3. Click the Input Records tab and the view shown in Figure 62 appears. The 
view shown has values configured.  

Figure 62. Configured Input Records Tab (XY Profile Deviation)

TC05018E

 

4. For each Input Record, click on the Data Source Aspect column and select the 
OPC server from which to receive the data. This is a data source that was 
created in Managing Data Source Connections on page 45.

5. Fill in the Data Source Item column with the OPC item providing the value to 
be monitored.

6. Click Apply. 

Refer to Configuring Asset Monitor Inhibit functionality on page 115 if inhibit 
functionality is needed.

 

Refer to System 800xA System, Upgrade for backup and restore procedures for 
XY Profile Deviation data.

 

Counter Check
The Counter Check Asset Monitor counts the number of transitions of an input 
signal and generates an abnormal condition when the count exceeds the configured 
limits. The counter can be reset to an initial value through the provided faceplate. 
Refer to Creation, Configuration, and Commissioning (Single Instance) on page 113 
for general background information.
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1. To change the Asset Parameters for this instance of the Asset Monitor, click 
the Asset Parameters tab. The view shown in Figure 63 appears. All of the 
Asset Parameters listed can be changed.   

Figure 63. Asset Parameters Tab (Counter Check)

TC08504A

 

a. The values are used for the following:

– Low_Warning_Limit: Number of times the Input_Signal Input 
Record value has changed before the Asset Monitor reports a Low 
Warning Limit exceeded condition.

– High_Limit: Number of times the Input_Signal Input Record value 
has changed before the Asset Monitor reports a High Limit exceeded 
condition.

– High_High_Limit: Number of times the Input_Signal Input Record 
value has changed before the Asset Monitor reports a High-High Limit 
exceeded condition.

– Input_Value_Mask_Hex: A 32-bit integer in hexadecimal that is applied 
(bitwise AND) to the Input_Signal Input Record value before 
evaluation. If this mask is set to 0xFFFFFFFF it will be ignored.

– Transition_Value (optional): The counter is incremented only when the 
Input_Signal Input Record value (after the optional 
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Input_Value_Mask_Hex is applied) transitions to match this Asset 
Parameter value. If this value begins with 0x it will be interpreted as a 
hexadecimal value. If this value is left empty it will be ignored.

Change the fields to the desired values.

2. Click Apply.

3. Click the Input Records tab and the view shown in Figure 64 appears. The 
view shown has values configured.  

Figure 64. Configured Input Records Tab (Counter Check)

TC08505A

 

4. Click on the Data Source Aspect column and select the OPC server from 
which to receive the data. This is a data source that was created in Managing 
Data Source Connections on page 45.

5. Fill in the Data Source Item column with the OPC items providing the value 
to be monitored.

6. Click Apply. 

Refer to Configuring Asset Monitor Inhibit functionality on page 115 if inhibit 
functionality is needed.



Counter Check Section 4  Basic Asset Monitor Library

138 3BUA000118-510 G

The Counter Check Asset Monitor generates five Output Records. The Output 
Records tab of a Runtime Asset Monitor instance is shown in Figure 65.  

The Output Records are:

• Counter: The number of transitions of the Input_Signal Input Record.

• Last_Counter_Reset: Date and time of last counter reset.

• Low_Warning_Limit: The counter value that when exceeded will trigger the 
Asset Monitor to report a Warning subcondition.

• High_Limit: The counter value that when exceeded will trigger the Asset 
Monitor to report an High subcondition.

• High_High_Limit: The counter value that when exceeded will trigger the 
Asset Monitor to report an High High Subcondition.

The Counter Check Asset Monitor requires a user interface to reset the counter. 
Therefore, a Generic Counter Check Asset Monitor Object Type is provided as an 
example of how to add a Counter Check Asset Monitor, including the related 
faceplate, to an existing Object Type or instance representing the asset to be 

TC08506A

Figure 65. Output Records Tab (Counter Check)
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monitored. Figure 66 shows the Counter Check faceplate. 

To reset the counter using the faceplate:

1. Click the numeric button next to Reset Count: to set the initial count.

2. Click Reset.

3. In order to add Counter Check Monitoring capability to an Object Type or 
object instance, the five aspects shown in Figure 67 are required to be added to 
such object. For this purpose, it is recommended to copy and paste the required 
aspects from the Generic Counter Check Asset Monitor Object Type to the 
target object. If these aspects are copied to an Object Type then it is necessary 
to modify the Object Type Definition aspect by properly setting the newly 

TC08507A

Figure 66. Counter Check Asset Monitor Faceplate
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added Aspect Instantiation attributes as shown in Figure 67. 

Figure 67. Generic Counter Check Asset Monitor Object Type

TC08508A

Where:

• Asset Reporter: Shows all the object conditions and provides access to the 
Fault Report Submitter, if configured on the object.

• Counter Check AM Faceplate Properties: Contains two supporting 
properties (OPC items) used to link the faceplate counter reset inputs to the 
Asset Monitor.

• Counter Check Asset Monitor: The Counter Check Asset Monitor.

• Counter Check Faceplate: Counter Check Asset Monitor Faceplate.
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• Counter Check Faceplate Element: Counter Check Asset Monitor Faceplate 
Element. 

Renaming the properties of the Counter Check Asset Monitor aspect or Counter 
Check Asset Monitor Faceplate properties aspect will break the links between 
such aspects and the related Counter Check Faceplate Element. If needed, a new 
Counter Check Faceplate Element can be configured and deployed using the 
names of the modified aspect properties.

 

Refer to System 800xA Administration and Security (3BSE037410*) for backup 
and restore procedures for Counter Check Asset Monitor data.

4. The Logic tab is common to all Asset Monitors. Refer to Logic Tab on page 67 
for more information.

System Status
The System Status Asset Monitor subscribes to the information provided by the 
800xA System Status properties and reports such information in the form of an 
Asset Condition Document. 

The System Status Asset Monitor can be configured on any object that exposes the 
800xA System Status properties. Refer to Creation, Configuration, and 
Commissioning (Single Instance) on page 113 for general background information.
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1. Click the Input Records tab and the view shown in Figure 68 appears. The 
view shown has values configured.  

Figure 68. Configured Input Records Tab (System Status)

TC08509A

 

2. Click on the Data Source Aspect column and select the OPC server from 
which to receive the data. This is a data source that was created in Managing 
Data Source Connections on page 45.

3. Fill in the Data Source Item column with the OPC item providing the value to 
be monitored.

4. Click Apply. 

Refer to Configuring Asset Monitor Inhibit functionality on page 115 if inhibit 
functionality is needed.

5. The System Status condition/subcondition selection logic is documented in 
Table 20. 

Table 20. System Status Condition - Subcondition Selection Logic 

S_STATUS Input Record 
Value

System Status Subcondition Selected

OK = 0 0 OK. This is the normal condition (no alarm).

ERROR = 1 1 Error

WARNING = 2 2 Warning
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6. The Output Records and Logic tabs are common to all Asset Monitors. Refer 
to Output Records Tab and Logic Tab on page 67 for more information.

NOT_VALID = 253 253 Not Valid

OUT_OF_SERVICE = 255 255 Out of Service

value not in good quality Uses the last known subcondition and sets its quality 
to BadLast KnownValue.

Table 20. System Status Condition - Subcondition Selection Logic (Continued)

S_STATUS Input Record 
Value

System Status Subcondition Selected
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Section 5  Control Loop Asset Monitor (CLAM)

Introduction 
The Control Loop Asset Monitor (CLAM) is designed to monitor in real time the 
quality and performance of process control loops in control systems in order to 
bring actionable information on loop quality and performance to controls engineers 
where and when they need it most. By providing actionable information on control 
loops directly at the operator screen, information is delivered to plant operations and 
maintenance personnel in a timely manner.

CLAM is set up in the 800xA System to monitor process control loops in real time, 
displaying complex analysis of control loops in a clear and straightforward manner. 
Additionally, CLAM is independent of the type of controllers used in ABB systems, 
whether AC800M or any of the other controllers available from ABB.

Each Control Loop Asset Monitor is associated with its own control loop. The 
controllers continuously provide process value (PV), set point (SP), and control 
output (CO) data. This data is captured by the 800xA System as OPC data. The 
CLAM is configured using its input records to receive PV, SP, and CO data from its 
control loop through CLAM log Configuration (the historian data of these OPC 
properties).

The CLAM logic reads and collects SET of DATA of the process value (PV), set 
point (SP), and control output (CO) data from history. This data set collected is sent 
to the CLAM auditing logic. The auditing logic performs loop analysis and returns 
the results as the loop diagnosis. The loop diagnosis is then published by the 
“Control Loop Asset Monitor” aspect of the Control Loop Asset Monitor Ex object 
type instance.

The Control Loop Asset Monitor provides user friendly access to the control loop 
diagnosis information for a large number of controllers. This information is 
organized so that it is quick and easy to read and interpret. Multiple stages of loop 
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failure modes are provided, so that a problem can be detected and rectified before it 
becomes too severe and affects plant operation.

Additional details are provided that are easy to access. These include the input data 
Trend Display to show the input data. The diagnostics are displayed in the output 
records as well as on the faceplate for easier and in-depth analysis of the loop 
condition.

This section describes CLAM configuration. It assumes that installation and post 
installation procedures are already complete. Deploying CLAM involves Object 
Type Structure configuration that applies to all new instances. It also involves 
instance based configuration in the Control Structure. Upon completing 
configuration, refer to System 800xA Asset Optimization Operation (3BUA000150*) 
for additional information on operation.

Enhancements to CLAM

As a constant endeavour towards improvement, the software has undergone some 
changes since the last release. Some of the important enhancements are the 
following:

1. New Names to User Interfaces:

– The threshold values are given easily recognizable and contextual names.

– Improved error messages and suggested action text of hypothesis.

2. Weights and Threshold Values Updated:

– The default values for the weights and threshold are updated. 

– Ascending-order validation checks for the threshold values are performed. 
Unused Asset Parameters are removed.

– Provision to configure Alarm threshold limits to monitor the condition.

Virtual AO Server Configuration
Control Loop Asset Monitor execution takes longer time than Basic Asset Monitors. 
It is recommended to load all control loop asset monitors on a separate Virtual AO 
Server. The Virtual AO Server is a second Asset Monitoring Engine running on 
existing AO Server node. The following steps describes how to create and configure 
a Virtual AO Server.



Section 5  Control Loop Asset Monitor (CLAM) Virtual AO Server Configuration

3BUA000118-510 G 147

Creating and Configuring a Virtual AO Server

1. Select Control Structure in the Structure Navigator.

2. Navigate and select Asset Optimization object in the object list area.

3. Right-click and select New Object from context menu options.

4. Select AO Server from the New Object dialog. 

5. Enter the name and click Create as shown in Figure 69.

Figure 69. Create an instance of AO server
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6. Select Asset Optimization Server Aspect on newly created object.

7. Right-click and select Config View from the context menu option.

8. Select AssetMonitoring SG_CLAMEx from Service Group drop down list as 
shown in Figure 70.

9. Click Apply.

10. Click View button to open Service Group Aspect View.

11. Select AssetMonitoring SP_CLAMEx from the providers list and click View to 
open Service Provider Aspect View. The current state of Asset Monitoring 
Engine will be “Undefined”.

12. Check Enabled option.

13. Select the Node to run AO Server.

14. Click Apply. The current state of Asset Monitoring Engine will change to 
Service. 

Figure 70. Select Service Group

Make sure the “Default Asset Optimization Server” is not checked.
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15. After configuring the Service Provider Definition, navigate to the Control 
Structure and click on the newly created AO Server and verify that it is running 
as shown in Figure 71. 

Figure 71. Verifying the AO engine is running

Create and Configure a new Service Group and Service Provider

1. Select Service Structure in the Structure Navigator.

2. Navigate and select AssetMonitoring, Service in the object list area.

3. Select Service Definition Aspect in the aspect list area.

4. To create new service group, click Add in the Aspect View.

5. Enter Service Group name and click OK.

6. Click Apply to add a new service group to AssetMonitoring Service.
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7. Select Service Group Definition Aspect from the newly created Service 
Group.

8. To create new service provider, click Add in the Aspect View.

Figure 72. New Service Group Name

Figure 73. Asset Monitoring:Service Definition
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9. Enter Service Provider name and click OK.

Figure 74. New Service provider name

10. Click Apply to add a new Service Provider to AssetMonitoring SG_CLAMEx 
Service Group

Licensing
There are two modes of operation of Control loop asset monitors:

• Basic Control Loop Monitoring mode (unlicensed).

• Enhanced Control Loop Monitoring mode (licensed).

The basic CLAM provides only the limited summary diagnosis for each control 
loop. This Basic Control Loop Monitoring mode is an unlicensed mode of 
operation. Additional license features, when purchased, provide more detailed 
diagnosis information.
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Configuration in the 800xA System 
The configuration of Control Loop Asset Monitors within the 800xA System 
consists of:

• Control Loop Asset Monitor Ex Object Types

• History Source Configuration

• Instance Configuration

Control Loop Asset Monitor Ex Object Types

The Asset Optimization installation generates a Control Loop Asset Monitor Ex 
Object Type in the Asset Monitors Object Type Group in the Object Type 
Structure. 

This Object Type must be customized for the target control system configuration. 
First configure the Control Loop Asset Monitor aspect by selecting the config view 
of the aspect. Refer to Figure 75.

Figure 75. Configuring Control Loop Asset Monitor Parameters
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Parameters such as Logic Execution Interval, Asset Parameters, Input Parameters, 
etc. can be changed in the Control Loop Asset Monitor aspect. The change will be 
automatically applied to all new instances of this object type. The changes will also 
be applied to existing instances unless it is decided to override the category in one or 
more of those instances. Overriding the category during Asset Monitor 
configuration can be used to modify individual instances. After any change, it is 
necessary to reload the Control Loop Asset Monitor instance so that the AO Server 
will read the change. All other associated aspects for Control Loop Asset Monitors 
are stored in this Control Loop Asset Monitor Ex Object Type in the Object Type 
Structure. 

The Control Loop Asset Monitor Aspect Type makes the Control Loop Asset 
Monitor aspect available. The Control Loop Asset Monitor Object Type uses this 
Control Loop Asset Monitor aspect and also makes several other integrated aspects 
available to the user. 

The Control Loop Asset Monitor has three Object Types associated with it:

• Control Loop Monitors: Root object used to hold all Control Loop Asset 
Monitor objects.

• Control Loop Monitoring Area: Used to hold several Control Loop Asset 
Monitor objects that should be grouped together, because they have similar 
functionality.

• Control Loop Asset Monitor Ex: Object Types that should be copied into 
new Object Types and custom configured so that their instances will require 
minimum configuration. This procedure is described later in this section.

All of these aspects are either Inherited or Copied for each CLAM object instance. 
Any change made in these aspects in the Object Type Structure will be applied to 
all new CLAM object instances. Changes are also applied to already existing 
CLAM objects where the aspects are Inherited. 

If there is a common change that must be made available to the Control Loop 
Asset Monitors or in any other aspect included in the CLAM Ex Objects, then it 
should be made in the CLAM Ex Object Type. This way, all changes become 
automatically available to all CLAM instances.
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Using these Object Types, the Control Loop Asset Monitor is organized in the 
Control Structure as shown in Figure 76.

The CLAM Object types can also be instantiated in the control structure near the 
location of the Source object providing PV, SP and CO data. Figure 77 shows 
configuration of CLAM instance below a control program object.

Figure 76. CLAM Organization in the Control Structure

Figure 77. Creating CLAM instance directly under a control or program object
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Configuring Input Data

Data inputs for each Control Loop Asset Monitor object are PV, SP, and CO data. 
These should be read as the controller data. There is also an INHIBIT input. The 
current value of all these data inputs are read each time the Control Loop Asset 
Monitor object is executed.

Each Control Loop Asset Monitor object is associated with a control loop. The 
Control Loop Asset Monitor has to receive PV, SP, and CO data from the controller 
associated with this control loop, into the Input Records tab of the Control Loop 
Asset Monitor aspect. This is typically accomplished by using one of the following 
options:

• Controllers and OPC Control Networks.

For testing purposes, the following 800xA System tools can be used:

• SoftPoint Control Network.

• Using Control Loop Asset Monitor Ex Objects. 

The Data Source used for the Input Records is the Control Loop Data Source 
aspect located in the following object in the Control Structure:

Root, Domain > Asset Optimization, Asset Optimization

Controllers and OPC Control Networks

The 800xA System provides Controller and OPC Control Network objects for the 
data coming from Controllers and OPC Control Networks. The following steps 
summarize configuration procedures necessary so that PV, SP, and CO data can be 
used by the Control Loop Asset Monitor objects. 

1. As an overall configuration (refer to Overall Configuration on page 156 for 
detailed information):

a. Create an instance of the Object type Control Loop Asset Monitor Ex at 
the desired place as shown in Figure 76 or Figure 77.

b. Verify the full path of the Controller object, using the Properties Browser, 
from where a Control Loop Asset Monitor object will receive PV, SP, and 
CO data.

c. Using the Controller Configuration faceplate element in the newly created 
Control Loop Asset Monitor Object Type, change the object name, aspect 
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name, and property name for PV, SP, and CO to appropriate names used 
by the controller in the Control Loop Asset Monitor aspect.

d. Make the same changes (as in Step c) in the Trend Display aspect and Log 
Configuration aspect, so that only minor modifications will be needed in 
these entries for each Control Loop Asset Monitor instance.

e. Copy the History Source aspect from the Asset Optimization object to the 
root level of the OPC Server Network in the Control Structure, if 
creating the instance as shown in Figure 77.

2. For each Control Loop Asset Monitor object (refer to Instance Configuration 
on page 162 for detailed information):

a. Set the correct full path for Input Records PV, SP, and CO data in 
Control Loop Asset Monitor asset monitor aspect using the Controller 
Configuration faceplate element. 

b. Set Object, Aspect, Property, and LogName in the Control Loop Trend 
Display aspect.

Overall Configuration

The Control Loop Asset Monitor will receive PV, SP, and CO data directly from the 
controllers at the plant site (instead of Loop Input Data GP General Property that is 
used as a default). The three parameters then are configured into CLAM Log 
configuration as in Step c. Log Configuration data goes as input to the CLAM. Each 
controller type must be custom configured to communicate with the CLAM.

1. The following demonstrate the integration of Control Network AC800M 
controller program object with Control Loop Asset Monitor Loop objects in an 
800xA System. This is an example and will not contain step-by-step 
procedures.
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Figure 78 shows Plant Explorer navigation and configuration.

2. Configure the corresponding Control Loop Asset Monitor object from the 
Object Type to receive data as shown in Figure 79. It requires specifying full 
path of Controller Object, Data Aspect, and PV, SP, and CO Property Tags in 

Figure 78. Receiving Controller Data in an AC800M control Network Read Object
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the Control Loop Asset Monitor Object Type Controller Configuration 
faceplate element.

Figure 79. Controller configuration

3. The appropriate path for the controller signal (such as PV) can be read from the 
Properties Browser that can show the complete path for any aspect. Use the full 
path for the controller object by browsing to it using a Properties Browser as 
shown in Figure 80. Refer to Input Records Tab on page 63 for more 
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information about Properties Browser.

Figure 80. Object properties browser

4. Change the Data Input Object for PV, SP, CO field to an appropriate 
Controller object. An example of such a full path for the object is: 

[Control Structure] > Root > Asset Optimization > Control Loop Monitors 
> Area1 > Loop001

5. The default for the Data Input Aspect for PV, SP, CO field is Loop Input 
Data GP. The default property in the PV Tag field is PV. The Data Source 
Item macro from Input Data of the ABB CLAM aspect combines these three 
and reads the input for PV data from the property: 
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[Control Structure]Root/Asset Optimization/Control Loop 
Monitors/Area1/Loop001:Loop Input Data GP:PV. Refer to Figure 81.

Figure 81. Loop Input Data GP

6. Add History Source aspect to the root level of OPC Server Network. In this 
example, it is added to Control Network to service log configuration of all 
child nodes. The History Source aspect can be copied from the Asset 
Optimization object. The Service Group can be Basic or anything available. 
Refer to Figure 82.

Figure 82. Adding history aspect on Control Network that will service all CLAMs in 
child objects
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7. Add a Log Configuration aspect to Program1 object to store Trend Display plot 
data. The same Log is also read by CLAM aspect when configured. Make sure 
to select the proper logged properties such as CO1, PV1, SP1 by clicking Add 
Property Log to open the new Log dialogue as shown in Figure 83. Also, 
select log template type as CLAM Log Template.

Figure 83. Log configuration for CLAM

History Source Configuration

To configure the History Source:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Control Structure.
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3. Use the Object Browser to navigate to and select:

Root, Domain > Asset Optimization, Asset Optimization > Control Loop 
Monitors

4. Create a History Source aspect in the object navigated to in Step 3.

5. Select History Source in the Aspect List Area.

6. Verify that the Service Group drop-down list box is not blank. If it is blank, 
select the available Service Group in the drop-down list box. The Basic History 
Service Group (Basic) on the AO Server node is preferred. Any available 
History Service Group can also be used. 

If the Control Loop Asset Monitor objects are created under an object other than 
the Control Loop Monitors object, copy the default History Source aspect to the 
new object. The History Source aspect is available for insertion as a default 
aspect for the Control Loop Monitors object. It can also be inserted as a new 
aspect, enabling the Show All check box and then navigating to the History 
Source aspect. 

Instance Configuration

1. For each instance of the Control Loop Asset Monitor in Control Structure, a 
modification is necessary in the Controller Configuration faceplate element. 
This enables each Control Loop Asset Monitor object to receive data from its 
corresponding Controller object. In each Control Loop Asset Monitor object 
instance in the Control Structure, only the object may have to be corrected to 
the appropriate Controller object. The object in this case should be the 
Program1 object that reads Controller data as shown in Figure 79.

2. Correct the Trend Display aspect of each instance of the Control Loop Asset 
Monitor in the Control Monitor Loop Asset Monitor Ex object instance or in 
the Trent tab of the Faceplate element of CLAM instance as shown in 
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Figure 84.

Figure 84. Trend aspect configuration from Faceplate

   

3. The Loop object should now be receiving data from the Program Aspect of 
AC800M, Program1 - controller object. Verify this by observing the Trend 
Display aspect. If data reception is fine, then load Loop object into AO Server 
and enable AO Server to perform Loop object execution.

SoftPoint Control Network

Loops can also receive PV, SP, and CO data from the SoftPoint Server. This option 
is particularly useful to receive non OPC data. The following example demonstrates 
the SoftPoint Server Generic Control Network integration with Control Loop Asset 
Monitor objects in the 800xA System.

It is assumed that the SoftPoint Server Generic Network is set up to organize data 
coming from plant objects. The User Manuals for installation and setup are 
available in System 800xA Installation (3BSE034678*), System 800xA Post 
Installation (3BUA000156*), and System 800xA Information Management 
Configuration (3BUF001092*).
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1. Add/use Softpoint Generic Control Network objects to read data from plant 
objects as shown in Figure 85.

Figure 85. Receiving Controller Data in a SoftPoint Generic Control Network

 

2. Configure the corresponding Control Loop Asset Monitor object from the 
Asset Optimization tree to receive this data similar to that shown in Figure 79.

3. The Object Dialog aspect can be configured (Figure 86) to manually feed the 
Softpoint data for test. It can also be obtained automatically from the OPC 
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server or any generic source serving plant objects (Figure 87). 

Figure 86. Manually Feeding SoftPoint Data for Test

Figure 87. Signal Data for a SoftPoint Control Network
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Using Control Loop Asset Monitor Ex Objects
Using Control Loop Asset Monitor consists of the following:

• Creating Control Loop Asset Monitor Ex Object instances.
• Control Loop Asset Monitor Controller Input Data Configuration.
• Control Loop Asset Monitor Input Data Storage and Display Configuration.
• Control Loop Asset Monitor Loop Analysis Configuration.

Creating Control Loop Asset Monitor Ex Object instances

Create new multiple Control Loop Asset Monitor objects from the Control Loop 
Asset Monitor object type. These are typically created as child objects of Control 
Loop Monitors Object in Control Structure. They will automatically have most of 
the desired configuration.

Each Control Loop should have its own Control Loop Asset Monitor object. 
Multiple Control Loop Asset Monitor objects are created from the Control Loop 
Asset Monitor object type by repeating this procedure. The Control Loop Asset 
Monitor objects can be organized under one common object such as Control Loop 
Monitors object in Control Structure. Figure 79 shows an example.  

Aspect control for each Control Loop Asset Monitor aspect can be reviewed from 
the Type Definition aspect in Object Type Structure. All Copy type aspects can 
store their own structure. All Inherited type aspects must get their structure from 
the parent definition. It cannot be overwritten in an instance.
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Figure 88 shows an example.

Copy and Insert instances are used where structure for instances is expected to be 
unique. Otherwise all instances will have the same structure as in the original object 
type. 

Control Loop Asset Monitor Controller Input Data Configuration

Four inputs are read by each Control Loop Asset Monitor object during each 
execution step. They are:

• SP: Set point input.
• PV: Process Value input.

Figure 88. Using Copy vs Inheritance to Manage Control Loop Asset Monitor 
Objects 

After any configuration changes, the Inherited instances will update 
automatically, but the Copy instances will not update. After any changes or 
updates, unload the object and delete the instance that was created by a Copy 
operation. Then switch to Inherit and switch back to Copy. This will generate an 
updated version of Copy aspects for Control Loop Asset Monitor Objects. 
Another option is to unload and delete the entire object and then create a new 
object from the LOOP object type.
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• CO: Control Output input.
• INHIBIT: True or false input indicating if the execution should be paused.

Details of Control Loop Asset Monitor Controller Input Data Configuration are 
described in Configuring Input Data on page 155. It mainly applies to the 
configuration in the Control Loop Asset Monitor Object Type. Additional instance 
specific customization is necessary.  

The inputs are constantly read from the Input Records tab of the Control Loop 
Asset Monitor. Input Records are configured to read the input according to Data 
Source Item entry. The source macros are:

• SP: 
%:APConfig_GP:DataInputObject%:%:APConfig_GP:DataInputAspect%
:%:APConfig_GP:SPTag%,CLAM Log Template

• PV: %:
%:APConfig_GP:DataInputObject%:%:APConfig_GP:DataInputAspect%
:%:APConfig_GP:PVTag%,CLAM Log Template

• CO: 
%:APConfig_GP:DataInputObject%:%:APConfig_GP:DataInputAspect%
:%:APConfig_GP:COTag%,CLAM Log Template

• INHIBIT:
%ID%:Loop Input Data GP:INHIBIT

The default Data Source Item entries should work for most cases. The necessary 
Data Source Item entry may be changed in the Data Source Item field after 
disabling the Inherit Configuration check box. This allows necessary instance 
specific entry changes to be made for each Control Loop Asset Monitor object. 
Whenever possible, do not change the Data Source Item entries.

1. Use the Properties Browser to find the full path of the aspect that is receiving 
the controller PV, SP, and CO data. By default the input data PV, SP, CO, and 
INHIBIT is read from the Loop Input Data GP General Property as shown in 
Figure 89. Refer to Input Records Tab on page 63 for more about Properties 
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Browser.

Figure 89. Default configuration of a CLAM instance

 

2. Enter the appropriate full path for the object, the aspect that receives PV, SP, 
and CO data, and property names for PV, SP, and CO data using Controller 
Configuration faceplate element. Generalized information should be entered in 

By default, it is possible to inhibit CLAM by changing the Inhibit Property value 
(in Loop Input Data GP Aspect, refer to Figure 81, ) to TRUE. To configure the 
INHIBIT input record, see Configuring Asset Monitor Inhibit functionality on 
page 115.

Typical scenario to inhibit CLAM execution is when the control loop under 
CLAM monitoring is out of service. When inhibited, CLAM conditions are set to 
GoodLocalOverride and the CLAM stops loop analysis. 
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the Object Type so that only a minor modification may be necessary in the 
object name.

Control Loop Asset Monitor Input Data Storage and Display Configuration

The PV, SP, and CO information is saved for each Control Loop Asset Monitor 
object and also displayed in the Trend Display.

1. If necessary, adjust the duration of the display durations in the Trend Template 
aspect. The default for the trend display is one hour. If the Control Loop Asset 
Monitor execution rate is changed from the default value of 8 hours, then also 
change the update rate in the Trend Template to match it. Figure 90 shows an 
example. 

Figure 90. Controller Input Data from the Trend Template

 

2. If necessary, adjust the save duration in the Control Loop Asset Monitor Log 
Template aspect. The default storage size is four weeks. The Trend Display can 
only show data that is already saved by the Control Loop Asset Monitor Log 
Template. Figure 91 shows an example.  



Figure 91. Controller Input Data from Control Loop Asset Monitor Log Template
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The Control Loop Asset Monitor OPC data collection rate is automatically matched 
with the Control Loop Asset Monitor execution rate that reads the input PV, SP, and 
CO data. 

Control Loop Asset Monitor Loop Analysis Configuration

Loop Analysis Configuration for all Control Loop Asset Monitor objects can be 
performed using the Loop Configuration Data aspect in the CLAM Object type 
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instance (refer to Figure 92).

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Control Structure.

3. Use the Object Browser to navigate to:

Root, Domain > Asset Optimization, Asset Optimization > 
Control Loop Monitors, Control Loop Monitors > Area Name, Control 
Loop Monitoring Area > Loop Name, Control Loop Asset Monitor Ex.

4. Select Loop config Data in the Aspect List Area.  

5. Configure the Loop configuration tab in the CLAM Faceplate data as per 
requirement.

6. The loop analysis is performed internally, and results become available after 
reading PV, SP, and CO sample sets numbering in value of the Data Set Size, 
such as 1000 data sets. The upper limit for Data Set Size is 5,000 samples, and 
the lower limit is 400.

7. Cascade can be master for multiple loops or slave for a single loop.

Figure 92. Loop Configuration Tab
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8. Loop Category can be Flow_liquid, Flow_other, Temperature, 
Composition, Pressure, Level_tight, Level_average, otherSRP, or 
otherNT depending on the process variable controlled by the loop. 

All string entries are case sensitive. For example, a Control Loop Asset Monitor 
object for a control loop controlling the flow of liquid should have 
Flow_liquid as the Loop Category. 

 

It is extremely important to select the correct Cascade and Loop Category 
options for each Control Loop Asset Monitor object. The auditing analysis will 
be reliable only when these options are correctly specified for each loop. 

9. The data interval field in the faceplate indicates the control loop monitor 
execution time. The default Data Interval value is 28800 seconds (8 hours) 
and should almost always work in all cases and usually not be altered. 
Sometimes, depending on the loop type, it may be necessary to change the data 
interval. As a general rule, the execution frequency slows down from fast to 
slow in the following order. 

– Pressure.
– Level.
– Flow.
– Temperature.
– Composition.

This sequence is determined by the inherent response characteristics of the 
variable. The loop action causes the pressure to change at the fastest rate and 
the composition at the slowest rate. 

10. Limits on CO and PV (SP limit is the same as the limit set for PV) can also be 
specified. Any data outside the limits is ignored during loop analysis. Also, PV 
high should ideally be twice as much as the highest value of the possible PV 
data. If PV exceeds this limit, then that data is ignored from analysis. The PV 
high value is also used for scaling by audit logic. So if PV high is much higher 
than the actual PV values, then the data fluctuations become less sensitive to 
analysis. The Audit may not be able to easily track problems. Conversely if PV 
high is a very low value, then the audit logic scaling makes data appear noisier 
and identifies diagnosis problems that may not really exist. The values CO 
high =100, CO low = 0, and PV low = 0 will work in most cases.
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11. Loop Analysis Configuration is accessed through Asset Parameters. This needs 
to be configured in each instance of control loop asset monitor. The data set 
size has to be configured as per requirement. Control Loop Asset Monitor logic 
uses Read Process method to retrieve historical data. Read Process calculates 
missing values between two points from history log that are further apart than 
ResampeIntervalSec by using Aggregate Function. Refer to Figure 93.  

 

12. Asset parameters with a prefix of W indicate weight for including history of 
diagnosis in the current diagnosis. The formula used after each loop execution 
is:

DiagnosisCurrent W DiagnosisCurrent 1 W–( ) DiagnosisPast×+×=

The default value for weight (W) of each diagnosis is 0.5. Use the following 
formula to determine weight (W):

W 1 -t τ⁄( )exp–=

Where t is the execution time multiplied by the number of new data points and 
τ is called the detection time arbitrarily chosen by the user. It is the time after 

Figure 93. Loop Analysis Configuration Stored as Asset Parameters
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which the effect of current diagnosis becomes prominent. The default for t is 
10 multiplied by 100 or 1000 seconds. If the default weights of 0.5 are used, 
then the detection time is 1,442 seconds. This detection time is too fast and can 
lead to false alarms. To set the detection time to 24 hours or 24 multiplied by 
3,600 seconds, weights should be set to:

W 1 -1,000 3,600 24⁄⁄( )exp– 0.0115= =

This is a more reasonable value. 

13. Reload the Asset Monitor after making any configuration changes in Loop 
Analysis Configuration, so that changes are read by AO Server. The Control 
Loop Asset Monitor will then restart analysis by making the current data point 
the starting data point. 

CLAM Diagnostics
The available CLAM Diagnostics are:

1. Final Control Element Diagnostics.

2. Loop Performance Diagnostics.

Final Control Element Diagnostics include the following:

1. FCE Action.

2. FCE Leakage.

3. FCE Size.

4. FCE Stiction/Backlash.

5. Loop Nonlinearity.

Loop Performance Diagnostics include the following:

1. Loop Tuning.

2. SetPoint Oscillation.

3. External Disturbances.

4. Data Reliability.
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5. Harris Index.

6. Setpoint Crossing Index.

7. Oscillation Index.

8. Controller Output Saturation.

9. Manual Mode.

10. Cascade Tracking.

11. Response Speed. 

To calculate FCE/LPS summary the above diagnostics are used along with the 
Weight given by user for each hypothesis/precondition. 

The subcondition of the FCE/LPS Summary does not depend on a single 
hypothesis, it is the cumulative of all hypotheses and their corresponding weights. It 
is not necessary that if one of the hypothesis is not okay then the subcondition will 
be abnormal. The subcondition also depends on the threshold defined by the user in 
Asset Parameter. If FCE/LPS summary value goes beyond the threshold, the 
subcondition will change accordingly. It means that one or more diagnostics related 
to FCE/LPS is not okay, and the user should check and take appropriate action as 
necessary. 
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Section 6  Heat Exchanger Asset Monitor 
(HXAM)

Introduction
Heat Exchanger Asset Monitors are intended to alert process and maintenance 
personnel when the operation of a Heat Exchanger indicates significant decline in 
performance. The decline in performance may be due to fouling or significant 
change in operating point. The Heat Exchanger Asset Monitors replace the current 
manual monitoring systems that require maintenance of paper records and manual 
interpretation of the data. When CMMS Integration is configured a work order for 
maintenance request can be generated.

The Heat Exchanger Asset Monitor application begins with the identification of 
Heat Exchanger Objects configured in the 800xA System Workplace. At the time of 
configuration, the user identifies process measurement inputs that allow the Heat 
Exchanger Asset Monitor to track the performance of the physical device. These 
Asset Monitors provide status and condition information to the user through the 
standard Asset Optimization interfaces and views.

The Heat Exchanger Asset Monitor does not require any specific data regarding the 
design or structure of the heat exchanger. It also does not require any configuration 
specific information related to the mathematical model of the heat exchanger.

There are two types of Heat Exchanger Asset Monitors:

Generic Heat Exchange Asset Monitor (HXAM_G)

Shell and Tube Heat Exchanger Asset Monitor (HXAM_ST)

Objective

The objective is to detect gross declines in heat exchanger efficiency, rather than 
minute changes. This is accomplished by taking baseline measurements of the 
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critical readable process variables around the heat exchanger, and noting any trends 
in them which would be indicative of declining performance. The most important, 
by far, is declining heat transfer efficiency due to fouling. For each occurrence of 
the input variables which are a reasonable match for the baseline sets, heat 
exchanger performance can be compared to the baseline. 

The basic approach of the HXAM is a proprietary analysis methodology, along with 
an understanding of the measurable boundary conditions, to create a basic Asset 
Monitor capable of alerting maintenance personnel to significant changes in heat 
exchanger Key Performance Indicators (KPI), such as:

Efficiency:

• Fouling, as indicated by:

– Delta T profiles drifting at reference Hot and Cold flows.

– Delta P across the exchanger increasing at reference (constant) flow for 
either Hot or Cold leg.

– Low Flow or Low Delta T readings for either leg.

– Significant changes in operating point which affect efficiency or heat-
duty.

Instrumentation Errors:

• Delta T, Delta P, Delta F, or Heat Duty Error going into 
undefined/unreasonable values.

In addtion to the above, HXAM-ST supports the following:

Process Errors:

• Temperature Crossover.
• Low Shell-side Flow.
• Low Heat Transfer.
• High/Low Tube Velocity.
• Low Limiting Approach Temperature.

Terminology

Refer to Appendix B, Heat Exchanger Specific Terminology for specific Heat 
Exchanger Terminology used in this document.
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Generic Heat Exchange Asset Monitor (HXAM_G)
This section describes the salient features of the Generic Heat Exchanger Asset 
Monitor operation.

Configuration

Configuration of the Generic Heat Exchanger Asset Monitor consists of:

• HXAM_G Aspect Configuration.
• HXAM-G Configuration Faceplate.
• HXAM-G Trend Display Aspect.

HXAM_G Aspect Configuration

From the Control Structure, the HXAM-G object can be created by calling the Heat 
Exchanger Object from the Asset Monitors list of Object Types. After the object has 
been created, the History Source aspect is added into the object. After creation of 
the History Source aspect, the Service Group of the History Source must be 
configured (typically set to Basic).

1. To start configuration, go to HXAM_G aspect as shown in Figure 94.  



Figure 94. Navigating to the HXAM_G Aspect

TC08432A
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2. Switch to the Config View of the HXAM_G aspect as shown in Figure 95. 

Figure 95. Config View of HXAM_G Aspect

TC08433A

 

3. The Config View is divided into six tabs:

– Asset Monitor Tab.
– Conditions Tab.
– Asset Parameters Tab.
– Input Records Tab.
– Output Records Tab.
– Logic Tab.

Asset Monitor Tab

The data in the Asset Monitor tab consists of:

• Asset Monitor Configuration Lifecycle frame: This frame does not have any 
configurable values. No action is required. 
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• AO Server Assignment frame: The Enable in Server check box must be 
enabled for the Asset Monitor to execute. Set the appropriate Server 
Assignment (typically set to Default) in the Assigned to drop-down list box.

• Asset Monitor frame: The Execution Interval in Seconds field must be kept 
at 60 seconds. This defines how often the analysis logic will be executed. 

The actual interval between subsequent executions may be longer than the 
specified interval on heavily loaded systems.

The Asset URL field is an optional parameter that can be used to point to the 
device web interface to get more information on the device status. If desired, 
this can be set to an application specific URL.

The Logic Failure Severity field should be left at 1000. This is the Asset 
Monitor alarm severity level. It is used to report Asset Monitor failures in the 
800xA Alarm and Event system.

• Configuration Inheritance frame: This section does not have any 
configurable values. No action is required. 

Conditions Tab

This tab does not have any configurable values, but reflects Condition/Subcondition 
information for the Asset Monitors, which are implemented.

The Conditions tab contains the definition of the conditions that are assessed and 
reported by the Heat Exchanger Asset Monitor. The main functionality of the Heat 
Exchanger Asset Monitor is to monitor the operating parameters of the heat 
exchanger and report the current subcondition for each defined condition. 

Each condition is defined by a set of subconditions. The subconditions for a given 
condition are mutually exclusive. Subcondition ENUM 0 always represents the 
normal condition state. A transition to the normal state will deactivate the associated 
alarm in the Alarm and Event List. 

If the Asset Monitor is not able to successfully assess the current subcondition for a 
given condition, it sets the quality status of that condition to a bad value. 

The only subconditions that will generate a Fault Report in the Fault Report 
Submitter are those that are not normal with good quality status. 
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Asset Parameters Tab

No configuration is required. The Asset Parameters tab contains configuration 
parameters used to provide additional heat exchanger information required by the 
Heat Exchanger Asset Monitor algorithm.

The Asset Parameters values are read from Configuration_Values aspect by the use 
of macros. The Configuration_Values aspect is an intermediate aspect that gets 
written to, from the Configuration Faceplate aspect, which is then read by the Asset 
Parameters value in HXAM_G aspect by the use of macros. These macros 
SHOULD NOT be changed. The actual configuration of Asset Parameters is done 
in the Configuration Faceplate. Refer to Configuring HXAM_G Asset Parameters 
on page 207 for details on configuring the Asset Parameters.

Input Records Tab

The Input Records tab contains the definition of data items (i.e. OPC items) used 
by the Heat Exchanger Asset Monitor to assess the current heat exchanger 
condition. Figure 96 shows the Input Records tab.  

The columns in the Input Records tab are defined as follows: 

• ID: Input Record identifier. 

TC08434A

Figure 96. Input Records Tab
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• Description: Input Record description. 

• Units: Input Record expected engineering units. 

• Trigger Execution: When True, the Asset Monitor will be scheduled for 
immediate execution upon Input Record value change. Setting this 
configuration parameter to True may increase the actual Asset Monitor 
execution frequency based on the Input Record Data Source Aspect OPC 
Group Update Rate.

• Data Source Aspect: Provides a pick list to select one of the available Asset 
Monitor Data Sources defining the data server (i.e. OPC server) from which to 
read the value. 

• Data Source Item: Identifies the item (i.e. OPC item) in the data server from 
which to read the value.

The Data Source Aspect for the Input Records must be configured to the Data 
Server that reads the value associated with that particular Input Record. The Data 
Source Item must refer to the property that contains the value of the Input Record. If 
an input record is not available, the Data Source Aspect is set to None and the Data 
Source Item is left empty. Input records Clear_Base_Operating_Point and 
Clear_BOPS_Date are manual inputs that uses macros %ID%:Clear BOPS and 
%ID%:Clear BOPS Date respectively to read its property from the HXAM_G_GP 
Aspect. These two macros SHOULD NOT be changed. The rest of the input 
records are field variables that must be configured accordingly. Refer to HXAM_G 
Asset Monitor Input Records on page 227 for a description of the Input Records.

Output Records Tab

The Output Records tab has no configurable values. It is for information only and 
shows the Output Records in the HXAM-G Configuration Faceplate for user 
information.

Logic Tab

The Logic tab has no configurable values.
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HXAM-G Configuration Faceplate

The HXAM-G Configuration Faceplate includes nine tabs. These tabs are named 
Step-1 through Step-9. These nine tabs guide the user through each stage of 
configuration. The tabs in the Faceplate aspect are views of the nine Faceplate 
Element aspects. Figure 97 shows the view of the HXAM-G Configuration 
Faceplate aspect. Refer to Configuring HXAM_G Asset Parameters on page 207 for 
details on the properties seen in the Configuration Faceplate.  

Step-1 Tab

The Step-1 tab is the view of Configuration_Step1_FE. Figure 97 shows the view of 
Step-1 tab. Table 21 lists and describes the elements in the Step-1 tab of the 
HXAM-G Configuration Faceplate.  

TC08435A

Figure 97. Step-1 Tab of HXAM-G Configuration Faceplate
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Table 21. Step-1 Tab of HXAM-G Configuration Faceplate 

Element Description Expected Value

Significant Improvement 
Level of E

Acceptable percentage difference 
between the COPS Performance 
Factor and the BOPS Performance 
Factor to consider the COPS 
Performance Factor to have 
significantly improved. If no value is 
entered a default of 5.00 will be taken. 
[Required]

Value greater than zero

Default Value: 5.00

Significant Declining Level 
of E

Acceptable percentage difference 
between the COPS Performance 
Factor and the BOPS Performance 
Factor to consider the COPS 
Performance Factor to have 
significantly declined. If no value is 
entered a default of 5.00 will be taken. 
[Required]

Improvement Level of E Acceptable percentage difference 
between the COPS Performance 
Factor and the BOPS Performance 
Factor to consider the COPS 
Performance Factor to have improved. 
If no value is entered a default of 2.00 
will be taken. [Required]

Value greater than zero

Default Value: 2.00

Declining Level of E Acceptable percentage difference 
between the COPS Performance 
Factor and the BOPS Performance 
Factor to consider the COPS 
Performance Factor to have declined. If 
no value is entered a default of 2.00 
will be taken. [Required]

Value greater than zero

Default Value: 2.00
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Step-2 Tab

The Step-2 tab is the view of Configuration_Step2_FE. Figure 98 shows the view of 
Step-2 tab and Table 22 lists and describes the elements in the Step-2 tab of the 
Configuration Faceplate.  

Delta BOPS Acceptable percentage difference 
between COPS and BOPS to consider 
COPS as a new set of BOPS. If no 
value is entered, or if there is some 
error in entry, a default value of 5.00 
will be taken. [Required]

Value greater than zero

Default Value: 5.00

Normal Service Interval Time interval between heat exchanger 
cleaning, rebuilds, etc. in hours 
[Required]

Value greater than zero

Monitoring Interval Time interval between monitoring in 
minutes. [Required]

Any Integer greater than 0. 
Recommended values given 
in Table 31 on page 212.

No: of Baseline Sets Number of Base Operating Point Sets 
expected [Required]

Minimum Integer value 
between 1 and 5

Unit of Temperature Unit of Temperature [Required] Select one from the drop 
down menu

Is Hot-Side Condensing? Select YES if Hot side Flow is 
Condensing. [Required]

YES, NO

Is Cold-Side Evaporating? Select YES if Cold Side is Evaporating 
[Required]

Enable Logging of Data? Select YES to enable data logging to a 
file [Required]

YES, NO

Inhibit Any string value can be entered for 
inhibit. When the Input Record Inhibit 
equals the value entered, the Asset 
Monitor gets disabled.

Any string value except 
True/False

Table 21. Step-1 Tab of HXAM-G Configuration Faceplate (Continued)

Element Description Expected Value
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Figure 98. Step-2 Tab of HXAM-G Configuration Faceplate

Table 22. Step-2 Tab of HXAM-G Configuration Faceplate 

Element Description Expected Value

Hot Side:

Is Mass Flow available?

Select YES if Mass Flow for Hot side is 
available [Required]

YES, NO

Hot Side:

Is Volume Flow available?

Select YES if Volume Flow for Hot side 
is available [Enabled if Mass Flow for 
Hot side is not available. Required if 
enabled]



Section 6  Heat Exchanger Asset Monitor (HXAM) HXAM-G Configuration Faceplate

3BUA000118-510 G 189

Hot Side: Density Density of Hot side fluid. [Enabled if 
Volume flow for hot side is available. 
Required if enabled]

Value greater than 0.

Hot Side: Specific Heat Specific Heat of Hot Side fluid [Required 
if either flow for hot side is available]

Hot Side: Heat of Vap Heat of Vaporization for hot side fluid. 
Enabled only if hot side is condensing. 
The unit of Heat of Vaporization is 
automatically filled based on the unit of 
Specific Heat selected. [Required if Hot 
side Condensing]

Cold Side:

Is Mass Flow available

Select YES if Mass Flow for Cold side is 
available [Required]

YES, NO

Cold Side:

Is Volume Flow available

Select YES if Volume Flow for Cold side 
is available [Enabled if Mass Flow for 
cold side is not available. Required if 
enabled]

Cold Side: Density Density of Cold side fluid. [Enabled if 
Volume flow for hot side is available. 
Required if enabled]

Value greater than 0.

Cold Side: Specific Heat Specific Heat of Cold Side fluid 
[Required if either flow for hot side is 
available]

Cold Side: Heat of Vap Heat of Vaporization for Cold side fluid. 
Enabled only if cold side is evaporating. 
The unit of Heat of Vaporization is 
automatically filled based on the unit of 
Specific Heat selected. [Required if Cold 
side Evaporating]

Table 22. Step-2 Tab of HXAM-G Configuration Faceplate (Continued)

Element Description Expected Value
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Step-3 Tab

The Step-3 tab is the view of Configuration_Step3_FE. Figure 99 shows the view of 
Step-3 tab and Table 23 lists and describes the elements in the Step-3 tab of the 
Configuration Faceplate.  

Unit of Mass Flow Unit of Mass Flow [Required] Select one from the drop 
down menu

Unit of Volume Flow Unit of Volume Flow [Required if Volume 
Flow for any side is available]

Unit of Density Unit of Density. [Required if any 
Densities are provided]

Unit of Heat Duty Unit of Heat Duty. [Required if mass flow 
or volume flow for either side is 
available]

Unit of Specific Heat Unit of Specific Heat. [Required if mass 
flow or volume flow for either side is 
available]

Unit of Pressure Unit of Pressure. [Required if Pressure 
is available]

NOTE:
Density relates to where the volumetric flow rate is measured - heat exchanger inlet or outlet.

Table 22. Step-2 Tab of HXAM-G Configuration Faceplate (Continued)

Element Description Expected Value
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Figure 99. Step-3 Tab of HXAM-G Configuration Faceplate

Table 23. Step-3 Tab of HXAM-G Configuration Faceplate 

Element Description Expected Value

Hot Side: Is Pressure 
Difference Available?

Select YES if Pressure Difference for 
Hot side is available [Required]

YES, NO

Hot Side: Is Pressure In 
and Out Available?

Select YES if alternative to calculate 
Pressure Difference for Hot side is 
available. Enabled only if Is Pressure 
Difference Available? for hot side is set 
to NO [Required if Pressure Difference 
for hot side is not available]
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Step-4 Tab

The Step-4 tab is the view of Configuration_Step4_FE. Figure 100 shows the view 
of Step-4 tab and Table 24 lists and describes the elements in the Step-4 tab of the 
Configuration Faceplate.  

Cold Side: Is Pressure 
Difference Available?

Select YES if Pressure Difference for 
Cold side is available [Required]

YES, NO

Cold Side: Is Pressure In 
and Out Available?

Select YES if alternative to calculate 
Pressure Difference for Cold side is 
available. Enabled only if Is Pressure 
Difference Available? for cold side is 
set to NO [Required if Pressure 
Difference for cold side is not available]

Table 23. Step-3 Tab of HXAM-G Configuration Faceplate (Continued)

Element Description Expected Value
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Figure 100. Step-4 Tab of HXAM-G Configuration Faceplate

Table 24. Step-4 Tab of HXAM-G Configuration Faceplate 

Element Description Expected Value

Are Base Operating 
Point Sets available for 
manual entry?

Select YES if BOPS are available 
for manual entry [Required]

YES, NO

Hot Inlet Temp Hot side inlet temperature (-459.67) and ≤ ( 5000) for Deg-F

(0) and ≤ ( 5000) for Deg-K

> (-273.15) and ≤ ( 5000) for Deg-C

> (0) and ≤ ( 5000) for Deg-R

Hot Outlet Temp Hot side outlet temperature

Cold Inlet Temp Cold side inlet temperature

Cold Outlet Temp Cold side outlet temperature
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Step-5 Tab

The Step-5 tab is the view of Configuration_Step5_FE. Figure 101 shows the view 
of Step-5 tab and Table 25 lists and describes the elements in the Step-5 tab of the 
Configuration Faceplate.  

Hot Side Flow Hot side Mass flow or Volume flow 
based on availability in Step-2 tab.

Value greater than 0

Cold Side Flow Cold side Mass flow or Volume 
flow based on availability in Step-2 
tab

Hot Side Pressure Delta P Hot side Pressure Difference

Cold Side Pressure 
Delta P

Cold side Pressure Difference

NOTES:
1. BOPS-1 to BOPS-5 are visible and required for manual entry only if:

Are Base Operating Point Sets available for manual entry? is set to YES.
Depending on the No: of Baseline Sets in Step-1 tab.

2. Hot side flow, cold side flow, hot side pressure diff, and cold side pressure diff are visible based on their availability 
specified in the Step-3 and Step-4 tabs.

Table 24. Step-4 Tab of HXAM-G Configuration Faceplate (Continued)

Element Description Expected Value
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Figure 101. Step-5 Tab of HXAM-G Configuration Faceplate

Table 25. Step-5 Tab of HXAM-G Configuration Faceplate 

Element Description Expected Value

Enable Delta Tx Condition Monitor Enable check box if Condition Monitor is 
to be enabled [Optional]

Enable/disable 
check box

Enable Delta T Hot Condition 
Monitor

Enable Delta T Cold Condition 
Monitor



HXAM-G Configuration Faceplate Section 6  Heat Exchanger Asset Monitor (HXAM)

196 3BUA000118-510 G

Step-6 Tab

The Step-6 tab is the view of Configuration_Step6_FE. Figure 102 shows the view 
of Step-6 tab and Table 26 lists and describes the elements in the Step-6 tab of the 
Configuration Faceplate.  

Enable Delta P Hot Condition 
Monitor

Enable check box if Condition Monitor is 
to be enabled. Enabled only if Pressure 
Difference for hot side is available or if 
Pressure Difference can be calculated. 
[Optional]

Enable/disable 
check box

Enable Delta P Cold Condition 
Monitor

Enable check box if Condition Monitor is 
to be enabled. Enabled only if Pressure 
Difference for cold side is available or if 
Pressure Difference can be calculated. 
[Optional]

Enable W Hot Condition Monitor Enable check box if Condition Monitor is 
to be enabled. [Optional]

Enable W Cold Condition Monitor

Enable Delta HD Condition 
Monitor

Enable HD Hot Condition Monitor

Enable HD Cold Condition Monitor

Table 25. Step-5 Tab of HXAM-G Configuration Faceplate (Continued)

Element Description Expected Value
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Figure 102. Step-6 Tab of HXAM-G Configuration Faceplate

Table 26. Step-6 Tab of HXAM-G Configuration Faceplate 

Element Description Expected Value

Delta Tx Limits: High Limit Delta Tx High Limit. Enabled only if 
Delta Tx Condition Monitor is enabled. 
[Required if Delta Tx Condition 
Monitor is enabled]

Value greater than 0

Delta Tx Limits: Increasing Limit Delta Tx Increasing Limit. Enabled 
only if Delta Tx Condition Monitor is 
enabled. [Required if Delta Tx 
Condition Monitor is enabled]
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Delta Tx Limits: Declining Limit Delta Tx Declining Limit. Enabled only 
if Delta Tx Condition Monitor is 
enabled. [Required if Delta Tx 
Condition Monitor is enabled]

Value greater than 0

Delta Tx Limits: Low Limit Delta Tx Low Limit. Enabled only if 
Delta Tx Condition Monitor is enabled. 
[Required if Delta Tx Condition 
Monitor is enabled]

Delta T Hot Limits: High Limit Delta T Hot High Limit. Enabled only if 
Delta T Hot Condition Monitor is 
enabled. [Required if Delta T Hot 
Condition Monitor is enabled]

Delta T Hot Limits: Increasing 
Limit

Delta T Hot Increasing Limit. Enabled 
only if Delta T Hot Condition Monitor is 
enabled. [Required if Delta T Hot 
Condition Monitor is enabled]

Delta T Hot Limits: Declining 
Limit

Delta T Hot Declining Limit. Enabled 
only if Delta T Hot Condition Monitor is 
enabled. [Required if Delta T Hot 
Condition Monitor is enabled]. 
Configurable only if Is Hot Side 
Condensing is NO.

Delta T Hot Limits: Low Limit Delta T Hot Low Limit. Enabled only if 
Delta T Hot Condition Monitor is 
enabled. [Required if Delta T Hot 
Condition Monitor is enabled]. 
Configurable only if Is Hot Side 
Condensing is NO.

Delta T Cold Limits: High Limit Delta T Cold High Limit. Enabled only 
if Delta T Cold Condition Monitor is 
enabled. [Required if Delta T Cold 
Condition Monitor is enabled]

Table 26. Step-6 Tab of HXAM-G Configuration Faceplate (Continued)

Element Description Expected Value



Section 6  Heat Exchanger Asset Monitor (HXAM) HXAM-G Configuration Faceplate

3BUA000118-510 G 199

Step-7 Tab

The Step-7 tab is the view of Configuration_Step7_FE. Figure 103 shows the view 
of Step-7 tab and Table 27 lists and describes the elements in the Step-7 tab of the 
Configuration Faceplate.  

Delta T Cold Limits: Increasing 
Limit

Delta T Cold Increasing Limit. Enabled 
only if Delta T Cold Condition Monitor 
is enabled. [Required if Delta T Cold 
Condition Monitor is enabled]

Value greater than 0

Delta T Cold Limits: Declining 
Limit

Delta T Cold Declining Limit. Enabled 
only if Delta T Cold Condition Monitor 
is enabled. [Required if Delta T Cold 
Condition Monitor is enabled]. 
Configurable only if Is Cold Side 
Evaporating is NO.

Delta T Cold Limits: Low Limit Delta T Cold Low Limit. Enabled only if 
Delta T Cold Condition Monitor is 
enabled. [Required if Delta T Cold 
Condition Monitor is enabled]. 
Configurable only if Is Cold Side 
Evaporating is NO.

Table 26. Step-6 Tab of HXAM-G Configuration Faceplate (Continued)

Element Description Expected Value
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Figure 103. Step-7 Tab of HXAM-G Configuration Faceplate
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Table 27. Step-7 Tab of HXAM-G Configuration Faceplate 

Element Description Expected Value

Delta P Hot Limits: High Limit Delta P Hot High Limit. Enabled only if 
Delta P Hot Condition Monitor is 
enabled. [Required if Delta P Hot 
Condition Monitor is enabled]

Value greater than 0

Delta P Hot Limits: Increasing 
Limit

Delta P Hot Increasing Limit. Enabled 
only if Delta P Hot Condition Monitor is 
enabled. [Required if Delta P Hot 
Condition Monitor is enabled]

Delta P Hot Limits: Declining 
Limit

Delta P Hot Declining Limit. Enabled 
only if Delta P Hot Condition Monitor is 
enabled. [Required if Delta P Hot 
Condition Monitor is enabled]

Delta P Hot Limits: Low Limit Delta P Hot Low Limit. Enabled only if 
Delta P Hot Condition Monitor is 
enabled. [Required if Delta P Hot 
Condition Monitor is enabled]

Delta P Cold Limits: High Limit Delta P Cold High Limit. Enabled only if 
Delta P Cold Condition Monitor is 
enabled. [Required if Delta P Cold 
Condition Monitor is enabled]

Delta P Cold Limits: Increasing 
Limit

Delta P Cold Increasing Limit. Enabled 
only if Delta P Cold Condition Monitor is 
enabled. [Required if Delta P Cold 
Condition Monitor is enabled]

Delta P Cold Limits: Declining 
Limit

Delta P Cold Declining Limit. Enabled 
only if Delta P Cold Condition Monitor is 
enabled. [Required if Delta P Cold 
Condition Monitor is enabled]

Delta P Cold Limits: Low Limit Delta P Cold Low Limit. Enabled only if 
Delta P Cold Condition Monitor is 
enabled. [Required if Delta P Cold 
Condition Monitor is enabled]
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Step-8 Tab

The Step-8 tab is the view of Configuration_Step8_FE. Figure 104 shows the view 
of the Step-8 tab and Table 28 lists and describes the elements in the Step-8 tab of 
the Configuration Faceplate. 

 

TC08442A

Figure 104. Step-8 Tab of HXAM-G Configuration Faceplate
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Table 28. Step-8 Tab of HXAM-G Configuration Faceplate 

Element Description Expected Value

Delta W Hot Limits: High Limit Delta W Hot High Limit. Enabled only 
if Delta W Hot Condition Monitor is 
enabled. [Required if Delta W Hot 
Condition Monitor is enabled]

Value greater than 0

Delta W Hot Limits: Increasing 
Limit

Delta W Hot Increasing Limit. 
Enabled only if Delta W Hot 
Condition Monitor is enabled. 
[Required if Delta W Hot Condition 
Monitor is enabled]

Value greater than 0

Delta W Hot Limits: Declining 
Limit

Delta W Hot Declining Limit. Enabled 
only if Delta W Hot Condition Monitor 
is enabled. [Required if Delta W Hot 
Condition Monitor is enabled]

Value greater than 0

Delta W Hot Limits: Low Limit Delta W Hot Low Limit. Enabled only 
if Delta W Hot Condition Monitor is 
enabled. [Required if Delta W Hot 
Condition Monitor is enabled]

Value greater than 0

Delta W Cold Limits: High Limit Delta W Cold High Limit. Enabled 
only if Delta W Cold Condition 
Monitor is enabled. [Required if Delta 
W Cold Condition Monitor is enabled]

Value greater than 0

Delta W Cold Limits: Increasing 
Limit

Delta W Cold Increasing Limit. 
Enabled only if Delta W Cold 
Condition Monitor is enabled. 
[Required if Delta W Cold Condition 
Monitor is enabled]

Value greater than 0
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Step-9 Tab

The Step-9 tab is the view of Configuration_Step9_FE. Figure 105 shows the view 
of the Step-9 tab and Table 29 lists and describes the elements in the Step-9 tab of 
the Configuration Faceplate.

 

Delta W Cold Limits: Declining 
Limit

Delta W Cold Declining Limit. 
Enabled only if Delta W Cold 
Condition Monitor is enabled. 
[Required if Delta W Cold Condition 
Monitor is enabled]

Value greater than 0

Delta W Cold Limits: Low Limit Delta W Cold Low Limit. Enabled 
only if Delta W Cold Condition 
Monitor is enabled. [Required if Delta 
W Cold Condition Monitor is enabled]

Value greater than 0

Table 28. Step-8 Tab of HXAM-G Configuration Faceplate (Continued)

Element Description Expected Value
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Figure 105. Step-9 Tab of HXAM-G Configuration Faceplate

Table 29. Step-9 Tab of HXAM-G Configuration Faceplate 

Element Description Expected Value

HD Hot Limits: High Limit HD Hot High Limit. Enabled only if HD Hot 
Condition Monitor is enabled. [Required if 
HD Hot Condition Monitor is enabled]

Value greater than 0

HD Hot Limits: Low Limit HD Hot Low Limit. Enabled only if HD Hot 
Condition Monitor is enabled. [Required if 
HD Hot Condition Monitor is enabled]
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HXAM-G Trend Display Aspect

The Object Name field of the Trend Display aspect must refer. If it does not:

1. Click on the field and the Select Object dialog appears as shown in 
Figure 106.  

2. Select the desired object and click OK.

3. The Aspect field, Property, and Log Name fields should be filled in as a 
result. From the drop-down list box in the Aspect field, choose 
AssetMonitorProperties.

4. Once the aspect is selected, choose any property from the drop-down list box 
of the Property field. The properties shown here are the only properties 
available for trending

5. Choose SEAMLESS from the drop-down list box in the Log Name field.

6. Configure the Low Range and High Range to the desired values. The Low 
range is the lowest Y-axis value of the trace. This can be changed by typing 
another value and pressing Enter or by using the arrows. Similarly, the High 
Range is the highest Y-axis value of the trace.

HD Cold Limits: High Limit HD Cold High Limit. Enabled only if HD Cold 
Condition Monitor is enabled. [Required if 
HD Cold Condition Monitor is enabled]

Value greater than 0

HD Cold Limits: Low Limit HD Cold Low Limit. Enabled only if HD Cold 
Condition Monitor is enabled. [Required if 
HD Cold Condition Monitor is enabled]

Delta HD Limits: High 
Limit

Delta HD High Limit. Enabled only if Delta 
HD Condition Monitor is enabled. [Required 
if Delta HD Condition Monitor is enabled]

Table 29. Step-9 Tab of HXAM-G Configuration Faceplate (Continued)

Element Description Expected Value
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Configuring HXAM_G Asset Parameters

Macros used in HXAM_G aspect to configure the Asset Parameter values are 
shown in Table 30. These macros SHOULD NOT be changed. 

Table 30. Macros Used in HXAM_G Aspect to Configure Asset Parameter Values 

Asset Parameter Name Asset Parameter Value

E_Improvement_Level %:Configuration_Values:E_Improve%

E_Significant_Improvement_Level %:Configuration_Values:E_Significant_Improve%

E_Decline_Level %:Configuration_Values:E_Decline%

E_Significant_Decline_Level %:Configuration_Values:E_Significant_Decline%

Asset_Monitor_Sampling_Interval %:Configuration_Values:Asset_Monitor_Sampling_Interval%

Delta_BOPS %:Configuration_Values:Delta_BOPS%

Hot_Side_Condensing %:Configuration_Values:Is_Hot_Side_Condensing%
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Cold_Side_Evaporating %:Configuration_Values:Is_Cold_Side_Evaporating%

Normal_Service_Interval_In_Hrs %:Configuration_Values:Normal_Service_Interval%

Number_Of_Baseline_Sets %:Configuration_Values:Number_Baseline_Sets%

Inhibit_Value %:Configuration_Values:Inhibit%

Inhibit_Value_Mask_Hex 0xFFFFFFFF

Enable_Logging_Data %:Configuration_Values:Enable_Logging_Data%

Mass_Flow_Hot_Available %:Configuration_Values:Mass_Flow_Hot_Available%

Volume_Flow_Hot_Available %:Configuration_Values:Volume_Flow_Hot_Available%

Mass_Flow_Cold_Available %:Configuration_Values:Mass_Flow_Cold_Available%

Volume_Flow_Cold_Available %:Configuration_Values:Volume_Flow_Cold_Available%

Delta_P_Hot_Available %:Configuration_Values:Delta_P_Hot_Available%

Delta_P_Hot_Alternative_Available %:Configuration_Values:Delta_P_Hot_Alternative_Available%

Delta_P_Cold_Available %:Configuration_Values:Delta_P_Cold_Available%

Delta_P_Cold_Alternative_Available %:Configuration_Values:Delta_P_Cold_Alternative_Available
%

Unit_Of_Temperature %:Configuration_Values:Unit_Of_Temperature%

Unit_Of_Mass_Flow %:Configuration_Values:Unit_Of_MassFlow%

Unit_Of_Volume_Flow %:Configuration_Values:Unit_Of_VolumeFlow%

Unit_Of_Density %:Configuration_Values:Unit_Of_Density%

Unit_Of_Specific_Heat %:Configuration_Values:Unit_Of_Specific_Heat%

Unit_Of_Heat_Duty %:Configuration_Values:Unit_Of_HeatDuty%

Specific_Heat_Hot_Fluid %:Configuration_Values:Specific_Heat_Hot%

Specific_Heat_Cold_Fluid %:Configuration_Values:Specific_Heat_Cold%

Table 30. Macros Used in HXAM_G Aspect to Configure Asset Parameter Values (Continued)

Asset Parameter Name Asset Parameter Value
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Density_Hot_Fluid %:Configuration_Values:Density_Hot%

Density_Cold_Fluid %:Configuration_Values:Density_Cold%

Heat_Of_Vaporization_Hot_Side %:Configuration_Values:Heat_Of_Vaporization_Hot%

Heat_Of_Vaporization_Cold_Side %:Configuration_Values:Heat_Of_Vaporization_Cold%

Enable_Delta_Tx_AM %:Configuration_Values:Enable_Delta_Tx_AM%

Delta_Tx_Increasing %:Configuration_Values:Delta_Tx_Increasing%

Delta_Tx_Declining %:Configuration_Values:Delta_Tx_Declining%

Delta_Tx_Low %:Configuration_Values:Delta_Tx_Low%

Delta_Tx_High %:Configuration_Values:Delta_Tx_High%

Enable_Delta_T_Hot_AM %:Configuration_Values:Enable_Delta_T_Hot_AM%

Delta_T_Hot_High %:Configuration_Values:Delta_T_Hot_High%

Delta_T_Hot_Increasing %:Configuration_Values:Delta_T_Hot_Increasing%

Delta_T_Hot_Declining %:Configuration_Values:Delta_T_Hot_Declining%

Delta_T_Hot_Low %:Configuration_Values:Delta_T_Hot_Low%

Enable_Delta_T_Cold_AM %:Configuration_Values:Enable_Delta_T_Cold_AM%

Delta_T_Cold_High %:Configuration_Values:Delta_T_Cold_High%

Delta_T_Cold_Increasing %:Configuration_Values:Delta_T_Cold_Increasing%

Delta_T_Cold_Declining %:Configuration_Values:Delta_T_Cold_Declining%

Delta_T_Cold_Low %:Configuration_Values:Delta_T_Cold_Low%

Enable_Delta_P_Hot_AM %:Configuration_Values:Enable_Delta_P_Hot_AM%

Delta_P_Hot_High %:Configuration_Values:Delta_P_Hot_High%

Delta_P_Hot_Increasing %:Configuration_Values:Delta_P_Hot_Increasing%

Delta_P_Hot_Declining %:Configuration_Values:Delta_P_Hot_Declining%

Table 30. Macros Used in HXAM_G Aspect to Configure Asset Parameter Values (Continued)

Asset Parameter Name Asset Parameter Value
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Delta_P_Hot_Low %:Configuration_Values:Delta_P_Hot_Low%

Enable_Delta_P_Cold_AM %:Configuration_Values:Enable_Delta_P_Cold_AM%

Delta_P_Cold_High %:Configuration_Values:Delta_P_Cold_High%

Delta_P_Cold_Increasing %:Configuration_Values:Delta_P_Cold_Increasing%

Delta_P_Cold_Declining %:Configuration_Values:Delta_P_Cold_Declining%

Delta_P_Cold_Low %:Configuration_Values:Delta_P_Cold_Low%

Enable_W_Hot_AM %:Configuration_Values:Enable_W_Hot_AM%

W_Hot_High %:Configuration_Values:W_Hot_High%

W_Hot_Increasing %:Configuration_Values:W_Hot_Increasing%

W_Hot_Declining %:Configuration_Values:W_Hot_Declining%

W_Hot_Low %:Configuration_Values:W_Hot_Low%

Enable_W_Cold_AM %:Configuration_Values:Enable_W_Cold_AM%

W_Cold_High %:Configuration_Values:W_Cold_High%

W_Cold_Increasing %:Configuration_Values:W_Cold_Increasing%

W_Cold_Declining %:Configuration_Values:W_Cold_Declining%

W_Cold_Low %:Configuration_Values:W_Cold_Low%

Enable_HD_Hot_AM %:Configuration_Values:Enable_HD_Hot_AM%

HD_Hot_High_Limit %:Configuration_Values:HD_Hot_High%

HD_Hot_Low_Limit %:Configuration_Values:HD_Hot_Low%

Enable_HD_Cold_AM %:Configuration_Values:Enable_HD_Cold_AM%

HD_Cold_High_Limit %:Configuration_Values:HD_Cold_High%

HD_Cold_Low_Limit %:Configuration_Values:HD_Cold_Low%

Table 30. Macros Used in HXAM_G Aspect to Configure Asset Parameter Values (Continued)

Asset Parameter Name Asset Parameter Value
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Configuration of Asset Parameters uses an intermediate Configuration_Values 
aspect which is a General Properties aspect. The macros used in the HXAM_G 
Aspect/Asset Parameters/Values reads the property of the corresponding Asset 
Parameter from its corresponding variable in the Configuration_Values aspect. 

There are two ways to configure Asset Parameters:

1. Write the values of the Asset Parameters in the Configuration_Values aspect 
against its corresponding variable. [Not Recommended].

2. Use the HXAM-G Configuration Faceplate that is a Graphical User Interface to 
assign values for the Asset Parameters. Any configuration done in the 
HXAM-G Configuration Faceplate gets automatically written to the 
Configuration_Values aspect, from where the Asset Parameters reads its value. 
[Recommended].

Table 31 shows the description and expected values of all the Asset Parameters and 
Table 32 shows the corresponding variables in Configuration_Values aspects and 
the HXAM-G Configuration Faceplate for every Asset Parameter.  

 

Enable_Delta_HD_AM %:Configuration_Values:Enable_Delta_HD_AM%

Delta_HD_High_Limit %:Configuration_Values:Delta_HD_High%

Do not change the macros used in the Asset Parameters tab in the HXAM_G 
aspect. Do not change anything in the Configuration_Values aspect. The 
read/write permissions for all properties in the Configuration_Values aspect is set 
to YES and the names and data type of the properties are shown in Table 32.

Table 30. Macros Used in HXAM_G Aspect to Configure Asset Parameter Values (Continued)

Asset Parameter Name Asset Parameter Value
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Table 31. Description and Expected Asset Parameter Values 

Parameter Name Description Expected Value

E_Improvement_Level Improvement in Performance 
Factor in % [Required]

Value greater than zero. 
Default Value: 2.00

E_Significant_Improvement_Level Significant Improvement in 
Performance Factor in % 
[Required]

Value greater than zero. 
Default Value: 5.00

E_Decline_Level Decline in Performance Factor 
in % [Required]

Value greater than zero

Default Value: 2.00

E_Significant_Decline_Level Significant Decline in 
Performance Factor in % 
[Required]

Value greater than zero. 
Default Value: 5.00

Asset_Monitor_Sampling_Interval Time interval between 
Monitoring [Required]

Any Integer greater than 
0. Recommended 
values given in Table 24 
on page 193. 

Delta_BOPS Acceptable percentage 
difference between COPS and 
BOPS to consider COPS as a 
new set of BOPS [Required]

Value greater than zero. 
Default Value: 5.00

Normal_Service_Interval_In_Hrs Time interval between heat 
exchanger cleaning, rebuilds, 
etc. in hours [Required]

Value greater than zero.

Number_Of_Baseline_Sets Number of BOPS expected 
[Required]

Minimum Integer value 
of 1 and no more than 5.

Enable_Logging_Data Set to True/Yes if the Operating 
Point Set needs to be logged 
into a file [Required]

TRUE, FALSE, YES, 
NO

Hot_Side_Condensing Set to True/Yes if Hot side Flow 
is getting Condensed. 
[Required]

TRUE, FALSE, YES, 
NO
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Cold_Side_Evaporating Set to True/Yes if Cold Side is 
getting Evaporated [Required]

TRUE, FALSE, YES, 
NO

Mass_Flow_Hot_Available Set to True/Yes if Mass Flow 
for Hot side is available 
[Required]

TRUE, FALSE, YES, 
NO

Mass_Flow_Cold_Available Set to True/Yes if Mass Flow 
for Cold side is available 
[Required]

TRUE, FALSE, YES, 
NO

Volume_Flow_Hot_Available Set to True/Yes if Volume Flow 
for Hot side is available 
[Required if Mass Flow for Hot 
side is not available]

TRUE, FALSE, YES, 
NO

Volume_Flow_Cold_Available Set to True/Yes if Volume Flow 
for Cold side is available 
[Required if Mass Flow for Cold 
side is not available]

TRUE, FALSE, YES, 
NO

Density_Hot_Fluid Density for Hot side. [Required 
if Volume Flow for Hot side is 
available]

Value greater than 0.

Density_Cold_Fluid Density for Cold side. [Required 
if Mass Flow for Cold side is not 
available]

Value greater than 0

Delta_P_Hot_Available Set to True if Pressure 
Difference for Hot side is 
available [Required] 

TRUE, FALSE, YES, 
NO

Delta_P_Hot_Alternative_Available Set to True if Alternative to 
calculate Pressure Difference 
for Hot side is available 
[Required if Pressure 
Difference for hot side is not 
available]

TRUE, FALSE, YES, 
NO

Table 31. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value



Configuring HXAM_G Asset Parameters Section 6  Heat Exchanger Asset Monitor (HXAM)

214 3BUA000118-510 G

Delta_P_Cold_Available Set to True if Pressure 
Difference for Cold side is 
available [Required

TRUE, FALSE, YES, 
NO

Delta_P_Cold_Alternative_Available Set to True if Alternative to 
calculate Pressure Difference 
for Cold side is available 
[Required if Pressure 
Difference for cold side is not 
available]

TRUE, FALSE, YES, 
NO

Specific_Heat_Hot_Fluid Specific Heat of Hot Side fluid 
[Required if either flows for hot 
side is available]

Value greater than 0

Specific_Heat_Cold_Fluid Specific Heat of Cold Side fluid 
[Required if either flows for cold 
side is available]

Value greater than 0

Unit_Of_Temperature Unit of Temperature [Required] DEG-K, 

DEG-C, 

DEG-F, 

DEG-R

Unit_Of_Mass_Flow Unit of Mass flow [Required] LB/DAY, 

LB/HR, 

LB/MIN, 

LB/S, 

KG/DAY, 

KG/HR, 

KG/MIN, 

KG/S

KLB/DAY

KLB/HR

TONNE/HR

Table 31. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Unit_Of_Heat_Duty Unit of Heat Duty [Required] KCAL/S, 

KCAL/HR, 

BTU/S, 

BTU/HR, 

W, 

MW

Unit_Of_Volume_Flow Unit of Volume Flow [Required 
if Volume Flow for any side is 
available]

CU.FT/DAY, CU.FT/HR, 
CU.FT/MIN, 

CU.FT/S, 

L/DAY, 

L/HR, 

L/MIN, 

US GAL/DAY, 

US GAL/HR, 

US GAL/MIN,

US GAL/S, 

CU.M/DAY, 

CU.M/HR, 

CU.M/MIN 

CU.M/S

Unit_Of_Density Unit of Density. [Required if any 
Densities are provided]

LB/CU.FT, 

LB/US GAL, 

KG/CU.M, 

G/L, 

G/CU.CM

Unit_Of_Specific_Heat Unit of Specific Heat. 
[Required]

BTU/LB.DEG-F, 
KJ/KG.DEG-K, 
KCAL/KG.DEG-K, 
J/G.DEG-C

Table 31. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Unit_Of_Heat_Duty Unit of Heat Duty [Required] KCAL/S, 

KCAL/HR, 

BTU/S, 

BTU/HR, 

W, 

MW

Inhibit_Value Any string value can be entered 
for inhibit. When the Input 
Record Inhibit equals the value 
entered, the Asset Monitor gets 
disabled.

Any string value except 
True/False

Enable_Delta_Tx_AM Set to True if Delta_Tx Asset 
Monitor is Enabled [Optional]

TRUE, FALSE

Delta_Tx_Increasing Delta_Tx Increasing Limit 
[Required if Delta_Tx AM 
Enabled]

Value greater than 0

Delta_Tx_Declining Delta_Tx Declining Limit 
[Required if Delta_Tx AM 
Enabled]

Value greater than 0

Delta_Tx_Low Delta_Tx Low Limit [Required if 
Delta_Tx AM Enabled]

Value greater than 0

Delta_Tx_High Delta_Tx High Limit [Required if 
Delta_Tx AM Enabled]

Value greater than 0

Heat_Of_Vaporization_Hot_Side Hot side Heat of Vaporization. 
[Required if Hot side 
Condensing]

Value greater than 0

Heat_Of_Vaporization_Cold_Side Cold side Heat of Vaporization. 
[Required if Cold Side 
Evaporating]

Value greater than 0

Table 31. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value



Section 6  Heat Exchanger Asset Monitor (HXAM) Configuring HXAM_G Asset Parameters

3BUA000118-510 G 217

Enable_Delta_T_Hot_AM Set to True if Hot Side 
Temperature Difference AM 
Enabled [Optional] 

TRUE, FALSE

Delta_T_Hot_High Delta_T_Hot High Limit 
[Required if Delta_T_Hot AM 
Enabled]

Value greater than 0

Delta_T_Hot_Increasing Delta_T_Hot Increasing Limit 
[Required if Delta_T_Hot AM 
Enabled]

Value greater than 0

Delta_T_Hot_Declining Delta_T_Hot Declining Limit 
[Required if Delta_T_Hot AM 
Enabled]

Value greater than 0

Delta_T_Hot_Low Delta_T_Hot Low Limit 
[Required if Delta_T_Hot AM 
Enabled]

Value greater than 0

Enable_Delta_T_Cold_AM Set to True if Cold Side 
Temperature Difference AM is 
Enabled [Optional]

TRUE, FALSE

Delta_T_Cold_High Delta_T_Cold High Limit 
[Required if Delta_T_Cold AM 
Enabled]

Value greater than 0

Delta_T_Cold_Increasing Delta_T_Cold Increasing Limit 
[Required if Delta_T_Cold AM 
Enabled]

Value greater than 0

Delta_T_Cold_Declining Delta_T_Cold Declining Limit 
[Required if Delta_T_Cold AM 
Enabled]

Value greater than 0

Delta_T_Cold_Low Delta_T_Cold Low Limit 
[Required if Delta_T_Cold AM 
Enabled]

Value greater than 0

Table 31. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Enable_Delta_P_Hot_AM Set to True if Hot Side Pressure 
Difference AM is Enabled 
[Optional]

TRUE, FALSE

Delta_P_Hot_High Delta_P_Hot High Limit 
[Required if Delta_P_Hot AM 
Enabled]

Value greater than 0

Delta_P_Hot_Increasing Delta_P_Hot Increasing Limit 
[Required if Delta_P_Hot AM 
Enabled]

Value greater than 0

Delta_P_Hot_Declining Delta_P_Hot Declining Limit 
[Required if Delta_P_Hot AM 
Enabled]

Value greater than 0

Delta_P_Hot_Low Delta_P_Hot Low Limit 
[Required if Delta_P_Hot AM 
Enabled]

Value greater than 0

Enable_Delta_P_Cold_AM Set to True if Cold Side 
Pressure Difference AM is 
Enabled [Optional]

TRUE, FALSE

Delta_P_Cold_High Delta_P_Cold High Limit 
[Required if Delta_P_Cold AM 
Enabled]

Value greater than 0

Delta_P_Cold_Low Delta_P_Cold Low Limit 
[Required if Delta_P_Cold 
AM Enabled]

Value greater than 0

Delta_P_Cold_Increasing Delta_P_Cold Increasing Limit 
[Required if Delta_P_Cold AM 
Enabled]

Value greater than 0

Delta_P_Cold_Declining Delta_P_Cold Declining Limit 
[Required if Delta_P_Cold AM 
Enabled]

Value greater than 0

Table 31. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Enable_W_Hot_AM Set to True if Hot Side Mass 
Flow AM is Enabled [Optional]

TRUE, FALSE

W_Hot_High Hot Side Mass Flow High Limit 
[Required if W_Hot AM 
Enabled]

Value greater than 0

W_Hot_Increasing Hot Side Mass Flow Increasing 
Limit [Required if W_Hot AM 
Enabled]

Value greater than 0

W_Hot_Declining Hot Side Mass Flow Declining 
Limit [Required if W_Hot AM 
Enabled]

Value greater than 0

W_Hot_Low Hot Side Mass Flow Low Limit 
[Required if W_Hot AM 
Enabled]

Value greater than 0

Enable_W_Cold_AM Set to True if Cold Side Mass 
Flow AM is Enabled [Optional]

TRUE, FALSE

W_Cold_High Cold Side Mass Flow High Limit 
[Required if W_Cold AM 
Enabled]

Value greater than 0

W_Cold_Increasing Cold Side Mass Flow 
Increasing Limit [Required if 
W_Cold AM Enabled]

Value greater than 0

W_Cold_Declining Cold Side Mass Flow Declining 
Limit [Required if W_Cold AM 
Enabled]

Value greater than 0

W_Cold_Low Cold Side Mass Flow Low Limit 
[Required if W_Cold AM 
Enabled]

Value greater than 0

Enable_HD_Hot_AM Set to True if Hot Side Heat 
Duty AM is Enabled [Optional]

TRUE, FALSE

Table 31. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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HD_Hot_High_Limit Hot Side Heat Duty High Limit 
[Required if HD_Hot AM 
Enabled]

Value greater than 0

HD_Hot_Low_Limit Hot Side Heat Duty Low Limit 
[Required if HD_Hot AM 
Enabled]

Value greater than 0

Enable_HD_Cold_AM Set to True if Cold Side Heat 
Duty AM is Enabled [Optional]

TRUE, FALSE

HD_Cold_High_Limit Cold Side Heat Duty High Limit 
[Required if HD_Cold AM 
Enabled]

Value greater than 0

HD_Cold_Low_Limit Cold Side Heat Duty Low Limit

[Required if HD_Cold AM 
Enabled]

Value greater than 0

Enable_Delta_HD_AM Set to True if Heat Duty 
Difference AM is Enabled 
[Optional]

TRUE, FALSE

Delta_HD_High_Limit Heat Duty Difference High Limit 
[Required if Delta_HD AM 
Enabled]

Value greater than 0

Table 32. Configuration_Values Aspect and HXAM-G Configuration Faceplate Values 

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-G Configuration 

Faceplate

E_Improvement_Level E_Improve (Float) Improvement Level of E 
[Step-1]

E_Significant_Improvement_Level E_Significant_Improve 
(Float)

Significant Improvement Level 
of E [Step-1]

Table 31. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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E_Decline_Level E_Decline (Float) Declining Level of E [Step-1]

E_Significant_Decline_Level E_Significant_Decline (Float) Significant Declining Level of E 
[Step-1]

Asset_Monitor_Sampling_Interval Asset_Monitor_Sampling_Int
erval (Integer)

Monitoring Interval [Step-1]

Delta_BOPS Delta_BOPS (Float) Delta BOPS [Step-1]

Hot_Side_Condensing Is_Hot_Side_Condensing 
(String)

Is Hot Side Condensing? 
[Step-1]

Cold_Side_Evaporating Is_Cold_Side_Evaporating 
(String)

Is Cold Side Evaporating? 
[Step-1]

Normal_Service_Interval_In_Hrs Normal_Service_Interval 
(Float)

Normal Service Interval 
[Step-1]

Number_Of_Baseline_Sets Number_Baseline_Sets 
(Integer)

No: of Baseline Sets [Step-1]

Inhibit_Value Inhibit (String) Inhibit [Step-1]

Enable_Logging_Data Enable_Logging_Data 
(String)

Enable Logging of Data? 
[Step-1]

Mass_Flow_Hot_Available Mass_Flow_Hot_Available 
(String)

Hot Side: Is Mass Flow 
Available? [Step-2]

Volume_Flow_Hot_Available  Volume_Flow_Hot_Available 
(String)

Hot Side: Is Volume Flow 
Available? 

 [Step-2]

Mass_Flow_Cold_Available  Mass_Flow_Cold_Available 
(String)

Cold Side: Is Mass Flow 
Available?  [Step-2]

Table 32. Configuration_Values Aspect and HXAM-G Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-G Configuration 

Faceplate
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Volume_Flow_Cold_Available Volume_Flow_Cold_Availabl
e (String)

Cold Side: Is Volume Flow 
Available?  [Step-2]

Delta_P_Hot_Available Delta_P_Hot_Available 
(String)

Hot Side: Is Pressure 
Difference Available? [Step-3]

Delta_P_Hot_Alternative_Available Delta_P_Hot_Alternative_ 
Available (String)

Hot Side: Is Pressure In and 
Out Available? [Step-3]

 Delta_P_Cold_Available Delta_P_Cold_Available 
(String)

Cold Side: Is Pressure 
Difference Available? [Step-3]

Delta_P_Cold_Alternative_ 
Available

Delta_P_Cold_Alternative_ 
Available (String)

Cold Side: Is Pressure In and 
Out Available? [Step-3]

Unit_Of_Temperature Unit_Of_Temperature 
(String)

Unit of Temperature [Step-1]

Unit_Of_Mass_Flow Unit_Of_Mass_Flow (String) Unit of Mass Flow [Step-2]

Unit_Of_Volume_Flow Unit_Of_Volume_Flow 
(String)

Unit of Volume Flow [Step-2]

Unit_Of_Density Unit_Of_Density (String) Unit of Density [Step-2]

Unit_Of_Specific_Heat Unit_Of_Specific_Heat 
(String)

Unit of Specific Heat [Step-2]

Unit_Of_Heat_Duty Unit_Of_Heat_Duty (String) Unit of Heat Duty [Step-2]

Specific_Heat_Hot_Fluid Specific_Heat_Hot (Float) Hot Side: Specific Heat 
[Step-2]

Specific_Heat_Cold_Fluid Specific_Heat_Cold (Float) Cold Side: Specific Heat 
[Step-2]

Density_Hot_Fluid Density_Hot (Float) Hot Side: Density [Step-2]

Density_Cold_Fluid Density_Cold (Float) Cold Side: Density [Step-2]

Table 32. Configuration_Values Aspect and HXAM-G Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-G Configuration 

Faceplate
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Heat_Of_Vaporization_Hot_Side Heat_Of_Vaporization_Hot 
(Float)

Hot Side: Heat of Vap [Step-2]

Heat_Of_Vaporization_Cold_Side Heat_Of_Vaporization_Cold 
(Float)

Cold Side: Heat of Vap 
[Step-2]

Enable_Delta_Tx_AM Enable_Delta_Tx_AM 
(String)

Enable Delta Tx Condition 
Monitor [Step-4]

Delta_Tx_Increasing Delta_Tx_Increasing (Float) Delta Tx Limits: Increasing 
Limit [Step-5]

Delta_Tx_Declining Delta_Tx_Declining (Float) Delta Tx Limits: Declining 
Limit [Step-5]

Delta_Tx_Low Delta_Tx_Low (Float) Delta Tx Limits: Low Limit 
[Step-5]

Delta_Tx_High Delta_Tx_High (Float) Delta Tx Limits: High Limit 
[Step-5]

Enable_Delta_T_Hot_AM Enable_Delta_T_Hot_AM 
(String)

Enable Delta T Hot Condition 
Monitor [Step-4]

Delta_T_Hot_High Delta_T_Hot_High (Float) Delta T Hot Limits: High Limit 
[Step-5]

Delta_T_Hot_Increasing Delta_T_Hot_Increasing 
(Float)

Delta T Hot Limits: Increasing 
Limit [Step-5]

Delta_T_Hot_Declining Delta_T_Hot_Declining 
(Float)

Delta T Hot Limits: Declining 
Limit [Step-5]

Delta_T_Hot_Low Delta_T_Hot_Low (Float) Delta T Hot Limits: Low Limit 
[Step-5]

Enable_Delta_T_Cold_AM Enable_Delta_T_Cold_AM 
(String)

Enable Delta T Cold Condition 
Monitor [Step-4]

Table 32. Configuration_Values Aspect and HXAM-G Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-G Configuration 

Faceplate
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Delta_T_Cold_High Delta_T_Cold_High (Float) Delta T Cold Limits: High 
Limit [Step-5]

Delta_T_Cold_Increasing Delta_T_Cold_Increasing 
(Float)

Delta T Cold Limits: 
Increasing Limit [Step-5]

Delta_T_Cold_Declining Delta_T_Cold_Declining 
(Float)

Delta T Cold Limits: Declining 
Limit [Step-5]

Delta_T_Cold_Low Delta_T_Cold_Low (Float) Delta T Hot Limits: Low Limit 
[Step-5]

Enable_Delta_P_Hot_AM Enable_Delta_P_Hot_AM 
(String)

Enable Delta P Hot Condition 
Monitor [Step-4]

Delta_P_Hot_High Delta_P_Hot_High (Float) Delta P Hot Limits: High Limit 
[Step-6]

Delta_P_Hot_Increasing Delta_P_Hot_Increasing 
(Float)

Delta P Hot Limits: Increasing 
Limit [Step-6]

Delta_P_Hot_Declining Delta_P_Hot_Declining 
(Float)

Delta P Hot Limits: Declining 
Limit [Step-6]

Delta_P_Hot_Low Delta_P_Hot_Low (Float) Delta P Hot Limits: Low Limit 
[Step-6]

Enable_Delta_P_Cold_AM Enable_Delta_P_Cold_AM 
(String)

Enable Delta P Cold Condition 
Monitor [Step-4]

Delta_P_Cold_High Delta_P_Cold_High (Float) Delta P Cold Limits: High 
Limit [Step-6]

Delta_P_Cold_Increasing Delta_P_Cold_Increasing 
(Float)

Delta P Cold Limits: 
Increasing Limit [Step-6]

Delta_P_Cold_Declining Delta_P_Cold_Declining 
(Float)

Delta P Cold Limits: Declining 
Limit [Step-6]

Table 32. Configuration_Values Aspect and HXAM-G Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-G Configuration 

Faceplate
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Delta_P_Cold_Low Delta_P_Cold_Low (Float) Delta P Cold Limits: Low Limit 
[Step-6]

Enable_W_Hot_AM Enable_W_Hot_AM (String) Enable W Hot Condition 
Monitor [Step-4]

W_Hot_High W_Hot_High (Float) W Hot Limits: High Limit 
[Step-7]

W_Hot_Increasing W_Hot_Increasing (Float) W Hot Limits: Increasing Limit 
[Step-7]

W_Hot_Declining W_Hot_Declining (Float) W Hot Limits: Declining Limit 
[Step-7]

W_Hot_Low W_Hot_Low (Float) W Hot Limits: Low Limit 
[Step-7]

Enable_W_Cold_AM Enable_W_Cold_AM (String) Enable W Cold Condition 
Monitor [Step-4]

W_Cold_High W_Cold_High (Float) W Cold Limits: High Limit 
[Step-7]

W_Cold_Increasing W_Cold_Increasing (Float) W Cold Limits: Increasing 
Limit [Step-7]

W_Cold_Declining W_Cold_Declining (Float) W Cold Limits: Declining Limit 
[Step-7]

W_Cold_Low W_Cold_Low (Float) W Cold Limits: Low Limit 
[Step-7]

Enable_HD_Hot_AM Enable_HD_Hot_AM (String) Enable HD Hot Condition 
Monitor [Step-4]

HD_Hot_High_Limit HD_Hot_High (Float) HD Hot Limits: High Limit 
[Step-8]

Table 32. Configuration_Values Aspect and HXAM-G Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-G Configuration 

Faceplate
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Recommended Asset Monitor Sampling Interval (AMSI) for HXAM_G

Table 33 lists the recommended Asset Monitor sampling interval (AMSI). 

HD_Hot_Low_Limit HD_Hot_Low (Float) HD Hot Limits: Low Limit 
[Step-8]

Enable_HD_Cold_AM Enable_HD_Cold_AM 
(String)

Enable HD Cold Condition 
Monitor [Step-5]

HD_Cold_High_Limit HD_Cold_High (Float) HD Cold Limits: High Limit 
[Step-8]

HD_Cold_Low_Limit HD_Cold_Low (Float) HD Cold Limits: Low Limit 
[Step-8]

Enable_Delta_HD_AM Enable_Delta_HD_AM Enable Delta HD Condition 
Monitor [Step-4]

Delta_HD_High_Limit Delta_HD_High (Float) Delta HD Limits: Low Limit 
[Step-8]

Table 33. Recommended Asset Monitor Sampling Interval (AMSI) 

Normal Service 
Interval

Recommended AMSI Value 
(minutes)

1 day 1 or greater

2 days

3 days

4 days

5 days

Table 32. Configuration_Values Aspect and HXAM-G Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-G Configuration 

Faceplate
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HXAM_G Asset Monitor Input Records

Input Records for HXAM-G Asset Monitor along with the expected data and 
explanations are given in Table 34. 

6 days 2 or greater

1 week

2 weeks

3 weeks 5 or greater

4 weeks

1 month 10 or greater

2 months 15 or greater

3 months 20 or greater

4 months 30 or greater

5 months

6 months 60 or greater

1 year 120 or greater

2 years 240 or greater

3 years 300 or greater

4 years 480 or greater

5 years

Table 33. Recommended Asset Monitor Sampling Interval (AMSI) (Continued)

Normal Service 
Interval

Recommended AMSI Value 
(minutes)
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Table 34. Input Records 

Input Records Explanation Expected Data

Clear_Base_Operating_Point Specifies if the Asset Monitor is to be retrained. 
This is read as an XML value, which includes a 
timestamp. Therefore any change from True to 
False, False to True, False to False, or True to 
True will trigger Retrain. On retraining, the Asset 
Monitor will erase all the trained BOPS and go 
back to Training Phase. This Input Record is a 
manual input that can be input by clicking a 
button from the HXAM-G Faceplate. [Required]

TRUE / FALSE

T_Hot_In Hot Side Inlet Temperature. [Required] Any numeric 
value

T_Hot_Out Hot Side Outlet Temperature. [Required] Any numeric 
value

T_Cold_In Cold Side Inlet Temperature [Required] Any numeric 
value

T_Cold_Out Hot Side Outlet Temperature [Required] Any numeric 
value

Mass_Flow_Hot_Side Hot Side Mass Flow [Required if Asset 
Parameter Mass_Flow_Hot_Available is set to 
TRUE/YES]

Any numeric 
value

Volume_Flow_Hot_Side Hot Side Volume Flow. [Required if Asset 
Parameter Volume_Flow_Hot_Available is set 
to TRUE/YES]

Any numeric 
value

Mass_Flow_Cold_Side Cold Side Mass Flow. [Required if Asset 
Parameter Mass_Flow_Cold_Available is set 
to TRUE/YES]

Any numeric 
value

Volume_Flow_Cold_Side Cold Side Volume Flow. [Required if Asset 
Parameter Volume_Flow_Cold_Available is 
set to TRUE/YES]

Any numeric 
value
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Delta_P_Hot_Side Hot Side Pressure Difference. [Required if Asset 
Parameter Delta_P_Hot_Available is set to 
TRUE/YES]

Any numeric 
value

P_Hot_In Hot Side Inlet Pressure. [Required if Asset 
Parameter 
Delta_P_Hot_Alternative_Available is set to 
TRUE/YES]

Any numeric 
value

P_Hot_Out Hot Side Outlet Pressure. [Required if Asset 
Parameter 
Delta_P_Hot_Alternative_Available is set to 
TRUE/YES]

Any numeric 
value

Delta_P_Cold_Side Cold Side Pressure Difference. . [Required if 
Asset Parameter Delta_P_Cold_Available is 
set to TRUE/YES]

Any numeric 
value

P_Cold_In Cold Side Inlet Pressure. [Required if Asset 
Parameter 
Delta_P_Cold_Alternative_Available is set to 
TRUE/YES]

Any numeric 
value

P_Cold_Out Cold Side Outlet Pressure. [Required if Asset 
Parameter 
Delta_P_Cold_Alternative_Available is set to 
TRUE/YES]

Any numeric 
value

Inhibit Inhibit Signal. The value must match the Asset 
Parameter Inhibit_Value, if the Asset Monitor is 
to be inhibited. [Optional]

Any String

Clear_BOPS_Date Date of Last Time BOPS change was made 
[Required]

String

Table 34. Input Records (Continued)

Input Records Explanation Expected Data
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For manual input of any input record, the Data Source Item should be configured 
using macros as shown in Table 35 and the actual values should be put in the 
corresponding variable in the HXAM_G_GP aspect. By configuring this way, the 
Input Record reads its data from the HXAM_G_GP aspect. The expected data for 
the Input Records are given in Table 34. 

Table 35. Data Source Item Macros 

Input Records Macros Used
Corresponding Variable 
in HXAM_G_GP Aspect

Clear_Base_Operating_Point %ID%:Clear BOPS Clear BOPS

Inhibit %ID%:Inhibit Inhibit

T_Hot_In %ID%:Inlet Hot Temperature Inlet Hot Temperature

T_Cold_In %ID%:Inlet Cold Temperature Inlet Cold Temperature

T_Hot_Out %ID%:Outlet Hot Temperature Outlet Hot Temperature

T_Cold_Out %ID%:Outlet Cold Temperature Outlet Cold Temperature

Mass_Flow_Hot_Side %ID%:Mass Flow Hot Side Mass Flow Hot Side

Volume_Flow_Hot_Side %ID%:Volume Flow Hot Side Volume Flow Hot Side

Mass_Flow_Cold_Side %ID%:Mass Flow Cold Side Mass Flow Cold Side

Volume_Flow_Cold_Side %ID%:Volume Flow Cold Side Volume Flow Cold Side

Delta_P_Hot_Side %ID%:Pressure Difference Hot Side Pressure Difference Hot 
Side

P_Hot_In %ID%:Inlet Pressure Hot Side Inlet Pressure Hot Side

P_Hot_Out %ID%:Outlet Pressure Hot Side Outlet Pressure Hot Side

Delta_P_Cold_Side %ID%:Pressure Difference Cold Side Pressure Difference Cold 
Side

P_Cold_In %ID%:Inlet Pressure Cold Side Inlet Pressure Cold Side

P_Cold_Out %ID%:Outlet Pressure Cold Side Outlet Pressure Cold Side

Clear_BOPS_Date %ID%:Clear BOPS Date Clear BOPS Date
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 — — RetrainFE_TempVal 

NOTES:
1. For all inputs that are not manually input or somehow stored into the HXAM_G_GP aspect, the macros shown in 

Table 35 will not work. The Data Source Item should be configured based on from where the property of the Input 
Record will be read. The Clear_Base_Operating_Point and Clear_BOPS_Date Input Records will always be 
manual inputs. The actual OPC data source items are obtained, from process variables available within the DCS, 
for the temperatures, flows, and pressures used by the monitor. Remember that the minimum inputs for 
operability of the Heat Exchanger Asset Monitor are the four leg temperatures of the heat exchanger being 
monitored.

2. The RetrainFE_TempVal property under HXAM_G_GP aspect in Table 35 does not have a corresponding Input 
Record. This property is only used for the working of the HXAM_G_BOPS_Info_FE aspect and is not an Input 
Record. This property is configured to take a string and it’s Readable?/Writable? Are set to Yes. Do not make any 
changes to this property. If by any chance the value of this property gets erased, type in the following value: So 
far received 0 Base Operating Point Set. The value of this property should never be 
empty.

Table 35. Data Source Item Macros (Continued)

Input Records Macros Used
Corresponding Variable 
in HXAM_G_GP Aspect



Shell and Tube Heat Exchanger Asset Monitor (HXAM_ST) Section 6  Heat Exchanger Asset 

232 3BUA000118-510 G

Shell and Tube Heat Exchanger Asset Monitor (HXAM_ST)
The following topics discuss Shell and Tube Heat Exchanger Asset Monitor 
operation.

Configuration

Configuration of the Generic Heat Exchanger Asset Monitor consists of:

• HXAM_ST Aspect Configuration.
• HXAM-ST Configuration Faceplate.
• HXAM_ST Trend Display Aspect.

HXAM_ST Aspect Configuration

From the Control Structure, the HXAM-ST object can be created by calling the 
Heat Exchanger Object from the Asset Monitors list of Object Types. After the 
object has been created, the History Source aspect is added into the object. After 
creation of the History Source aspect, the Service Group of the History Source must 
be configured (typically set to Basic).

1. To start configuration, go to HXAM_ST aspect as shown in Figure 107.  



Figure 107. Navigating to the HXAM_ST Aspect
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2. Switch to the Config View of the HXAM_ST aspect as shown in 
Figure 108. 

Figure 108. Config View of HXAM_ST Aspect

TC08447A

 

3. The Config View is divided into six tabs:

– Asset Monitor Tab.
– Conditions Tab.
– Asset Parameters Tab.
– Input Records Tab.
– Output Records Tab.
– Logic Tab.

Asset Monitor Tab

The data in the Asset Monitor tab consists of:

• Asset Monitor Configuration Lifecycle frame: This frame does not have any 
configurable values. No action is required. 
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• AO Server Assignment frame: The Enable in Server check box must be 
enabled for the Asset Monitor to execute. Set the appropriate Server 
Assignment (typically set to Default) in the Assigned to drop-down list box.

• Asset Monitor frame: The Execution Interval in Seconds field must be kept 
at 60 seconds. This defines how often the analysis logic will be executed. 

The actual interval between subsequent executions may be longer than the 
specified interval on heavily loaded systems.

The Asset URL field is an optional parameter that can be used to point to the 
device web interface to get more information on the device status. If desired, 
this can be set to an application specific URL.

The Logic Failure Severity field should be left at 1000. This is the Asset 
Monitor alarm severity level. It is used to report Asset Monitor failures in the 
800xA Alarm and Event system.

• Configuration Inheritance frame: This section does not have any 
configurable values. No action is required. 

Conditions Tab

This tab does not have any configurable values, but reflects Condition/Subcondition 
information for the Asset Monitors, which are implemented.

The Conditions tab contains the definition of the conditions that are assessed and 
reported by the Heat Exchanger Asset Monitor. The main functionality of the Heat 
Exchanger Asset Monitor is to monitor the operating parameters of the heat 
exchanger and report the current subcondition for each defined condition. 

Each condition is defined by a set of subconditions. The subconditions for a given 
condition are mutually exclusive. Subcondition ENUM 0 always represents the 
normal condition state. A transition to the normal state will deactivate the associated 
alarm in the Alarm and Event List. 

If the Asset Monitor is not able to successfully assess the current subcondition for a 
given condition, it sets the quality status of that condition to a bad value. 

The only subconditions that will generate a Fault Report in the Fault Report 
Submitter are those that are not normal with good quality status. 
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Asset Parameters Tab

No configuration is required. The Asset Parameters tab contains configuration 
parameters used to provide additional heat exchanger information required by the 
Heat Exchanger Asset Monitor algorithm.

The Asset Parameters values are read from Configuration_Values aspect by the use 
of macros. The Configuration_Values aspect is an intermediate aspect that gets 
written to, from the Configuration Faceplate aspect, which is then read by the Asset 
Parameters value in HXAM_ST aspect by the use of macros. These macros 
SHOULD NOT be changed. The actual configuration of Asset Parameters is done 
in the Configuration Faceplate. Refer to Configuring HXAM_ST Asset Parameters 
on page 266 for details on configuring the Asset Parameters.

Input Records Tab

The Input Records tab contains the definition of data items (i.e. OPC items) used 
by the Heat Exchanger Asset Monitor to assess the current heat exchanger 
condition. Figure 109 shows the Input Records tab.  
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The columns in the Input Records tab are defined as follows: 

• ID: Input Record identifier. 

• Description: Input Record description. 

• Units: Input Record expected engineering units. 

• Trigger Execution: When True, the Asset Monitor will be scheduled for 
immediate execution upon Input Record value change. Setting this 
configuration parameter to True may increase the actual Asset Monitor 

TC08448A

Figure 109. Input Records Tab
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execution frequency based on the Input Record Data Source Aspect OPC 
Group Update Rate.

• Data Source Aspect: Provides a pick list to select one of the available Asset 
Monitor Data Sources defining the data server (i.e. OPC server) from which to 
read the value. 

• Data Source Item: Identifies the item (i.e. OPC item) in the data server from 
which to read the value.

The Data Source Aspect for the Input Records must be configured to the Data 
Server that reads the value associated with that particular Input Record. The Data 
Source Item must refer to the property that contains the value of the Input Record. If 
an input record is not available, the Data Source Aspect is set to None and the Data 
Source Item is left empty. Input records Clear_Base_Operating_Point and 
Clear_BOPS_Date are manual inputs that uses macros %ID%:Clear BOPS and 
%ID%:Clear BOPS Date respectively to read its property from the 
HXAM_ST_GP Aspect. These two macros SHOULD NOT be changed. The rest of 
the input records are field variables that must be configured accordingly. Refer to 
HXAM-ST Input Records on page 292 for a description of the Input Records.

Output Records Tab

The Output Records tab has no configurable values. It is for information only and 
shows the Output Records in the HXAM-ST Configuration Faceplate for user 
information.

Logic Tab

The Logic tab has no configurable values.

HXAM-ST Configuration Faceplate

The HXAM-ST Configuration Faceplate includes 11 tabs. These tabs are named 
Step-1 through Step-11. These 11 tabs guide the user through each stage of 
configuration. The tabs in the Faceplate aspect are views of the 11 Faceplate 
Element aspects. Figure 110 shows the view of the HXAM-ST Configuration 
Faceplate aspect. Refer to Configuring HXAM_ST Asset Parameters on page 266 
for details on the properties seen in the Configuration Faceplate.  
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Step-1 Tab

The Step-1 tab is the view of Configuration_Step1_FE. Figure 110 shows the view 
of Step-1 tab. Table 36 lists and describes the elements in the Step-1 tab of the 
HXAM-G Configuration Faceplate.  

TC08449A

Figure 110. Step-1 Tab of HXAM-ST Configuration Faceplate



HXAM-ST Configuration Faceplate Section 6  Heat Exchanger Asset Monitor (HXAM)

240 3BUA000118-510 G

Table 36. Step-1 Tab of HXAM-ST Configuration Faceplate 

Element Description Expected Value

Normal Service Interval Time interval between heat exchanger 
cleaning, rebuilds, etc. in hours 
[Required]

Value greater than 0

Monitoring Interval Time interval between monitoring in 
minutes. [Required]

Any Integer greater than 0. 
Recommended values given 
in Configuring HXAM_G 
Asset Parameters on page 
207.

Delta BOPS Acceptable percentage difference 
between COPS and BOPS to consider 
COPS as a new set of BOPS. If no 
value is entered or if there is some 
error in entry, a default value of 5.00 
will be taken. [Required]

Value greater than 0

Default Value: 5.00

No: of Baseline Sets Number of BOPS expected [Required] Minimum Integer value of 1 
and no more than 5

Number of Shells Number of shells used. For most 
applications, one shell is the norm 
[Required]

Total Tube Surface Area Total surface area of tube [Required] Value greater than 0

Total Tube C/S Area Total cross sectional area of tube. Use 
tube ID as this information is used to 
determine tube velocity. [Required]

LMTD Corr Factor Log mean temperature difference 
correction factor. If no value is entered 
or if there is some error in entry, a 
default value of 1 will be taken. 
[Optional]

Value greater than 0 
Default Value: 1

Design Heat Transfer 
Coeff Value

Design heat transfer efficiency. If not 
available, enter any negative value. 
[Required]

Value greater than 0
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Flow Type Flow type through the heat exchanger 
[Required]

CO-CURRENT, COUNTER-
CURRENT

Shell-Side Flow Flow at shell side [Required] HOT, COLD

Unit of Tube Area Unit of tube area [Required] Select one from the drop-
down list box

Unit of Temperature Unit of temperature [Required]

Unit of Heat Transfer 
Coeff.

Unit of heat transfer coefficient 
[Required]

Is Hot-Side Condensing? Select YES if hot side flow is 
condensing. [Required]

YES, NO

Is Cold-Side Evaporating? Select YES if Cold Side is Evaporating 
[Required]

Enable Logging of Data? Select YES to enable data logging to a 
file [Required]

Inhibit Any string value can be entered for 
inhibit. When the Input Record Inhibit 
equals the value entered, the Asset 
Monitor gets disabled.

 Any string value except 
True/False

Table 36. Step-1 Tab of HXAM-ST Configuration Faceplate (Continued)

Element Description Expected Value
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Step-2 Tab

The Step-2 tab is the view of Configuration_Step2_FE. Figure 111 shows the view 
of Step-2 tab and Table 37 lists and describes the elements in the Step-2 tab of the 
Configuration Faceplate.  

TC08450A

Figure 111. Step-2 Tab of HXAM-ST Configuration Faceplate



Section 6  Heat Exchanger Asset Monitor (HXAM) HXAM-ST Configuration Faceplate

3BUA000118-510 G 243

Table 37. Step-2 Tab of HXAM-ST Configuration Faceplate 

Element Description Expected Value

Performance Factor: 
Improvement Level

Acceptable percentage difference 
between the COPS Performance 
Factor and the BOPS Performance 
Factor to consider the COPS 
Performance Factor to have improved. 
If no value is entered a default of 2.00 
will be taken. [Required]

Value greater than 0 
Default Value: 2.00

Performance Factor: 
Declining Level

Acceptable percentage difference 
between the COPS Performance 
Factor and the BOPS Performance 
Factor to consider the COPS 
Performance Factor to have declined. If 
no value is entered a default of 2.00 will 
be taken. [Required]

Value greater than 0 
Default Value: 2.00

Performance Factor: 
Significant Improvement 
Level

Acceptable percentage difference 
between the COPS Performance 
Factor and the BOPS Performance 
Factor to consider the COPS 
Performance Factor to have 
significantly improved. If no value is 
entered a default of 5.00 will be taken. 
[Required]

Value greater than 0

Default Value: 5.00

Performance Factor: 
Significant Declining Level

Acceptable percentage difference 
between the COPS Performance 
Factor and the BOPS Performance 
Factor to consider the COPS 
Performance Factor to have 
significantly declined. If no value is 
entered a default of 5.00 will be taken. 
[Required]
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Heat Transfer Efficiency: 
Improvement Level

Acceptable percentage difference 
between the COPS Heat Transfer 
Efficiency and the BOPS Heat Transfer 
Efficiency to consider the COPS Heat 
Transfer Efficiency to have improved. If 
no value is entered a default of 2.00 will 
be taken. [Required]

Value greater than 0

Default Value: 2.00

Heat Transfer Efficiency: 
Declining Level

Acceptable percentage difference 
between the COPS Heat Transfer 
Efficiency and the BOPS Heat Transfer 
Efficiency to consider the COPS Heat 
Transfer Efficiency to have declined. If 
no value is entered a default of 2.00 will 
be taken. [Required]

Value greater than 0

Default Value: 2.00

Heat Transfer Efficiency: 
Significant Improvement 
Level

Acceptable percentage difference 
between the COPS Heat Transfer 
Efficiency and the BOPS Heat Transfer 
Efficiency to consider COPS Heat 
Transfer Efficiency to have significantly 
improved. If no value is entered a 
default of 5.00 will be taken. [Required]

Value greater than 0

Default Value: 5.00

Heat Transfer Efficiency: 
Significant Declining Level

Acceptable percentage difference 
between the COPS Heat Transfer 
Efficiency and the BOPS Heat Transfer 
Efficiency to consider the COPS Heat 
Transfer Efficiency to have significantly 
declined. If no value is entered a default 
of 5.00 will be taken. [Required]

Table 37. Step-2 Tab of HXAM-ST Configuration Faceplate (Continued)

Element Description Expected Value



Section 6  Heat Exchanger Asset Monitor (HXAM) HXAM-ST Configuration Faceplate

3BUA000118-510 G 245

Step-3 Tab

The Step-3 tab is the view of Configuration_Step3_FE. Figure 112 shows the view 
of Step-3 tab and Table 38 lists and describes the elements in the Step-3 tab of the 
Configuration Faceplate.  

TC08451A

Figure 112. Step-3 Tab of HXAM-ST Configuration Faceplate

Table 38. Step-3 Tab of HXAM-ST Configuration Faceplate 

Element Description Expected Value

Hot Side:

Is Mass Flow available?

Select YES if mass flow for hot side is 
available [Required if volume flow for hot 
side is not available]

YES, NO
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Hot Side:

Is Volume Flow available?

Select YES if volume flow for hot side is 
available [Required if mass flow for hot 
side is not available or if hot side flows 
through the tube and Tube Velocity 
Condition Monitor is enabled]

YES, NO

Hot Side: Density Density of hot side fluid. [Required if 
mass flow for hot side is not available or 
if Tube Velocity Condition Monitor is 
enabled and volume flow for this side is 
not available]

Value greater than 0.

Hot Side: Specific Heat Specific heat of hot side fluid [Required]

Hot Side: Heat of Vap Heat of vaporization for hot side fluid. 
Enabled only if hot side is condensing. 
the unit of heat of vaporization is 
automatically filled based on the unit of 
specific heat selected. [Required if hot 
side condensing]

Cold Side:

Is Mass Flow available

Select YES if mass flow for cold side is 
available [Required if volume flow for 
cold side is not available]

YES, NO

Cold Side:

Is Volume Flow available

Select YES if volume flow for cold side is 
available [Required if mass flow for cold 
side is not available or if cold side flows 
through the tube and Tube Velocity 
Condition Monitor is enabled]

Cold Side: Density Density of cold side fluid. [Required if 
mass flow for cold side is not available 
or if Tube Velocity Condition Monitor is 
enabled and volume flow for this side is 
not available]

Value greater than 0.

Cold Side: Specific Heat Specific heat of cold side fluid 
[Required]

Table 38. Step-3 Tab of HXAM-ST Configuration Faceplate (Continued)

Element Description Expected Value



Section 6  Heat Exchanger Asset Monitor (HXAM) HXAM-ST Configuration Faceplate

3BUA000118-510 G 247

Cold Side: Heat of Vap Heat of vaporization for cold side fluid. 
Enabled only if cold side is evaporating. 
The unit of heat of vaporization is 
automatically filled based on the unit of 
specific heat selected. [Required if cold 
side evaporating]

Value greater than 0

Unit of Mass Flow Unit of mass flow [Required] Select one from the drop-
down list box

Unit of Volume Flow Unit of volume flow [Required if volume 
flow for any side is available]

Unit of Density Unit of density. [Required if any 
densities are provided]

Unit of Heat Duty Unit of heat duty [Required]

Unit of Specific Heat Unit of specific heat. [Required]

Unit of Pressure Unit of pressure. [Required if pressure is 
available]

NOTE:
Density relates to where the volumetric flow rate is measured; heat exchanger inlet or outlet.

Table 38. Step-3 Tab of HXAM-ST Configuration Faceplate (Continued)

Element Description Expected Value
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Step-4 Tab

The Step-4 tab is the view of Configuration_Step4_FE. Figure 113 shows the view 
of Step-4 tab and Table 39 lists and describes the elements in the Step-4 tab of the 
Configuration Faceplate.  
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Figure 113. Step-4 Tab of HXAM-ST Configuration Faceplate

Table 39. Step-4 Tab of HXAM-ST Configuration Faceplate 

Element Description Expected Value

Hot Side: Is Pressure 
Difference Available?

Select YES if pressure difference for hot 
side is available [Required if alternative 
to calculate pressure difference for hot 
side is not available]

YES, NO



Section 6  Heat Exchanger Asset Monitor (HXAM) HXAM-ST Configuration Faceplate

3BUA000118-510 G 249

Hot Side: Is Pressure In 
and Out Available?

Select YES if alternative to calculate 
pressure difference for hot side is 
available. Enabled only if Is Pressure 
Difference Available? for hot side is set 
to NO [Required if pressure difference 
for hot side is not available]

YES, NO

Cold Side: Is Pressure 
Difference Available?

Select YES if pressure difference for 
cold side is available [Required if 
alternative to calculate pressure 
difference for cold side is not available]

Cold Side: Is Pressure In 
and Out Available?

Select YES if alternative to calculate 
pressure difference for cold side is 
available. Enabled only if Is Pressure 
Difference Available? for cold side is 
set to NO [Required if pressure 
difference for cold side is not available]

Table 39. Step-4 Tab of HXAM-ST Configuration Faceplate (Continued)

Element Description Expected Value
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Step-5 Tab

The Step-5 tab is the view of Configuration_Step5_FE. Figure 114 shows the view 
of Step-5 tab and Table 40 lists and describes the elements in the Step-5 tab of the 
Configuration Faceplate.  

TC08453A

Figure 114. Step-5 Tab of HXAM-ST Configuration Faceplate
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Table 40. Step-5 Tab of HXAM-ST Configuration Faceplate 

Element Description Expected Value

Are Base Operating 
Point Sets available for 
manual entry?

Select YES if BOPS are available 
for manual entry [Required]

YES, NO

Hot Inlet Temp Hot side inlet temperature > (-459.67) and ≤ ( 5000) for Deg-F

> (0) and ≤ ( 5000) for Deg-K

> (-273.15) and ≤ ( 5000) for Deg-C

> (0) and <= ( 5000) for Deg-R

Hot Outlet Temp Hot side outlet temperature

Cold Inlet Temp Cold side inlet temperature

Cold Outlet Temp Cold side outlet temperature

Hot Side Flow Hot side mass flow or volume flow 
based on availability in Step-2 tab.

Value greater than 0

Cold Side Flow Cold side mass flow or volume 
flow based on availability in Step-2 
tab.

Hot Side Pressure Delta P Hot side pressure difference

Cold Side Pressure 
Delta P

Cold side pressure difference

NOTES:
1. BOPS-1 to BOPS-5 are visible and required for manual entry only if:

Are Base Operating Point Sets available for manual entry? is set to YES.
Depending on the No: of Baseline Sets in Step-1 tab.

2. Hot side flow, cold side flow, hot side pressure diff, and cold side pressure diff are visible based on their availability 
specified in the Step-3 and Step-4 tabs.
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Step-6 Tab

The Step-6 tab is the view of Configuration_Step6_FE. Figure 115 shows the view 
of Step-6 tab and Table 41 lists and describes the elements in the Step-6 tab of the 
Configuration Faceplate.  

TC08454A

Figure 115. Step-6 Tab of HXAM-ST Configuration Faceplate
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Table 41. Step-6 Tab of HXAM-ST Configuration Faceplate 

Element Description Expected Value

Enable Delta Tx Condition Monitor Enable check box if Condition Monitor is 
to be enabled [Optional]

Enable/disable 
check box

Enable Delta T Hot Condition 
Monitor

Enable Delta T Cold Condition 
Monitor

Enable Delta P Hot Condition 
Monitor

Enable check box if Condition Monitor is 
to be enabled. Enabled only if Pressure 
Difference for hot side is available or if 
Pressure Difference can be calculated. 
[Optional]

Enable Delta P Cold Condition 
Monitor

Enable check box if Condition Monitor is 
to be enabled. Enabled only if Pressure 
Difference for cold side is available or if 
Pressure Difference can be calculated. 
[Optional]

Enable W Hot Condition Monitor Enable check box if Condition Monitor is 
to be enabled. [Optional]

Enable W Cold Condition Monitor

Enable Delta HD Condition 
Monitor

Enable HD Hot Condition Monitor

Enable HD Cold Condition Monitor

Enable Tube Velocity Condition 
Monitor

Enable Shell Side Flow Condition 
Monitor

Enable Limit Approach 
Temperature Condition Monitor
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Step-7 Tab

The Step-7 tab is the view of Configuration_Step7_FE. Figure 116 shows the view 
of Step-7 tab and Table 42 lists and describes the elements in the Step-7 tab of the 
Configuration Faceplate.  

Enable Thermal Crossover 
Detection Monitor

Enable check box if Condition Monitor is 
to be enabled. [Optional]

Enable/disable 
check box

NOTE: If the heat exchanger is a condenser, enabling the Delta T Hot Condition Monitor or the P Hot Condition Monitor 
should not be selected as they will not provide any useful results. Similarly, if the heat exchanger is an evaporator, 
enabling the Delta T Cold Condition Monitor or the P Cold Condition Monitor should not be selected as they will not 
provide any useful results.

TC08455A

Figure 116. Step-7 Tab of HXAM-ST Configuration Faceplate

Table 41. Step-6 Tab of HXAM-ST Configuration Faceplate (Continued)

Element Description Expected Value
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Table 42. Step-7 Tab of HXAM-ST Configuration Faceplate 

Element Description Expected Value

Delta Tx Limits: High Limit Delta Tx High Limit. Enabled only if 
Delta Tx Condition Monitor is enabled. 
[Required if Delta Tx Condition 
Monitor is enabled]

Value greater than 0

Delta Tx Limits: Increasing Limit Delta Tx Increasing Limit. Enabled 
only if Delta Tx Condition Monitor is 
enabled. [Required if Delta Tx 
Condition Monitor is enabled]

Delta Tx Limits: Declining Limit Delta Tx Declining Limit. Enabled only 
if Delta Tx Condition Monitor is 
enabled. [Required if Delta Tx 
Condition Monitor is enabled]

Value greater than 0

Delta Tx Limits: Low Limit Delta Tx Low Limit. Enabled only if 
Delta Tx Condition Monitor is enabled. 
[Required if Delta Tx Condition 
Monitor is enabled]

Delta T Hot Limits: High Limit Delta T Hot High Limit. Enabled only if 
Delta T Hot Condition Monitor is 
enabled. [Required if Delta T Hot 
Condition Monitor is enabled]

Delta T Hot Limits: Increasing 
Limit

Delta T Hot Increasing Limit. Enabled 
only if Delta T Hot Condition Monitor is 
enabled. [Required if Delta T Hot 
Condition Monitor is enabled]

Delta T Hot Limits: Declining 
Limit

Delta T Hot Declining Limit. Enabled 
only if Delta T Hot Condition Monitor is 
enabled. [Required if Delta T Hot 
Condition Monitor is enabled]. 
Configurable only if Is Hot Side 
Condensing is NO.
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Delta T Hot Limits: Low Limit Delta T Hot Low Limit. Enabled only if 
Delta T Hot Condition Monitor is 
enabled. [Required if Delta T Hot 
Condition Monitor is enabled] 
Configurable only if Is Hot Side 
Condensing is NO.

Delta T Cold Limits: High Limit Delta T Cold High Limit. Enabled only 
if Delta T Cold Condition Monitor is 
enabled. [Required if Delta T Cold 
Condition Monitor is enabled]

Delta T Cold Limits: Increasing 
Limit

Delta T Cold Increasing Limit. Enabled 
only if Delta T Cold Condition Monitor 
is enabled. [Required if Delta T Cold 
Condition Monitor is enabled]

Value greater than 0

Delta T Cold Limits: Declining 
Limit

Delta T Cold Declining Limit. Enabled 
only if Delta T Cold Condition Monitor 
is enabled. [Required if Delta T Cold 
Condition Monitor is enabled]. 
Configurable only if Is Cold Side 
Evaporating is NO.

Delta T Cold Limits: Low Limit Delta T Cold Low Limit. Enabled only if 
Delta T Cold Condition Monitor is 
enabled. [Required if Delta T Cold 
Condition Monitor is enabled]. 
Configurable only if Is Cold Side 
Evaporating is NO.

Table 42. Step-7 Tab of HXAM-ST Configuration Faceplate (Continued)

Element Description Expected Value
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Step-8 Tab

The Step-8 tab is the view of Configuration_Step8_FE. Figure 117 shows the view 
of the Step-8 tab and Table 43 lists and describes the elements in the Step-8 tab of 
the Configuration Faceplate. 

 

TC08456A

Figure 117. Step-8 Tab of HXAM-ST Configuration Faceplate
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Table 43. Step-8 Tab of HXAM-ST Configuration Faceplate 

Element Description Expected Value

Delta P Hot Limits: High 
Limit

Delta P Hot High Limit. Enabled only if 
Delta P Hot Condition Monitor is 
enabled. [Required if Delta P Hot 
Condition Monitor is enabled]

Value greater than 0

Delta P Hot Limits: 
Increasing Limit

Delta P Hot Increasing Limit. Enabled 
only if Delta P Hot Condition Monitor is 
enabled. [Required if Delta P Hot 
Condition Monitor is enabled]

Delta P Hot Limits: 
Declining Limit

Delta P Hot Declining Limit. Enabled 
only if Delta P Hot Condition Monitor is 
enabled. [Required if Delta P Hot 
Condition Monitor is enabled]

Delta P Hot Limits: Low 
Limit

Delta P Hot Low Limit. Enabled only if 
Delta P Hot Condition Monitor is 
enabled. [Required if Delta P Hot 
Condition Monitor is enabled]

Delta P Cold Limits: High 
Limit

Delta P Cold High Limit. Enabled only if 
Delta P Cold Condition Monitor is 
enabled. [Required if Delta P Cold 
Condition Monitor is enabled]

Delta P Cold Limits: 
Increasing Limit

Delta P Cold Increasing Limit. Enabled 
only if Delta P Cold Condition Monitor 
is enabled. [Required if Delta P Cold 
Condition Monitor is enabled]

Delta P Cold Limits: 
Declining Limit

Delta P Cold Declining Limit. Enabled 
only if Delta P Cold Condition Monitor 
is enabled. [Required if Delta P Cold 
Condition Monitor is enabled]

Delta P Cold Limits: Low 
Limit

Delta P Cold Low Limit. Enabled only if 
Delta P Cold Condition Monitor is 
enabled. [Required if Delta P Cold 
Condition Monitor is enabled]
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Step-9 Tab

The Step-9 tab is the view of Configuration_Step9_FE. Figure 118 shows the view 
of the Step-9 tab and Table 44 lists and describes the elements in the Step-9 tab of 
the Configuration Faceplate.  

TC08457A

Figure 118. Step-9 Tab of HXAM-ST Configuration Faceplate

Table 44. Step-9 Tab of HXAM-ST Configuration Faceplate 

Element Description Expected Value

Delta W Hot Limits: High Limit Delta W Hot High Limit. Enabled only 
if Delta W Hot Condition Monitor is 
enabled. [Required if Delta W Hot 
Condition Monitor is enabled]

Value greater than 0
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Delta W Hot Limits: Increasing 
Limit

Delta W Hot Increasing Limit. 
Enabled only if Delta W Hot 
Condition Monitor is enabled. 
[Required if Delta W Hot Condition 
Monitor is enabled]

Value greater than 0

Delta W Hot Limits: Declining 
Limit

Delta W Hot Declining Limit. Enabled 
only if Delta W Hot Condition Monitor 
is enabled. [Required if Delta W Hot 
Condition Monitor is enabled]

Delta W Hot Limits: Low Limit Delta W Hot Low Limit. Enabled only 
if Delta W Hot Condition Monitor is 
enabled. [Required if Delta W Hot 
Condition Monitor is enabled]

Delta W Cold Limits: High Limit Delta W Cold High Limit. Enabled 
only if Delta W Cold Condition 
Monitor is enabled. [Required if Delta 
W Cold Condition Monitor is enabled]

Delta W Cold Limits: Increasing 
Limit

Delta W Cold Increasing Limit. 
Enabled only if Delta W Cold 
Condition Monitor is enabled. 
[Required if Delta W Cold Condition 
Monitor is enabled]

Delta W Cold Limits: Declining 
Limit

Delta W Cold Declining Limit. 
Enabled only if Delta W Cold 
Condition Monitor is enabled. 
[Required if Delta W Cold Condition 
Monitor is enabled]

Delta W Cold Limits: Low Limit Delta W Cold Low Limit. Enabled 
only if Delta W Cold Condition 
Monitor is enabled. [Required if Delta 
W Cold Condition Monitor is enabled]

Table 44. Step-9 Tab of HXAM-ST Configuration Faceplate (Continued)

Element Description Expected Value
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Step-10 Tab

The Step-10 tab is the view of Configuration_Step10_FE. Figure 119 shows the 
view of the Step-10 tab and Table 44 lists and describes the elements in the Step-9 
tab of the Configuration Faceplate. 

TC08458A

Figure 119. Step-10 Tab of HXAM-ST Configuration Faceplate
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Step-11 Tab

The Step-11 tab is the view of Configuration_Step10_FE. Figure 120 shows the 
view of the Step-11 tab and Table 46 lists and describes the elements in the Step-11 
tab of the Configuration Faceplate.  

Table 45. Step-10 Tab of HXAM-ST Configuration Faceplate 

Element Description Expected Value

HD Hot Limits: High Limit HD Hot High Limit. Enabled only if HD Hot 
Condition Monitor is enabled. [Required if 
HD Hot Condition Monitor is enabled]

Value greater than 0

HD Hot Limits: Low Limit HD Hot Low Limit. Enabled only if HD Hot 
Condition Monitor is enabled. [Required if 
HD Hot Condition Monitor is enabled]

HD Cold Limits: High Limit HD Cold High Limit. Enabled only if HD Cold 
Condition Monitor is enabled. [Required if 
HD Cold Condition Monitor is enabled]

Value greater than 0

HD Cold Limits: Low Limit HD Cold Low Limit. Enabled only if HD Cold 
Condition Monitor is enabled. [Required if 
HD Cold Condition Monitor is enabled]

Delta HD Limits: High 
Limit

Delta HD High Limit. Enabled only if Delta 
HD Condition Monitor is enabled. [Required 
if Delta HD Condition Monitor is enabled]
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Figure 120. Step-11 Tab of HXAM-ST Configuration Faceplate
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Table 46. Step-11 Tab of HXAM-ST Configuration Faceplate 

Element Description Expected Value

Shell Side Flow: Low Limit Shell Side Flow Hot High Limit. Enabled only if 
Shell Side Flow Condition Monitor is enabled. 
[Required if Shell Side Flow Condition Monitor 
is enabled]

Value greater than 0

Limit Approach 
Temperature: Low Limit

Limit Approach Temperature Low Limit. 
Enabled only if Limit Approach Temperature 
Condition Monitor is enabled. [Required if Limit 
Approach Temperature Condition Monitor is 
enabled]

Tube Velocity: High Limit Tube Velocity High Limit. Enabled only if Tube 
Velocity Condition Monitor is enabled. 
[Required if Tube Velocity Condition Monitor is 
enabled]

Tube Velocity: Low Limit Tube Velocity Low Limit. Enabled only if Tube 
Velocity Condition Monitor is enabled. 
[Required if Tube Velocity Condition Monitor is 
enabled]

Tube Velocity: Unit of 
Tube Velocity

Unit of Tube Velocity. Enabled only if Tube 
Velocity Condition Monitor is enabled. 
[Required if Tube Velocity Condition Monitor is 
enabled]

Select one from 
drop-down list box
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HXAM_ST Trend Display Aspect

The Object Name field of the Trend Display aspect must refer. If it does not:

1. Click on the field and the Select Object dialog appears as shown in 
Figure 121. 

Figure 121. Select Object Dialog

TC08460A

 

2. Select the desired object and click OK.

3. The Aspect field, Property, and Log Name fields should be filled in as a 
result. From the drop-down list box in the Aspect field, choose 
HXAM_ST_Logging_GP.

4. Once the aspect is selected, choose any property from the drop-down list box 
of the Property field. The properties shown here are the only properties 
available for trending

5. Choose SEAMLESS from the drop-down list box in the Log Name field.

6. Configure the Low Range and High Range to the desired values. The Low 
range is the lowest Y-axis value of the trace. This can be changed by typing 



Configuring HXAM_ST Asset Parameters Section 6  Heat Exchanger Asset Monitor (HXAM)

266 3BUA000118-510 G

another value and pressing Enter or by using the arrows. Similarly, the High 
Range is the highest Y-axis value of the trace.

Configuring HXAM_ST Asset Parameters

Macros used in HXAM_ST aspect to configure the Asset Parameter values are 
shown in Table 47. These macros SHOULD NOT be changed. 

Table 47. Macros Used in HXAM_ST Aspect to Configure Asset Parameter Values 

Asset Parameter Name Asset Parameter Value

E_Improvement_Level %:Configuration_Values:E_Improve%

E_Significant_Improvement_Level %:Configuration_Values:E_Significant_Improve%

E_Decline_Level %:Configuration_Values:E_Decline%

E_Significant_Decline_Level %:Configuration_Values:E_Significant_Decline%

U_Improvement_Level %:Configuration_Values:U_Improve%

U_Significant_Improvement_Level %:Configuration_Values:U_Significant_Improve%

U_Decline_Level %:Configuration_Values:U_Decline%

U_Significant_Decline_Level %:Configuration_Values:U_Significant_Decline%

Asset_Monitor_Sampling_Interval %:Configuration_Values:Asset_Monitor_Sampling_Interval%

Delta_BOPS %:Configuration_Values:Delta_BOPS%

Hot_Side_Condensing %:Configuration_Values:Is_Hot_Side_Condensing%

Cold_Side_Evaporating %:Configuration_Values:Is_Cold_Side_Evaporating%

Normal_Service_Interval_In_Hrs %:Configuration_Values:Normal_Service_Interval%

Number_Of_Baseline_Sets %:Configuration_Values:Number_Baseline_Sets%

Inhibit_Value %:Configuration_Values:Inhibit%

Inhibit_Value_Mask_Hex 0xFFFFFFFF

Enable_Logging_Data %:Configuration_Values:Enable_Logging_Data%

Number_Of_Shells %:Configuration_Values:Number_Of_Shells%
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Shell_Side_Flow_Type %:Configuration_Values:Shell_Side_Flow_Type%

Mass_Flow_Hot_Available %:Configuration_Values:Mass_Flow_Hot_Available%

Volume_Flow_Hot_Available %:Configuration_Values:Volume_Flow_Hot_Available%

Mass_Flow_Cold_Available %:Configuration_Values:Mass_Flow_Cold_Available%

Volume_Flow_Cold_Available %:Configuration_Values:Volume_Flow_Cold_Available%

Delta_P_Hot_Available %:Configuration_Values:Delta_P_Hot_Available%

Delta_P_Hot_Alternative_Available %:Configuration_Values:Delta_P_Hot_Alternative_Available
%

Delta_P_Cold_Available %:Configuration_Values:Delta_P_Cold_Available%

Delta_P_Cold_Alternative_Available %:Configuration_Values:Delta_P_Cold_Alternative_Available
%

Flow_Type %:Configuration_Values:Flow_Type%

Total_Tube_Surface_Area %:Configuration_Values:Tube_Surface_Area%

Total_Tube_CrossSectional_Area %:Configuration_Values:Tube_CrossSectional_Area%

LMTD_Correction_Factor %:Configuration_Values:LMTD_Corr_Factor%

Design_Heat_Transfer_Value %:Configuration_Values:Design_Heat_Transfer_Value%

Unit_Of_Temperature %:Configuration_Values:Unit_Of_Temperature%

Unit_Of_Mass_Flow %:Configuration_Values:Unit_Of_MassFlow%

Unit_Of_Volume_Flow %:Configuration_Values:Unit_Of_VolumeFlow%

Unit_Of_Density %:Configuration_Values:Unit_Of_Density%

Unit_Of_Specific_Heat %:Configuration_Values:Unit_Of_Specific_Heat%

Unit_Of_Heat_Duty %:Configuration_Values:Unit_Of_HeatDuty%

Unit_Of_Heat_Transfer_Efficiency %:Configuration_Values:Unit_Of_Heat_Transfer_Efficiency%

Unit_Of_Tube_Velocity %:Configuration_Values:Unit_Of_Tube_Velocity%

Table 47. Macros Used in HXAM_ST Aspect to Configure Asset Parameter Values (Continued)

Asset Parameter Name Asset Parameter Value
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Unit_of_Tube_Area %:Configuration_Values:Unit_Of_Tube_Area%

Specific_Heat_Hot_Fluid %:Configuration_Values:Specific_Heat_Hot%

Specific_Heat_Cold_Fluid %:Configuration_Values:Specific_Heat_Cold%

Density_Hot_Fluid %:Configuration_Values:Density_Hot%

Density_Cold_Fluid %:Configuration_Values:Density_Cold%

Heat_Of_Vaporization_Hot_Side %:Configuration_Values:Heat_Of_Vaporization_Hot%

Heat_Of_Vaporization_Cold_Side %:Configuration_Values:Heat_Of_Vaporization_Cold%

Enable_Delta_Tx_AM %:Configuration_Values:Enable_Delta_Tx_AM%

Delta_Tx_Increasing %:Configuration_Values:Delta_Tx_Increasing%

Delta_Tx_Declining %:Configuration_Values:Delta_Tx_Declining%

Delta_Tx_Low %:Configuration_Values:Delta_Tx_Low%

Delta_Tx_High %:Configuration_Values:Delta_Tx_High%

Enable_Delta_T_Hot_AM %:Configuration_Values:Enable_Delta_T_Hot_AM%

Delta_T_Hot_High %:Configuration_Values:Delta_T_Hot_High%

Delta_T_Hot_Increasing %:Configuration_Values:Delta_T_Hot_Increasing%

Delta_T_Hot_Declining %:Configuration_Values:Delta_T_Hot_Declining%

Delta_T_Hot_Low %:Configuration_Values:Delta_T_Hot_Low%

Enable_Delta_T_Cold_AM %:Configuration_Values:Enable_Delta_T_Cold_AM%

Delta_T_Cold_High %:Configuration_Values:Delta_T_Cold_High%

Delta_T_Cold_Increasing %:Configuration_Values:Delta_T_Cold_Increasing%

Delta_T_Cold_Declining %:Configuration_Values:Delta_T_Cold_Declining%

Delta_T_Cold_Low %:Configuration_Values:Delta_T_Cold_Low%

Enable_Delta_P_Hot_AM %:Configuration_Values:Enable_Delta_P_Hot_AM%

Table 47. Macros Used in HXAM_ST Aspect to Configure Asset Parameter Values (Continued)

Asset Parameter Name Asset Parameter Value
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Delta_P_Hot_High %:Configuration_Values:Delta_P_Hot_High%

Delta_P_Hot_Increasing %:Configuration_Values:Delta_P_Hot_Increasing%

Delta_P_Hot_Declining %:Configuration_Values:Delta_P_Hot_Declining%

Delta_P_Hot_Low %:Configuration_Values:Delta_P_Hot_Low%

Enable_Delta_P_Cold_AM %:Configuration_Values:Enable_Delta_P_Cold_AM%

Delta_P_Cold_High %:Configuration_Values:Delta_P_Cold_High%

Delta_P_Cold_Increasing %:Configuration_Values:Delta_P_Cold_Increasing%

Delta_P_Cold_Declining %:Configuration_Values:Delta_P_Cold_Declining%

Delta_P_Cold_Low %:Configuration_Values:Delta_P_Cold_Low%

Enable_W_Hot_AM %:Configuration_Values:Enable_W_Hot_AM%

W_Hot_High %:Configuration_Values:W_Hot_High%

W_Hot_Increasing %:Configuration_Values:W_Hot_Increasing%

W_Hot_Declining %:Configuration_Values:W_Hot_Declining%

W_Hot_Low %:Configuration_Values:W_Hot_Low%

Enable_W_Cold_AM %:Configuration_Values:Enable_W_Cold_AM%

W_Cold_High %:Configuration_Values:W_Cold_High%

W_Cold_Increasing %:Configuration_Values:W_Cold_Increasing%

W_Cold_Declining %:Configuration_Values:W_Cold_Declining%

W_Cold_Low %:Configuration_Values:W_Cold_Low%

Enable_HD_Hot_AM %:Configuration_Values:Enable_HD_Hot_AM%

HD_Hot_High_Limit %:Configuration_Values:HD_Hot_High%

HD_Hot_Low_Limit %:Configuration_Values:HD_Hot_Low%

Enable_HD_Cold_AM %:Configuration_Values:Enable_HD_Cold_AM%

Table 47. Macros Used in HXAM_ST Aspect to Configure Asset Parameter Values (Continued)

Asset Parameter Name Asset Parameter Value
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Configuration of Asset Parameters uses an intermediate Configuration_Values 
aspect which is a General Properties aspect. The macros used in the HXAM_ST 
Aspect/Asset Parameters/Values reads the property of the corresponding Asset 
Parameter from its corresponding variable in the Configuration_Values aspect. 

There are two ways to configure Asset Parameters:

1. Write the values of the Asset Parameters in the Configuration_Values aspect 
against its corresponding variable. [Not Recommended].

2. Use the HXAM-ST Configuration Faceplate that is a Graphical User Interface 
to assign values for the Asset Parameters. Any configuration done in the 
HXAM-ST Configuration Faceplate gets automatically written to the 
Configuration_Values aspect, from where the Asset Parameters reads its value. 
[Recommended].

HD_Cold_High_Limit %:Configuration_Values:HD_Cold_High%

HD_Cold_Low_Limit %:Configuration_Values:HD_Cold_Low%

Enable_Delta_HD_AM %:Configuration_Values:Enable_Delta_HD_AM%

Delta_HD_High_Limit %:Configuration_Values:Delta_HD_High%

Enable_Tube_Velocity_AM %:Configuration_Values:Enable_Tube_Velocity_AM%

Tube_Velocity_High_Limit %:Configuration_Values:Tube_Velocity_High%

Tube_Velocity_Low_Limit %:Configuration_Values:Tube_Velocity_Low%

Enable_LAT_AM %:Configuration_Values:Enable_LAT_AM%

LAT_Low_Limit %:Configuration_Values:LAT_Low%

Enable_Shell_Side_Flow_AM %:Configuration_Values:Enable_Shell_Side_Flow_AM%

Shell_Side_Flow_Low_Limit %:Configuration_Values:Shell_Side_Flow_Low%

Enable_Thermal_CrossOver_ 
Detection_AM

%:Configuration_Values:Enable_TCOD_AM%

Table 47. Macros Used in HXAM_ST Aspect to Configure Asset Parameter Values (Continued)

Asset Parameter Name Asset Parameter Value
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Table 48 shows the description and expected values of all the Asset Parameters and 
Table 49 shows the corresponding variables in Configuration_Values aspects and 
the HXAM-ST Configuration Faceplate for every Asset Parameter.   

Do not change the macros used in the Asset Parameters tab in the HXAM_ST 
aspect. Do not change anything in the Configuration_Values aspect. The 
read/write permissions for all properties in the Configuration_Values aspect is set 
to YES and the names and data type of the properties are shown in Table 49.

Table 48. Description and Expected Asset Parameter Values 

Parameter Name Description Expected Value

E_Improvement_Level Improvement in Performance 
Factor in % [Required]

Value greater than 0 
Default Value: 2

E_Significant_Improvement_Level Significant Improvement in 
Performance Factor in % 
[Required]

Value greater than 0 
Default Value: 5

E_Decline_Level Decline in Performance Factor 
in % [Required]

Value greater than 0 
Default Value: 2

E_Significant_Decline_Level Significant Decline in 
Performance Factor in % 
[Required]

Value greater than 0 
Default Value: 5

U_Improvement_Level Improvement in Heat Transfer 
Efficiency in % [Required]

Value greater than 0 
Default Value: 2

U_Significant_Improvement_Level Significant Improvement in 
Heat Transfer Efficiency in % 
[Required]

Value greater than 0 
Default Value: 5

U_Decline_Level Decline in Heat Transfer 
Efficiency in % [Required]

Value greater than 0 
Default Value: 2

U_Significant_Decline_Level Significant Decline in Heat 
Transfer Efficiency in % 
[Required]

Value greater than 0 
Default Value: 5

Asset_Monitor_Sampling_Interval Time interval between 
Monitoring [Required]

Any Integer greater than 
0. Recommended 
values given in Table 33.
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Delta_BOPS Acceptable percentage 
difference between COPS and 
BOPS to consider COPS as a 
new set of BOPS [Required]

Value greater than 0 
Default Value: 5

Normal_Service_Interval_In_Hrs Time interval between heat 
exchanger cleaning, rebuilds, 
etc. in hours [Required]

Value greater than 0

Number_Of_Baseline_Sets Number of BOPS expected 
[Required]

Minimum Integer value 
of 1 and no more than 5

Enable_Logging_Data Set to True/Yes if the Operating 
Point Set needs to be logged 
into a file [Required]

TRUE, FALSE, YES, 
NO

Flow_Type Flow Type through the heat 
exchanger [Required]

CO-CURRENT, 
COUNTER-CURRENT

Number_Of_Shells Number of Shells used 
[Required]

Minimum Integer value 
of 1 and no more than 5

Shell_Side_Flow_Type Flow at shell Side [Required] HOT, COLD

Total_Tube_Surface_Area Total Surface Area of Tube 
[Required]

Value greater than 0

Total_Tube_CrossSectional_Area Total Cross Sectional Area of 
Tube [Required]

LMTD_Correction_Factor Log Mean Temperature 
Difference Correction Factor. 
[Optional]

Value greater than 0 
Default Value: 1

Design_Heat_Transfer_Value Design Heat Transfer Efficiency 
[Optional]

Value greater than 0. 

Hot_Side_Condensing Set to True/Yes if Hot side Flow 
is getting Condensed. 
[Required]

TRUE, FALSE, YES, 
NO

Table 48. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Cold_Side_Evaporating Set to True/Yes if Cold Side is 
getting Evaporated [Required]

TRUE, FALSE, YES, 
NO

Mass_Flow_Hot_Available Set to True/Yes if Mass Flow 
for Hot side is available 
[Required if Volume Flow for 
Hot side is not available]

Mass_Flow_Cold_Available Set to True/Yes if Mass Flow 
for Cold side is available 
[Required if Volume Flow for 
Cold side is not available]

Volume_Flow_Hot_Available Set to True/Yes if Volume Flow 
for Hot side is available 
[Required if Mass Flow for Hot 
side is not available or if Hot 
side flows through the tube and 
Tube Velocity Condition 
Monitor is enabled]

Volume_Flow_Cold_Available Set to True/Yes if Volume Flow 
for Cold side is available 
[Required if Mass Flow for Cold 
side is not available or if Cold 
side flows through the tube and 
Tube Velocity Condition 
Monitor is enabled]

Density_Hot_Fluid Density for Hot side. [Required 
if Mass Flow for Hot side is not 
available or if Tube Velocity 
condition Monitor is enabled 
and Volume Flow for this side is 
not available]

Value greater than 0.

Table 48. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Density_Cold_Fluid Density for Cold side. [Required 
if Mass Flow for Cold side is not 
available or if Tube Velocity 
condition Monitor is enabled 
and Volume Flow for this side is 
not available]

Value greater than 0.

Delta_P_Hot_Available Set to True if Pressure 
Difference for Hot side is 
available [Required if 
Alternative to calculate 
Pressure Difference for hot side 
is not available]

TRUE, FALSE, YES, 
NO

Delta_P_Hot_Alternative_Available Set to True if Alternative to 
calculate Pressure Difference 
for Hot side is available 
[Required if Pressure 
Difference for hot side is not 
available]

Delta_P_Cold_Available Set to True if Pressure 
Difference for Cold side is 
available [Required if 
Alternative to calculate 
Pressure Difference for cold 
side is not available]

Delta_P_Cold_Alternative_Available Set to True if Alternative to 
calculate Pressure Difference 
for Cold side is available 
[Required if Pressure 
Difference for cold side is not 
available]

Specific_Heat_Hot_Fluid Specific Heat of Hot Side fluid 
[Required]

Value greater than 0

Table 48. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Specific_Heat_Cold_Fluid Specific Heat of Cold Side fluid 
[Required]

Value greater than 0

Unit_Of_Temperature Unit of Temperature [Required] DEG-K 
DEG-C 
DEG-F

DEG-R

Unit_Of_Heat_Transfer_Efficiency Unit of Heat Transfer Efficiency 
[Required]

BTU/HR.SQ-FT 
KCAL/HR.SQ-M 
KCAL/S.SQ-M 
W/SQ-M 
MW/SQ-M

Unit_of_Tube_Area Unit of Area [Required] SQ-M 
SQ-FT 
SQ-INCH 
SQ-CM

Unit_Of_Tube_Velocity Unit of Velocity [Required if 
Tube Velocity Condition 
Monitor is Enabled]

M/S 
KM/S 
FT/S 
MILES/S

Unit_Of_Mass_Flow Unit of Mass flow [Required] LB/DAY 
LB/HR 
LB/MIN 
LB/S 
KG/DAY 
KG/HR 
KG/MIN 
KG/S 
KLB/DAY 
KLB/HR 
TONNE/HR

Table 48. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Unit_Of_Heat_Duty Unit of Heat Duty [Required] KCAL/S 
KCAL/HR 
BTU/S 
BTU/HR 
W 
MW

Unit_Of_Volume_Flow Unit of Volume Flow [Required 
if Volume Flow for any side is 
available]

CU.FT/DAY 
CU.FT/HR 
CU.FT/MIN 
CU.FT/S 
L/DAY 
L/HR 
L/MIN 
US GAL/DAY 
US GAL/HR 
US GAL/MIN 
US GAL/S 
CU.M/DAY 
CU.M/HR 
CU.M/MIN 
CU.M/S

Unit_Of_Density Unit of Density. [Required if any 
Densities are provided]

LB/CU.FT 
LB/US GAL 
KG/CU.M 
G/L 
G/CU.CM

Unit_Of_Specific_Heat Unit of Specific Heat. 
[Required]

BTU/LB.DEG-F 
KJ/KG.DEG-K 
KCAL/KG.DEG-K 
J/G.DEG-C

Table 48. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Unit_Of_Heat_Duty Unit of Heat Duty [Required] KCAL/S 
KCAL/HR 
BTU/S 
BTU/HR 
W 
MW

Inhibit_Value Any string value can be entered 
for inhibit. When the Input 
Record Inhibit equals the value 
entered, the Asset Monitor gets 
disabled.

 Any string value except 
True/False

Enable_Delta_Tx_AM Set to True if Delta_Tx AM is 
Enabled [Optional]

TRUE, FALSE

Delta_Tx_Increasing Delta_Tx Increasing Limit 
[Required if Delta_Tx AM 
Enabled]

Value greater than 0

Delta_Tx_Declining Delta_Tx Declining Limit 
[Required if Delta_Tx AM 
Enabled]

Delta_Tx_Low Delta_Tx Low Limit [Required if 
Delta_Tx AM Enabled]

Delta_Tx_High Delta_Tx High Limit [Required if 
Delta_Tx AM Enabled]

Heat_Of_Vaporization_Hot_Side Hot side Heat of Vaporization. 
[Required if Hot side 
Condensing]

Heat_Of_Vaporization_Cold_Side Cold side Heat of Vaporization. 
[Required if Cold Side 
Evaporating]

Table 48. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Enable_Delta_T_Hot_AM Set to True if Hot Side 
Temperature Difference AM 
Enabled [Optional] 

TRUE, FALSE

Delta_T_Hot_High Delta_T_Hot High Limit 
[Required if Delta_T_Hot AM 
Enabled]

Value greater than 0

Delta_T_Hot_Increasing Delta_T_Hot Increasing Limit 
[Required if Delta_T_Hot AM 
Enabled]

Delta_T_Hot_Declining Delta_T_Hot Declining Limit 
[Required if Delta_T_Hot AM 
Enabled]

Delta_T_Hot_Low Delta_T_Hot Low Limit 
[Required if Delta_T_Hot AM 
Enabled]

Enable_Delta_T_Cold_AM Set to True if Cold Side 
Temperature Difference AM is 
Enabled [Optional]

TRUE, FALSE

Delta_T_Cold_High Delta_T_Cold High Limit 
[Required if Delta_T_Cold AM 
Enabled]

Value greater than 0

Delta_T_Cold_Increasing Delta_T_Cold Increasing Limit 
[Required if Delta_T_Cold AM 
Enabled]

Delta_T_Cold_Declining Delta_T_Cold Declining Limit 
[Required if Delta_T_Cold AM 
Enabled]

Delta_T_Cold_Low Delta_T_Cold Low Limit 
[Required if Delta_T_Cold AM 
Enabled]

Table 48. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Enable_Delta_P_Hot_AM Set to True if Hot Side Pressure 
Difference AM is Enabled 
[Optional]

TRUE, FALSE

Delta_P_Hot_High Delta_P_Hot High Limit 
[Required if Delta_P_Hot AM 
Enabled]

Value greater than 0

Delta_P_Hot_Increasing Delta_P_Hot Increasing Limit 
[Required if Delta_P_Hot AM 
Enabled]

Delta_P_Hot_Declining Delta_P_Hot Declining Limit 
[Required if Delta_P_Hot AM 
Enabled]

Delta_P_Hot_Low Delta_P_Hot Low Limit 
[Required if Delta_P_Hot AM 
Enabled]

Enable_Delta_P_Cold_AM Set to True if Cold Side 
Pressure Difference AM is 
Enabled [Optional]

TRUE, FALSE

Delta_P_Cold_High Delta_P_Cold High Limit 
[Required if Delta_P_Cold AM 
Enabled]

Value greater than 0

Delta_P_Cold_Low Delta_P_Cold Low Limit 
[Required if Delta_P_Cold 
AM Enabled]

Delta_P_Cold_Increasing Delta_P_Cold Increasing Limit 
[Required if Delta_P_Cold AM 
Enabled]

Delta_P_Cold_Declining Delta_P_Cold Declining Limit 
[Required if Delta_P_Cold AM 
Enabled]

Table 48. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Enable_W_Hot_AM Set to True if Hot Side Mass 
Flow AM is Enabled [Optional]

TRUE, FALSE

W_Hot_High Hot Side Mass Flow High Limit 
[Required if W_Hot AM 
Enabled]

Value greater than 0

W_Hot_Increasing Hot Side Mass Flow Increasing 
Limit [Required if W_Hot AM 
Enabled]

W_Hot_Declining Hot Side Mass Flow Declining 
Limit [Required if W_Hot AM 
Enabled]

W_Hot_Low Hot Side Mass Flow Low Limit 
[Required if W_Hot AM 
Enabled]

Enable_W_Cold_AM Set to True if Cold Side Mass 
Flow AM is Enabled [Optional]

TRUE, FALSE

W_Cold_High Cold Side Mass Flow High Limit 
[Required if W_Cold AM 
Enabled]

Value greater than 0

W_Cold_Increasing Cold Side Mass Flow 
Increasing Limit [Required if 
W_Cold AM Enabled]

W_Cold_Declining Cold Side Mass Flow Declining 
Limit [Required if W_Cold AM 
Enabled]

W_Cold_Low Cold Side Mass Flow Low Limit 
[Required if W_Cold AM 
Enabled]

Enable_HD_Hot_AM Set to True if Hot Side Heat 
Duty AM is Enabled [Optional]

TRUE, FALSE

Table 48. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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HD_Hot_High_Limit Hot Side Heat Duty High Limit 
[Required if HD_Hot AM 
Enabled]

Value greater than 0

HD_Hot_Low_Limit Hot Side Heat Duty Low Limit 
[Required if HD_Hot AM 
Enabled]

Enable_HD_Cold_AM Set to True if Cold Side Heat 
Duty AM is Enabled [Optional]

TRUE, FALSE

HD_Cold_High_Limit Cold Side Heat Duty High Limit 
[Required if HD_Cold AM 
Enabled]

Value greater than 0

HD_Cold_Low_Limit Cold Side Heat Duty Low Limit 
[Required if HD_Cold AM 
Enabled]

Enable_Delta_HD_AM Set to True if Heat Duty 
Difference AM is Enabled 
[Optional]

TRUE, FALSE

Delta_HD_High_Limit Heat Duty Difference High Limit 
[Required if Delta_HD AM 
Enabled]

Value greater than 0

Enable_Tube_Velocity_AM Set to True if Tube Velocity AM 
is Enabled [Optional]

TRUE, FALSE

Tube_Velocity_High_Limit Tube Velocity High Limit 
[Required if Tube Velocity AM 
Enabled]

Value greater than 0

Tube_Velocity_Low_Limit Tube Velocity Low Limit 
[Required if Tube Velocity AM 
Enabled]

Table 48. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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Enable_LAT_AM Set to True if Limit Approach 
Temperature AM is Enabled 
[Optional]

TRUE, FALSE

LAT_Low_Limit Limit Approach Temperature 
Low Limit [Required if LAT AM 
Enabled]

Value greater than 0

Enable_Shell_Side_Flow_AM Set to True if Shell Side Flow 
AM is Enabled [Optional]

TRUE, FALSE

Shell_Side_Flow_Low_Limit Shell Side Flow Low Limit. The 
limit will be for Mass flow if 
Mass flow is available else the 
limit will be for Volume Flow. 
[Required if Shell Side Flow AM 
Enabled] 

Value greater than 0

Enable_Thermal_CrossOver_ 
Detection_AM

Set to True if Thermal 
Crossover Detection AM is 
Enabled [Optional]

TRUE, FALSE

Table 49. Configuration_Values Aspect and HXAM-ST Configuration Faceplate Values 

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-ST Configuration 

Faceplate

E_Improvement_Level E_Improve (Float) Performance Factor: 
Improvement Level [Step-2]

E_Significant_Improvement_Level E_Significant_Improve 
(Float)

Performance Factor: 
Significant Improvement Level 
[Step-2]

E_Decline_Level E_Decline (Float) Performance Factor: Declining 
Level [Step-2]

Table 48. Description and Expected Asset Parameter Values (Continued)

Parameter Name Description Expected Value
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E_Significant_Decline_Level E_Significant_Decline (Float) Performance Factor: 
Significant Declining Level 
[Step-2]

U_Improvement_Level U_Improve (Float) Heat Transfer Efficiency: 
Improvement Level [Step-2]

U_Significant_Improvement_Level U_Significant_Improve 
(Float)

Heat Transfer Efficiency: 
Significant Improvement Level 
[Step-2]

U_Decline_Level U_Decline (Float) Heat Transfer Efficiency: 
Declining Level [Step-2]

U_Significant_Decline_Level U_Significant_Decline (Float) Heat Transfer Efficiency: 
Significant Declining Level 
[Step-2]

Asset_Monitor_Sampling_Interval Asset_Monitor_Sampling_Int
erval (Integer)

Monitoring Interval [Step-1]

Delta_BOPS Delta_BOPS (Float) Delta BOPS [Step-1]

Hot_Side_Condensing Is_Hot_Side_Condensing 
(String)

Is Hot Side Condensing? 
[Step-1]

Cold_Side_Evaporating Is_Cold_Side_Evaporating 
(String)

Is Cold Side Evaporating? 
[Step-1]

Normal_Service_Interval_In_Hrs Normal_Service_Interval 
(Float)

Normal Service Interval 
[Step-1]

Number_Of_Baseline_Sets Number_Baseline_Sets 
(Integer)

No: of Baseline Sets [Step-1]

Inhibit_Value Inhibit (String) Inhibit [Step-1]

Table 49. Configuration_Values Aspect and HXAM-ST Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-ST Configuration 

Faceplate
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Enable_Logging_Data Enable_Logging_Data 
(String)

Enable Logging of Data? 
[Step-1]

Number_Of_Shells Number_Of_Shells (Integer) Number of Shells [Step-1]

Shell_Side_Flow_Type Shell_Side_Flow_Type 
(String)

Shell Side Flow [Step-1]

Mass_Flow_Hot_Available Mass_Flow_Hot_Available 
(String)

Hot Side: Is Mass Flow 
Available? [Step-3]

Volume_Flow_Hot_Available Volume_Flow_Hot_Available 

(String)

Hot Side: Is Volume Flow 
Available? [Step-3]

Mass_Flow_Cold_Available  Mass_Flow_Cold_Available 
(String)

Cold Side: Is Mass Flow 
Available? [Step-3]

Volume_Flow_Cold_Available  
Volume_Flow_Cold_Availabl
e

(String)

Cold Side: Is Volume Flow 
Available? [Step-3]

Delta_P_Hot_Available  Delta_P_Hot_Available 
(String)

Hot Side: Is Pressure 
Difference Available? [Step-4]

Delta_P_Hot_Alternative_ 
Available

Delta_P_Hot_Alternative_ 
Available (String)

 Hot Side: Is Pressure In and 
Out Available? [Step-4]

Delta_P_Cold_Available Delta_P_Cold_Available 
(String)

Cold Side: Is Pressure 
Difference Available? [Step-4]

Asset Parameter Name Corresponding Variable 
Name in 
Configuration_Values Aspect 
along with Data Type

Corresponding Variable in 
Configuration_Faceplate 
Aspect

Table 49. Configuration_Values Aspect and HXAM-ST Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-ST Configuration 

Faceplate
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Delta_P_Cold_Alternative_ 
Available

Delta_P_Cold_Alternative_A
vailable

(String)

Cold Side: Is Pressure In and 
Out Available? [Step-4]

Flow_Type Flow_Type (String) Flow Type [Step-1]

Total_Tube_Surface_Area Tube_Surface_Area (Float) Total Tube Surface Area 
[Step-1]

Total_Tube_CrossSectional_Area Tube_CrossSectional_Area 
(Float)

Total Tube C/S Area [Step-1]

LMTD_Correction_Factor LMTD_Corr_Factor (Float) LMTD Corr. Factor [Step-1]

Design_Heat_Transfer_Value Design_Heat_Transfer_Valu
e (Float)

Dsgn Heat Transfer Value 
[Step-1]

Unit_Of_Temperature Unit_Of_Temperature 
(String)

Unit of Temperature [Step-1]

Unit_Of_Mass_Flow Unit_Of_Mass_Flow (String) Unit of Mass Flow [Step-3]

Unit_Of_Volume_Flow Unit_Of_Volume_Flow 
(String)

Unit of Volume Flow [Step-3]

Unit_Of_Density Unit_Of_Density (String) Unit of Density [Step-3]

 Unit_Of_Specific_Heat  Unit_Of_Specific_Heat 
(String)

Unit of Specific Heat [Step-3]

 Unit_Of_Heat_Duty  Unit_Of_Heat_Duty (String) Unit of Heat Duty [Step-3]

Unit_Of_Heat_Transfer_Efficiency Unit_Of_Heat_Transfer_Effici
ency (String)

Unit of Heat Transfer [Step-1]

Unit_Of_Tube_Velocity Unit_Of_Tube_Velocity 
(String)

Tube Velocity: Unit of Tube 
Velocity [Step-10]

Unit_Of_Tube_Area Unit_of_Tube_Area (String) Unit of Tube Area [Step-1]

Table 49. Configuration_Values Aspect and HXAM-ST Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-ST Configuration 

Faceplate
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Specific_Heat_Hot_Fluid Specific_Heat_Hot (Float) Hot Side: Specific Heat 
[Step-3]

Specific_Heat_Cold_Fluid Specific_Heat_Cold (Float) Cold Side: Specific Heat 
[Step-3]

Density_Hot_Fluid Density_Hot (Float) Hot Side: Density [Step-3]

Density_Cold_Fluid Density_Cold (Float) Cold Side: Density [Step-3]

Heat_Of_Vaporization_Hot_Side Heat_Of_Vaporization_Hot 
(Float)

Hot Side: Heat of Vap [Step-3]

Heat_Of_Vaporization_Cold_Side Heat_Of_Vaporization_Cold 
(Float)

Cold Side: Heat of Vap 
[Step-3]

Enable_Delta_Tx_AM Enable_Delta_Tx_AM 
(String)

Enable Delta Tx Condition 
Monitor [Step-5]

Delta_Tx_Increasing Delta_Tx_Increasing (Float) Delta Tx Limits: Increasing 
Limit [Step-6]

 Delta_Tx_Declining Delta_Tx_Declining (Float) Delta Tx Limits: Declining 
Limit [Step-6]

 Delta_Tx_Low Delta_Tx_Low (Float) Delta Tx Limits: Low Limit 
[Step-6]

 Delta_Tx_High Delta_Tx_High (Float) Delta Tx Limits: High Limit 
[Step-6]

Enable_Delta_T_Hot_AM Enable_Delta_T_Hot_AM 
(String)

Enable Delta T Hot Condition 
Monitor [Step-5]

Delta_T_Hot_High Delta_T_Hot_High (Float) Delta T Hot Limits: High Limit 
[Step-6]

Table 49. Configuration_Values Aspect and HXAM-ST Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-ST Configuration 

Faceplate
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Delta_T_Hot_Increasing Delta_T_Hot_Increasing 
(Float)

Delta T Hot Limits: Increasing 
Limit [Step-6]

Delta_T_Hot_Declining Delta_T_Hot_Declining 
(Float)

Delta T Hot Limits: Declining 
Limit [Step-6]

Delta_T_Hot_Low Delta_T_Hot_Low (Float) Delta T Hot Limits: Low Limit 

[Step-6]

Enable_Delta_T_Cold_AM Enable_Delta_T_Cold_AM 
(String)

Enable Delta T Cold Condition 
Monitor [Step-5]

Asset Parameter Name Corresponding Variable 
Name in 
Configuration_Values Aspect 
along with Data Type

Corresponding Variable in 
Configuration_Faceplate 
Aspect

Delta_T_Cold_High Delta_T_Cold_High (Float) Delta T Cold Limits: High 
Limit [Step-6]

Delta_T_Cold_Increasing Delta_T_Cold_Increasing 
(Float)

Delta T Cold Limits: 
Increasing Limit [Step-6]

 Delta_T_Cold_Declining  Delta_T_Cold_Declining 
(Float)

Delta T Cold Limits: Declining 
Limit [Step-6]

 Delta_T_Cold_Low  Delta_T_Cold_Low 
(Float)

Delta T Hot Limits: Low Limit 
[Step-6]

Enable_Delta_P_Hot_AM Enable_Delta_P_Hot_AM 
(String)

Enable Delta P Hot Condition 
Monitor [Step-5]

Delta_P_Hot_High Delta_P_Hot_High (Float) Delta P Hot Limits: High Limit 
[Step-7]

Delta_P_Hot_Increasing Delta_P_Hot_Increasing 
(Float)

Delta P Hot Limits: Increasing 
Limit [Step-7]

Table 49. Configuration_Values Aspect and HXAM-ST Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-ST Configuration 

Faceplate
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Delta_P_Hot_Declining Delta_P_Hot_Declining 
(Float)

Delta P Hot Limits: Declining 
Limit [Step-7]

Delta_P_Hot_Low Delta_P_Hot_Low (Float) Delta P Hot Limits: Low Limit 
[Step-7]

Enable_Delta_P_Cold_AM Enable_Delta_P_Cold_AM 
(String)

Enable Delta P Cold Condition 
Monitor [Step-5]

Delta_P_Cold_High Delta_P_Cold_High (Float) Delta Cold Limits: High Limit 
[Step-7]

Delta_P_Cold_Increasing Delta_P_Cold_Increasing 
(Float)

Delta P Cold Limits: 
Increasing Limit [Step-7]

Delta_P_Cold_Declining Delta_P_Cold_Declining 
(Float)

Delta P Cold Limits: Declining 
Limit [Step-7]

Delta_P_Cold_Low Delta_P_Cold_Low (Float) Delta P Cold Limits: Low 
Limit [Step-7]

Enable_W_Hot_AM Enable_W_Hot_AM (String) Enable W Hot Condition 
Monitor [Step-5]

W_Hot_High W_Hot_High (Float) W Hot Limits: High Limit 
[Step-8]

W_Hot_Increasing W_Hot_Increasing (Float) W Hot Limits: Increasing Limit 
[Step-8]

W_Hot_Declining W_Hot_Declining (Float) W Hot Limits: Declining Limit 
[Step-8]

W_Hot_Low W_Hot_Low (Float) W Hot Limits: Low Limit 
[Step-8]

Enable_W_Cold_AM Enable_W_Cold_AM (String) Enable W Cold Condition 
Monitor [Step-5]

Table 49. Configuration_Values Aspect and HXAM-ST Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-ST Configuration 

Faceplate
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W_Cold_High W_Cold_High (Float) W Cold Limits: High Limit 
[Step-8]

W_Cold_Increasing W_Cold_Increasing (Float) W Cold Limits: Increasing 
Limit [Step-8]

W_Cold_Declining W_Cold_Declining (Float) W Cold Limits: Declining Limit 
[Step-8]

W_Cold_Low W_Cold_Low (Float) W Cold Limits: Low Limit 
[Step-8]

Enable_HD_Hot_AM Enable_HD_Hot_AM (String) Enable HD Hot Condition 
Monitor [Step-5]

HD_Hot_High_Limit HD_Hot_High (Float) HD Hot Limits: High Limit 
[Step-9]

Asset Parameter Name Corresponding Variable 
Name in 
Configuration_Values Aspect 
along with Data Type

Corresponding Variable in 
Configuration_Faceplate 
Aspect

HD_Hot_Low_Limit HD_Hot_Low (Float) HD Hot Limits: Low Limit 
[Step-9]

Enable_HD_Cold_AM Enable_HD_Cold_AM 
(String)

Enable HD Cold Condition 
Monitor [Step-5]

HD_Cold_High_Limit HD_Cold_High (Float) HD Cold Limits: High Limit 
[Step-9]

HD_Cold_Low_Limit HD_Cold_Low (Float) HD Cold Limits: Low Limit 
[Step-9]

Enable_Delta_HD_AM Enable_Delta_HD_AM Enable Delta HD Condition 
Monitor [Step-5]

Table 49. Configuration_Values Aspect and HXAM-ST Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
Aspect and Data Type

Corresponding Variable in 
HXAM-ST Configuration 

Faceplate
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Delta_HD_High_Limit Delta_HD_High (Float) Delta HD Limits: Low Limit 
[Step-9]

Enable_Tube_Velocity_AM Enable_Tube_Velocity_AM 
(String)

Enable Tube Velocity 
Condition Monitor [Step-5]

Tube_Velocity_High_Limit Tube_Velocity_High_Limit 
(Float)

Tube Velocity: Low Limit 
[Step-10]

Tube_Velocity_Low_Limit Tube_Velocity_Low_Limit 
(Float)

Tube Velocity: High Limit 
[Step-10]

Enable_LAT_AM Enable_LAT_AM (String) Enable Limit Approach 
Temperature Condition Monitor 
[Step-5]

LAT_Low_Limit LAT_Low_Limit (Float) Limit Approach 
Temperature: Low Limit [Step-
10]

Enable_Shell_Side_Flow_AM Enable_Shell_Side_Flow_A
M (String)

Enable Shell Side Flow 
Condition Monitor [Step-5]

Shell_Side_Flow_Low_Limit Shell_Side_Flow_Low_Limit 
(Float)

Shell Side Flow: Low Limit 
[Step-10] 

Enable_Thermal_CrossOver_Det
ection_AM

Enable_TCOD_AM (String) Enable Thermal Crossover 
Detection Condition Monitor 
[Step-5]

Table 49. Configuration_Values Aspect and HXAM-ST Configuration Faceplate Values (Continued)

Asset Parameter Name

Corresponding Variable 
Name in 

Configuration_Values 
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Recommended Asset Monitor Sampling Interval (AMSI) for HXAM_ST

Table 50 lists the recommended Asset Monitor sampling interval (AMSI). 

Table 50. Recommended Asset Monitor Sampling Interval (AMSI) 

Normal Service 
Interval

Recommended AMSI Value 
(minutes)

1 day 1 or greater

2 days

3 days

4 days

5 days

6 days 2 or greater

1 week

2 weeks

3 weeks 5 or greater

4 weeks

1 month 10 or greater

2 months 15 or greater

3 months 20 or greater

4 months 30 or greater

5 months

6 months 60 or greater

1 year 120 or greater

2 years 240 or greater

3 years 300 or greater
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HXAM-ST Input Records

Input Records for HXAM-ST Asset Monitor, along with the expected data and 
explanations are given in Table 51. 

4 years 480 or greater

5 years

Table 51. HXAM-ST Input Records 

Input Records Explanation Expected Data

Clear_Base_Operating_Point Specifies if the Asset Monitor is to be retrained. 
This is read as an XML value, which includes a 
timestamp. Therefore any change from True to 
False, False to True, False to False, or True to 
True will trigger Retrain. On retraining, the Asset 
Monitor will erase all the trained BOPS and go 
back to Training Phase. This Input Record is a 
manual input that can be input by clicking a 
button from the HXAM-ST Faceplate. [Required]

TRUE / FALSE

T_Hot_In Hot Side Inlet Temperature. [Required] Any numeric 
value

T_Hot_Out Hot Side Outlet Temperature. [Required] Any numeric 
value

T_Cold_In Cold Side Inlet Temperature [Required] Any numeric 
value

T_Cold_Out Hot Side Outlet Temperature [Required] Any numeric 
value

Mass_Flow_Hot_Side Hot Side Mass Flow [Required if Asset 
Parameter Mass_Flow_Hot_Available is set to 
TRUE/YES]

Any numeric 
value

Table 50. Recommended Asset Monitor Sampling Interval (AMSI) (Continued)

Normal Service 
Interval

Recommended AMSI Value 
(minutes)
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Volume_Flow_Hot_Side Hot Side Volume Flow. [Required if Asset 
Parameter Volume_Flow_Hot_Available is set 
to TRUE/YES]

Any numeric 
value

Mass_Flow_Cold_Side Cold Side Mass Flow. [Required if Asset 
Parameter Mass_Flow_Cold_Available is set 
to TRUE/YES]

Any numeric 
value

Volume_Flow_Cold_Side Cold Side Volume Flow. [Required if Asset 
Parameter Volume_Flow_Cold_Available is 
set to TRUE/YES]

Any numeric 
value

Delta_P_Hot_Side Hot Side Pressure Difference. [Required if Asset 
Parameter Delta_P_Hot_Available is set to 
TRUE/YES]

Any numeric 
value

P_Hot_In Hot Side Inlet Pressure. [Required if Asset 
Parameter 
Delta_P_Hot_Alternative_Available is set to 
TRUE/YES]

Any numeric 
value

P_Hot_Out Hot Side Outlet Pressure. [Required if Asset 
Parameter 
Delta_P_Hot_Alternative_Available is set to 
TRUE/YES]

Any numeric 
value

Delta_P_Cold_Side Cold Side Pressure Difference. . [Required if 
Asset Parameter Delta_P_Cold_Available is 
set to TRUE/YES]

Any numeric 
value

P_Cold_In Cold Side Inlet Pressure. [Required if Asset 
Parameter 
Delta_P_Cold_Alternative_Available is set to 
TRUE/YES]

Any numeric 
value

P_Cold_Out Cold Side Outlet Pressure. [Required if Asset 
Parameter 
Delta_P_Cold_Alternative_Available is set to 
TRUE/YES]

Any numeric 
value

Table 51. HXAM-ST Input Records (Continued)

Input Records Explanation Expected Data



HXAM-ST Input Records Section 6  Heat Exchanger Asset Monitor (HXAM)

294 3BUA000118-510 G

Inhibit Inhibit Signal. The value must match the Asset 
Parameter Inhibit_Value, if the Asset Monitor is 
to be inhibited. [Optional]

Any String

Clear_BOPS_Date Date of Last Time BOPS change was made 
[Required]

String

Table 51. HXAM-ST Input Records (Continued)

Input Records Explanation Expected Data
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For manual input of any input record, the Data Source Item should be configured 
using macros as shown in Table 52 and the actual values should be put in the 
corresponding variable in the HXAM_ST_GP aspect. By configuring this way, the 
Input Record reads its data from the HXAM_ST_GP aspect. The expected data for 
the Input Records are given in Table 51. 

Table 52. Data Source Item Macros 

Input Records Macros Used
Corresponding Variable 
in HXAM_ST_GP Aspect

Clear_Base_Operating_Point %ID%:Clear BOPS Clear BOPS

T_Hot_In %ID%:Inlet Hot Temperature Inlet Hot Temperature

T_Hot_Out %ID%:Outlet Hot Temperature Outlet Hot Temperature

T_Cold_In %ID%:Inlet Cold Temperature Inlet Cold Temperature

T_Cold_Out %ID%:Outlet Cold Temperature Outlet Cold Temperature

Mass_Flow_Hot_Side %ID%:Mass Flow Hot Side Mass Flow Hot Side

Volume_Flow_Hot_Side %ID%:Volume Flow Hot Side Volume Flow Hot Side

Mass_Flow_Cold_Side %ID%:Mass Flow Cold Side Mass Flow Cold Side

Volume_Flow_Cold_Side %ID%:Volume Flow Cold Side Volume Flow Cold Side

Delta_P_Hot_Side %ID%:Pressure Difference Hot Side Pressure Difference Hot 
Side

P_Hot_In %ID%:Inlet Pressure Hot Side Inlet Pressure Hot Side

P_Hot_Out %ID%:Outlet Pressure Hot Side Outlet Pressure Hot Side

Delta_P_Cold_Side %ID%:Pressure Difference Cold Side Pressure Difference Cold 
Side

P_Cold_In %ID%:Inlet Pressure Cold Side Inlet Pressure Cold Side

P_Cold_Out %ID%:Outlet Pressure Cold Side Outlet Pressure Cold Side
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Inhibit %ID%:Inhibit Inhibit

 — — RetrainFE_TempVal 

NOTES:
1. For all inputs that are not manually input or somehow stored into the HXAM_ST_GP aspect, the macros shown in 

Table 52 will not work. The Data Source Item should be configured based on from where the property of the Input 
Record will be read. The Clear_Base_Operating_Point and Inhibit Input Records will always be manual inputs.

2. The RetrainFE_TempVal property under HXAM_ST_GP aspect in Table 52 does not have a corresponding Input 
Record. This property is only used for the working of the HXAM_ST_BOPS_Info_FE aspect and is not an Input 
Record. This property is configured to take a string and it’s Readable?/Writable? Are set to Yes. Do not make any 
changes to this property. If by any chance the value of this property gets erased, type in the following value: So 
far received 0 Base Operating Point Set. The value of this property should never be 
empty.

Table 52. Data Source Item Macros (Continued)

Input Records Macros Used
Corresponding Variable 
in HXAM_ST_GP Aspect



3BUA000118-510 G 297

Appendix A  CMMS Definition Files

Introduction
This appendix contains an example of a ABB-supplied Maximo Definition (MxDef) 
file and a SAP/PM Definition (SAPDef) file. Assuming the default directory was 
selected during Asset Optimization installation, the default MxDef files and 
SAPDef files supplied with Asset Optimization are located in:

...\Program Files\ABB Industrial IT\Optimize IT\ 
Asset Optimization\AOECSConnector\MaximoDef

...\Program Files\ABB Industrial IT\Optimize IT\ 
Asset Optimization\AOECSConnector\SAPPMDef

Navigate to the desired file in Windows Explorer and double-click on it to 
view the xml code.  

Follow these instructions when customizing the MxDef files and SAPDef files to 
prevent the custom MxDef files and SAPDef files from being overwritten during 
an upgrade or reinstallation of Asset Optimization. 

   

Do not edit the MxDef files without an extensive knowledge of the Maximo 
SDK for Business Components documentation and a close consulting 
association with IBM Maximo personnel to determine what fields are required.

Do not edit the SAPDef files without a close consulting association with SAP, 
AG personnel to determine what fields are required. Editing these files without 
the required knowledge and experience may result in problems with the Maximo 
system, SAP/PM system, and the CMMS interface to them.

 

Refer to System 800xA - System, Upgrade and Installation for backup and restore 
procedures for the MxDef and SAPDef files.

The MxDef files and SAPDef files for the basic CMMS views (Active Work 
Orders, Work Order History, Equipment Status, Preventive Maintenance Schedule, 
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Spare Parts, Availability of Spare Parts (supported only in Maximo systems)) 
provide the information on the data to retrieve and display. 

The MXDef and SAPDef files for the Fault Report Submitter provides the 
information on the data to display, defines the data inputs/edit characteristics, and 
the data destination for the creation of a Work Order in the Maximo system or 
SAP/PM system. The <Attr>, <Caption>, and <type> XML tags are identical to 
those in the MxDef and SAPDef files for the basic CMMS Views.

Information in the MxDef and SAPDef files has the following structure and each 
attribute for display has a definition record:

<AttrDef> 
<Attr>description</Attr> 
<Caption>WO Description</Caption> 
<Map>ABBACD/Condition/SuggestedAction</Map> 
<DefaultValue></DefaultValue> 
<Type>string</Type> 
<FieldLen>50</FieldLen> 
<Edit>True</Edit> 

</AttrDef> 

• <Attr>description</Attr> tag: Defines the data field to retrieve from the 
Maximo system.

• <Caption>WO Description</Caption> tag: Defines the column heading for 
the view.

• <Map>ABBACD/Condition/SuggestedAction</Map> tag: The information 
token used to fill in the displayed field in the Create Fault Report and Submit 
Fault Report UI forms (browser-based UI forms/pages). This map is the 
method for making information existing in the Fault Reports available to the 
Fault Report Viewer/Fault Report Submitter visible in the submission displays 
(Create Fault Report and Submit Fault Report) and available to send to the 
CMMS in a Fault Report. The mapping is the <Attr> tag that represents a data 
element in a Fault Report object in the particular CMMS. 

• <DefaultValue></DefaultValue> tag: A typed value that is used in the 
mapping functions if the token does not exist in the Fault Report data that is 
available to the Fault Report Viewer/Fault Report Submitter, or if the 
tokenized data does exist but is null or blank in the Fault Report data. 
Therefore, the DefaultValue is used if the token does not exist or supplies no 
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useful data. Thus, if in a configuration, one wishes to use the DefaultValue in 
place of the values that may be available from the Asset Monitors through the 
Fault Report Viewer/Fault Report Submitter, one could configure the <Map> 
tag as blank or to a token known to not exist in the Fault Report data, e.g. 
<Map>notused</Map>. 

• <Type>string</Type> tag: Defines the data type being retrieved from the 
Maximo system.

• <FieldLen>50</FieldLen> tag: Field length tag used to truncate the data from 
the ACD to a length less than or equal to FieldLen. This restriction on field 
length is a result of the database storage size (in characters) of the fields in a 
Maximo Work Order (specifically in the Waiting for Approval state (WAPPR). 
Each Maximo field has its own attributes, so a knowledge of the Maximo Work 
Order is necessary in setting these limits (refer to Maximo documentation). A 
FieldLen of 0 is interpreted by the Asset Optimization web server as meaning 
no practical limit.

• <Edit>True</Edit> tag: Enables editing of particular fields as displayed on the 
various Fault Report submission UIs (Create Fault Report and Submit Fault 
Report).

The database attribute <Attr> AUFNR is used to link into the SAP/PM system 
and MUST be part of the request in the SAPDef xml definition file. AUFNR 
represents the Order number in the SAP/PM system.

 

When configuring the Active Work Order SAPDef file 
(SapDef_GetWONO.xml), the number of requested <Attr>s should be kept 
below 250 and there should be no duplication of requested <Attr>s. That is, the 
file should contain one and only one of each of the <Attr>s that are required.
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Sample MxDef File

The Fault Report Submitter MxDef file is called:

MxDefMOMAppFR_Submit.xml

The .xml code is:
<MxActionDef>

<Action>http://www.abb.com/AssetOptimization/2.0/ 
MOM/MOMAppFR_Submit</Action>
<AttrDefs>

<AttrDef>
<Attr></Attr>
<Caption>CMMS System Type</Caption>
<Map></Map>
<DefaultValue>Maximo</DefaultValue>
<Type>string</Type>
<Edit>False</Edit>

</AttrDef>
<AttrDef>

<Attr>eqnum</Attr>
<Caption>Equipment</Caption>
<Map>DestinationID/Asset/ItemName</Map>
<DefaultValue></DefaultValue>
<Type>string</Type>
<Edit>False</Edit>

</AttrDef>
<AttrDef>

<Attr></Attr>
<Caption>Asset Monitor Aspect</Caption>
<Map>ABBACD/Asset/AspectID/AspectName</Map>
<DefaultValue>Create Fault Report/ 
Notification</DefaultValue>
<Type>string</Type>
<FieldLen>50</FieldLen>
<Edit>False</Edit>

</AttrDef>
<AttrDef>

<Attr></Attr>
<Caption>Asset Monitor LogicDescription</Caption>
<Map>ABBACD/AssetMonitor/LogicDescription</Map>
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<DefaultValue>Create Fault 
Report/Notification</DefaultValue>

<Type>string</Type>
<FieldLen>50</FieldLen>
<Edit>False</Edit>

</AttrDef>
<AttrDef>

<Attr>description</Attr>
<Caption>WO Description</Caption>
<Map>ABBACD/Condition/SuggestedAction</Map>
<DefaultValue></DefaultValue>
<Type>string</Type>
<FieldLen>50</FieldLen>
<Edit>True</Edit>

</AttrDef>
<AttrDef>

<Attr>description_longdescription</Attr>
<Caption>User Comment</Caption>
<Map>ABBACD/Condition/SuggestedAction</Map>
<DefaultValue></DefaultValue>
<Type>string</Type>
<FieldLen>0</FieldLen>
<Edit>True</Edit>

</AttrDef>
<AttrDef>

<Attr>FAILDATE</Attr>
<Caption>Failure Date</Caption>
<Map>ABBACD/Condition/UTCTimeStamp</Map>
<DefaultValue></DefaultValue>
<Type>datetime</Type>
<Edit>True</Edit>

</AttrDef>
<AttrDef>

<Attr>reportedby</Attr>
<Caption>Problem Reporter</Caption>
<Map>ABBACD/Condition/ReportedBy</Map>
<DefaultValue>Optimize IT</DefaultValue>
<Type>string</Type>
<Edit>True</Edit>

</AttrDef>
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<AttrDef>
<Attr>GLACCOUNT</Attr>
<Caption>General Ledger Account</Caption>
<Map></Map>
<DefaultValue>6900-332-000</DefaultValue>
<Type>string</Type>
<Edit>True</Edit>

</AttrDef>
<AttrDef>

<Attr>WOPRIORITY</Attr>
<Caption>WO Priority</Caption>
<Map>USEDEFAULT</Map>
<Select>

<Option Value="1">HI</Option>
<Option Value="2">MID</Option>
<Option Value="3" Selected="true">LOW</Option>

</Select>
<Type>string</Type>
<Edit>True</Edit>

</AttrDef>
<AttrDef>

<Attr>WORKTYPE</Attr>
<Caption>Work Type</Caption>
<Map>USEDEFAULT</Map>
<DefaultValue>PM</DefaultValue>
<Type>string</Type>
<Edit>True</Edit>

</AttrDef>
<AttrDef>

<Attr>WOPM5</Attr>
<Caption>SubWork Type</Caption>
<Map>USEDEFAULT</Map>
<DefaultValue>MINOR</DefaultValue>
<Type>string</Type>
<Edit>True</Edit>

</AttrDef>
<AttrDef>

<Attr>LEADCRAFT</Attr>
<Caption>Lead Craft</Caption>
<Map>USEDEFAULT</Map>
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<DefaultValue></DefaultValue>
<Type>string</Type>
<Edit>True</Edit>

</AttrDef>
<AttrDef>

<Attr>Username</Attr>
<Caption>Username</Caption>
<Map></Map>
<DefaultValue></DefaultValue>
<Type>string</Type>
<Edit>True</Edit>

</AttrDef>
<AttrDef>

<Attr>Password</Attr>
<Caption>Password</Caption>
<Map></Map>
<DefaultValue></DefaultValue>
<Type>password</Type>
<Edit>True</Edit>

</AttrDef>
</AttrDefs>

</MxActionDef>
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Sample SAPDef File

The Fault Report Viewer SAPDef file is called:

SapDef_FaultReportView.xml

The .xml code is:
<Data>

<Fields>
<Field>

<Attr>ABBSystemType</Attr>
<Required>False</Required>
<Caption>CMMS System Type</Caption>
<Map>SAPService-Request/Asset/SystemType</Map>
<Type>String</Type>
<Edit>False</Edit>
<Value>SAP-PM</Value>

</Field>
<Field>

<Attr>EQUNR</Attr>
<Required>True</Required>
<Caption>SAP Equipment Number</Caption>
<Map>SAPService-Request/Asset/ItemName</Map>
<Type>String</Type>
<Edit>False</Edit>
<Value></Value>

</Field>
<Field>

<Attr>ABBMonitoringServerID</Attr>
<Required>False</Required>
<Caption>Asset Monitor Aspect</Caption>
<Map>SAPService-Request/ABBACD/Asset/ 
AspectID/AspectName</Map>
<Type>String</Type>
<Edit>False</Edit>
<Value>Create Fault Report/Notification</Value>

</Field>
<Field>

<Attr>ABBMonitoringServerLogicDescription</Attr>
<Required>False</Required>
<Caption>Asset Monitor LogicDescription</Caption>
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<Map>SAPService-Request/ABBACD/AssetMonitor/ 
LogicDescription</Map>
<Type>String</Type>
<Edit>False</Edit>
<Value>Create Fault Report/Notification</Value>

</Field>
<Field>

<Attr>IWERK</Attr>
<Required>True</Required>
<Caption>Maintenance Planning Plant</Caption>
<Map></Map>
<Type>String</Type>
<Edit>True</Edit>
<aValue>US01</aValue>
<Value>3000</Value>

</Field>
<Field>

<Attr>ILOAN</Attr>
<Required>True</Required>
<Caption>Location and account assignment 
for equipment</Caption>
<Map></Map>
<Type>String</Type>
<Edit>True</Edit>
<Value>Default Account</Value>

</Field>
<Field>

<Attr>AUSVN</Attr>
<Required>True</Required>
<Caption>Date of start of equipment 
malfunction</Caption>
<Map></Map>
<Type>DateTime</Type>
<Edit>True</Edit>
<Value>2014-05-10</Value>

</Field>
<Field>

<Attr>AUZTV</Attr>
<Required>True</Required>
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<Caption>Time of start of equipment 
malfunction</Caption>
<Map></Map>
<Type>DateTime</Type>
<Edit>True</Edit>
<Value>120000</Value>

</Field>
<Field>

<Attr>AUSBS</Attr>
<Required>True</Required>
<Caption>Date of end of equipment 
malfunction</Caption>
<Map></Map>
<Type>DateTime</Type>
<Edit>True</Edit>
<Value>20040520</Value>

</Field>
<Field>

<Attr>AUZTB</Attr>
<Required>True</Required>
<Caption>Time of end of equipment 
malfunction</Caption>
<Map></Map>
<Type>DateTime</Type>
<Edit>True</Edit>
<Value>130000</Value>

</Field>
<Field>

<Attr>AUSZT</Attr>
<Required>True</Required>
<Caption>Duration of breakdown</Caption>
<Map></Map>
<Type>DateTime</Type>
<Edit>True</Edit>
<Value>8</Value>

</Field>
<Field>

<Attr>MAUEH</Attr>
<Required>True</Required>
<Caption>Breakdown unit</Caption>
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<Map></Map>
<Type>String</Type>
<Edit>True</Edit>
<Value>H</Value>

</Field>
<Field>

<Attr>BTPLN</Attr>
<Required>True</Required>
<Caption>Functional location affected</Caption>
<Map></Map>
<Type>String</Type>
<Edit>True</Edit>
<Value></Value>

</Field>
<Field>

<Attr>BEQUI</Attr>
<Required>True</Required>
<Caption>Equipment affected</Caption>
<Map></Map>
<Type>String</Type>
<Edit>True</Edit>
<Value></Value>

</Field>
<Field>

<Attr>AUSWK</Attr>
<Required>True</Required>
<Caption>Effect on operations</Caption>
<Map></Map>
<Type>String</Type>
<Edit>True</Edit>
<Select>

<Option Value="3">STOP</Option>
<Option Value="2">Unit</Option>
<Option Value="1" Selected="true">No Effect</Option>

</Select>
<Value></Value>

</Field>
<Field>

<Attr>QMTXT</Attr>
<Required>True</Required>
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<Caption>Notification description</Caption>
<Map>SAPService-Request/ABBACD/ 
Condition/Description</Map>
<Type>String</Type>
<Edit>True</Edit>
<Value>Test CFR</Value>

</Field>
<Field>

<Attr>INSPK</Attr>
<Required>True</Required>
<Caption>Responsible person</Caption>
<Map>SAPService-Request/ABBACD/AssetMonitor/ 
LogicDescription</Map>
<Type>String</Type>
<Edit>True</Edit>
<Value></Value>

</Field>
<Field>

<Attr>DATAN</Attr>
<Required>True</Required>
<Caption>Date for technical inspection</Caption>
<Map></Map>
<Type>DateTime</Type>
<Edit>True</Edit>
<Value></Value>

</Field>
<Field>

<Attr>QMART</Attr>
<Required>True</Required>
<Caption>Notification type</Caption>
<Map></Map>
<Type>String</Type>
<Edit>True</Edit>
<Select>

<Option Value="M3">M3</Option>
<Option Value="M1">M1</Option>
<Option Value="M2" Selected="true"> 
Notification:M2</Option>

</Select>
<Value>M2</Value>
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</Field>
<Field>

<Attr>ARTPR</Attr>
<Required>True</Required>
<Caption>Priority type</Caption>
<Map></Map>
<Type>String</Type>
<Edit>True</Edit>
<Value></Value>

</Field>
<Field>

<Attr>PRIOK</Attr>
<Required>True</Required>
<Caption>Priority</Caption>
<Map>SAPService-Request/ABBACD/ 
Condition/Severity</Map>
<Type>String</Type>
<Edit>True</Edit>
<Value>LOW</Value>

</Field>
<Field>

<Attr>QMDAT</Attr>
<Required>True</Required>
<Caption>Date of notification</Caption>
<Map></Map>
<Type>DateTime</Type>
<Edit>True</Edit>
<Value></Value>

</Field>
<Field>

<Attr>QMNAM</Attr>
<Required>True</Required>
<Caption>Name of person reporting</Caption>
<Map>SAPService-Request/ABBACD/Condition/ 
ReportedBy</Map>
<Type>String</Type>
<Edit>True</Edit>
<Select>

<Option Value="DLUM">Dave Lum</Option>
<Option Value="JSCHUBERT">Joerg Schubert</Option>
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<Option Value="MHERMES">Martin Hermes</Option>
<Option Value="SMATTONI">Samuel Mattoni</Option>
<Option Value="DCURTIN">Deborah Curtin</Option>
<Option Value="JROCHOW" Selected="true"> 
Jeff Rochow</Option>
<Option Value="RFC_PM">RFC_PM</Option>

</Select>
<Value>PPAOperator</Value>

</Field>
<Field>

<Attr>ABBUserName</Attr>
<Required>False</Required>
<Caption>UserName</Caption>
<Map></Map>
<Type>String</Type>
<Edit>True</Edit>
<Value></Value>

</Field>
<Field>

<Attr>ABBPassword</Attr>
<Required>False</Required>
<Caption>Password</Caption>
<Map></Map>
<Type>Password</Type>
<Edit>True</Edit>
<Value></Value>

</Field>
<Field>

<Attr>ABBClient</Attr>
<Required>False</Required>
<Caption>Client</Caption>
<Map></Map>
<Type>String</Type>
<Edit>True</Edit>
<Value>800</Value>

</Field>
<Field>

<Attr>ABBSAPLang</Attr>
<Required>False</Required>
<Caption>SAPLang</Caption>
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<Map></Map>
<Type>String</Type>
<Edit>True</Edit>
<Value>EN</Value>

</Field>
</Fields>

</Data>
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Appendix B  Heat Exchanger Specific 
Terminology

Heat Exchanger Specific Terminology
Table 53 is a list of terms associated with heat exchangers.  

Table 53. Heat Exchanger Specific Terminology 

Term/Acronym Description

AMSI Asset Monitor Sample Interval. Time interval used by the Asset Monitor to 
sample heat exchanger instrumentation values. Typical values NSI/1000 or 
60 seconds, whichever is greater.

BOPS Base OPS. OPS read during the training period, which become the initial set 
used for all future comparisons.

COPS Comparative OPS. OPS read during subsequent heat exchanger operation 
which will be used to compare against the BOPS of the heat exchanger.

Delta P Cold Pressure difference at Cold Side (Cold-Side Inlet Pressure – Cold-Side 
Outlet Pressure)

Delta P Hot Pressure difference at Hot Side (Hot-Side Inlet Pressure – Hot-Side Outlet 
Pressure)

Delta T Cold Temperature difference at Cold Side (Cold-Side Inlet Temperature – Cold-
Side Outlet Temperature)

Delta T Hot Temperature difference at Hot Side (Hot-Side Inlet Temperature – Hot-Side 
Outlet Temperature)

Delta Tx Temperature difference across the heat exchanger (Hot- Side Inlet 
Temperature – Cold-Side Inlet Temperature)

E Performance Factor
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HD Heat Duty

HD Cold Cold-Side Heat Duty

HD Hot Hot-Side Heat Duty

HeatX Heat Exchanger

HeatX_G Generic Heat Exchanger

HeatX_ST Shell and Tube Heat Exchanger

HXAM-G Generic Heat Exchanger Asset Monitor

HXAM-ST Shell and Tube Heat Exchanger Asset Monitor.

LAT Limit Approach Temperature

LMTD Log Mean Temperature Difference

NBS Number of Baseline Sets. This is the set of baseline operating point sets 
which will be taken during the training period.

NSI Normal Service Interval. The time interval between heat exchanger 
cleanings, rebuilds, etc.

OPS Operating Point Set. The full set of operating values read from process 
instrumentation relevant to the operation of the heat exchanger.

SP Staleness Period. Maximum time interval for which a BOPS can go 
unreferenced. Typical value NSI/50 or 48 hours, whichever is greater.

T Hot In Heat exchanger hot inlet temperature

T Hot Out Heat exchanger hot outlet temperature

T Cold In Heat exchanger cold inlet temperature

T Cold Out Heat exchanger cold outlet temperature

TCD Thermal Crossover Detection

TP Training Period. Time interval in which all operating point sets should be 
gathered. Typical values NSI/100 or 200 hours, whichever is smaller.

Table 53. Heat Exchanger Specific Terminology (Continued)

Term/Acronym Description
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U Heat Transfer Efficiency

W Mass Flow

W Cold Cold-Side Mass Flow

W Hot Hot-Side Mass Flow 

Table 53. Heat Exchanger Specific Terminology (Continued)

Term/Acronym Description
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A
Alarm behavior 41
Alarm grouping 94
Aspect system

Asset monitoring
Asset monitor data source, OPC specific 

connectivity 47
Maximo connectivity

Maximo equipment ID 27
SAP connectivity

SAP equipment ID 31
Asset condition reporting

Asset reporter 78
Asset reporter with system status 82
Asset tree 78
Asset viewer 83

Asset monitor data source
OPC specific connectivity 47

Asset monitor sampling interval 226, 291
Asset monitor startup parameters 25
Asset monitor tab 58, 181, 234
Asset monitoring aspect system

Asset monitor data source
OPC specific connectivity 47

Asset monitors
Bad quality check 116
Basic

Creating, configuring, and commissioning 
(single instance) 113

Bool check 118
Configuration 50

Asset monitor tab 58, 181, 234
Asset parameters tab 62, 183, 236
CLAM 152
Conditions tab 60, 182, 235

HXAM-G 179
HXAM-ST 232
Input records tab 63, 183, 236
Logic tab 67, 184, 238
Output records tab 67, 184, 238

Flow delta 120
Limit check 122
Loading configuration 21
Runtime 126
Startup parameters 25
XY profile deviation 132

Asset Optimization
Asset optimization server configuration 20
Loading asset monitor configurations 21

Asset optimization server configuration 20
Asset parameters tab 62, 183, 236
Asset reporter

Configuration 78
Asset reporter with system status

Configuration 82
Asset viewer

Configuration 83
Assets

Adding to maintenance workplace 109
Authentication 94

B
Bad quality check 116
Basic asset monitor library

Creating, configuring, and commissioning 
(single instance) 113

Basic history service group
CLAM 161

Bool check 118
Bulk data manager 68

Index
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A&E Filters tab data 72
Asset monitor tab data 69
Asset parameters tab data 71
Conditions tab data 70
Input records tab data 71
Maximo integration 87
SAP/PM integration 91

C
Caution and caution icon 12
CLAM asset monitor

Controllers 155
History service group 161
Input data 167
Instance configuration 162
OPC control networks 155
Overall configuration 156

CMMS views 86, 91
Conditions tab 60, 182, 235
Configuration 49

Alarm grouping 94
Asset monitor tab 181, 234
Asset monitors 50

Asset monitor tab 58
Asset parameters tab 62
Conditions tab 60
Input records tab 63
Logic tab 67
Output records tab 67

Asset optimization server 20
Asset parameters 266
Asset parameters tab 183, 236
Asset reporter 78
Asset reporter with system status 82
Asset tree 78
Asset viewer 83
Authentication 94
Bad quality check asset monitor 116
Bool check asset monitor 118
CLAM 161

Controllers 155
Input data 167
Instance 162
OPC control networks 155
Overall 156

CLAM asset monitor 152
CMMS views 86, 91
Conditions tab 182, 235
Flow delta asset monitor 120
HXAM-G asset monitor 179
HXAM-ST asset monitor 232
Input records 227, 292
Input records tab 183, 236
Limit check asset monitor 122
Loading asset monitor configurations 21
Logic tab 184, 238
Maximo equipment ID 84
Maximo integration 83, 89

Bulk data manager 87
Output records tab 184, 238
Runtime asset monitor 126
SAP equipment ID 89
SAP/PM integration

Bulk data manager 91
Trend display aspect 206, 265
XY profile deviation asset monitor 132

Configuration faceplate 185, 238
Controllers

CLAM 155

D
Document

Related 13

F
Fault report submitter 41
Flow delta 120
Functional components 17
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H
History service group 161

CLAM 161
HXAM-G asset monitor

Configuration faceplate 185
Input records 227
trend display aspect 206

HXAM-ST asset monitor
Configuration faceplate 238
Configuring asset parameters 266
Input records 292
trend display aspect 265

I
Information and information icon 12
Input data

CLAM 167
Input records tab 63, 183, 236
Instance configuration

CLAM 162

L
Limit check 122
Loading asset monitor configurations 21
Logic tab 67, 184, 238

M
Maintenance workplace

Adding assets 109
Managing data source connections 45
Mapping between IIT and CMMS 35
Maximo connectivity aspect system

Maximo equipment ID 27
Maximo definition files (MxDef) 35
Maximo equipment ID 27, 31, 84
Maximo integration

Bulk data manager 87
CMMS views 86, 91
Configuration 83, 89
Maximo equipment ID 84

Maximo server connection properties 27, 31
Maximo user credentials 42, 43
MxDef files 35

O
OPC control networks

CLAM 155
OPC specific connectivity 47
Output records tab 67, 184, 238
Overall configuration

CLAM 156
Overview 15

P
Primary structures 44
Process Portal B

Provider 26

R
Runtime 126
Runtime asset monitor 126

S
SAP

SAP equipment ID 89
SAP connectivity aspect system

SAP equipment ID 31
SAP equipment ID 31
SAP ID 89
SAP/PM integration

Bulk data manager 91
Setting up aspect defaults 20
System setup 19

Alarm behavior 41
Asset monitor startup parameters 25
Managing data source connections 45
Maximo equipment ID 27, 31
Maximo server connection properties 27, 31
Maximo user credentials 42, 43
Primary structures 44
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Process Portal B provider 26
Setting up aspect defaults 20
System setup

Fault report submitter 41
User privileges 42

T
Terminology 13, 313
Tip and tip icon 12
Trend display aspect 206, 265

U
User privileges 42

Maximo 42, 43

W
Warning and warning icon 12

X
XY profile deviation 132
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Revision History

Introduction
This section provides information on the revision history of this User Manual. 

Revision History
The following table lists the revision history of this User Manual. 

The revision index of this User Manual is not related to the 800xA 5.1 System 
Revision. 

Revision 
Index

Description Date

- First version published for 800xA 5.1 June 2010

A Updated for 800xA 5.1 Rev A May 2011

B Updated for 800xA 5.1 Feature Pack 1 August 2011

C Updated for 800xA 5.1 Rev B June 2012

D Updated for 800xA 5.1 Feature Pack 3 August 2012

E Updated for 800xA 5.1 Feature Pack 4 February 2013

F Updated for 800xA 5.1 Rev D and 800xA 5.1 FP4 
Rev D.

December 2013

G Updated for 800xA 5.1 Rev E and 800xA 5.1 FP4 
Rev E.

July 2015
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Updates in Revision Index A
The following table shows the updates made in this User Manual for 800xA 5.1 Rev 
A.  

Updates in Revision Index B
The following table shows the updates made in this User Manual for 800xA 5.1 
Feature Pack 1.  

Updated Section/Sub-section Description of Update

Section 3, Asset Parameters Tab Updated with the new image for Figure 14 with refer 
to Bool Check - Asset Parameters Tab. 

Updated Section/Sub-section Description of Update

About this User Manual Added a new section Feature Pack describing the 
user manual conventions used for indicating the 
Feature Pack content.

Section 2, Maximo Server Connection 
Properties

Updated the table and screenshot of Maximo 
Equipment ID and Maximo Equipment ID Provider 
Properties respectively. 

Section 2, SAP/PM Server Connection 
Properties

Updated the table and screenshot of SAP Equipment 
ID and SAP Equipment ID Provider Properties 
respectively. 

Section 2, SAP/PM Server Connection 
Properties

Added new information note on deletion of files from 
ECS Server. 

Section 2, Mapping between the 800xA 
System and the CMMS

Deleted the content of Maximo Integration, Maximo 
Business Object, Caution information, and 
Information text.

Section 2, Mapping between the 800xA

System and the CMMS

Updated the sub-section Deploying the Maximo 
Model with Feature Pack functionality. 

Section 2, Mapping between the 800xA

System and the CMMS

Added new information note on deploying Maximo 
Model using Process Definition Tool. 
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Updates in Revision Index C
The following table shows the updates made in this User Manual for 800xA 5.1 
Revision B.

Updates in Revision Index D
The following table shows the updates made in this User Manual for 800xA 5.1 
Feature Pack 3.

Updates in Revision Index E
The following table shows the updates made in this User Manual for 800xA 5.1 
Feature Pack 4.

Section 3, Mapping the 800xA System 
Object to the Maximo Equipment

Updated the screen shot of Maximo Equipment ID. 

Section 3, Mapping the 800xA System 
Object to the SAP/PM Equipment

Updated the screen shot of SAP Equipment ID. 

Updated Section/Sub-section Description of Update

Section 3 Configuration Updated Figure 12: Asset Monitor Tab

Updated Section/Sub-section Description of Update

Section 3 Configuration Updated Figure 14: Asset Parameters Tab

Updated Section/Sub-section Description of Update

Section 3 Configuration New sub-section created for Maintenance Workplace 
and NAMUR NE107.

Updated Section/Sub-section Description of Update
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Updates in Revision Index F
The following table shows the updates made in this User Manual for 800xA 5.1 Rev 
D and 800xA 5.1 FP4 Rev D.

Updates in Revision Index G
The following table shows the updates made in this User Manual for 800xA 5.1 Rev 
E and 800xA 5.1 FP4 Rev E.

Updated Section/Sub-section Description of Update

Section 3 References to Plant Explorer changed to 
Maintenance Workplace.

Updated Section/Sub-section Description of Update

Section 2 Added information on ABB cpmplus Enterprise 
Connectivity services.
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